
ProMark™3 / ProMark3 RTK

Reference Manual

 



Copyright Notice

©2005-2007 Magellan Navigation, Inc. All rights reserved.

Other Notice

Some of the pictures in this publication show the former 
ProMark antenna (110454). This antenna is however no 
longer delivered with ProMark3. The ProMark antenna is now 
replaced with the NAP100.

Trademarks

All product and brand names mentioned in this publication 
are trademarks of their respective holders.

FCC Notice

This equipment has been tested and found to comply with the 
limits for a class B digital device, pursuant to part 15 of the 
FCC Rules. These limits are designed to provide reasonable 
protection against harmful interference in a residential instal-
lation. This equipment generates, uses and can radiate radio 
frequency energy and if not installed and used in accordance 
with the instructions, may cause harmful interference to radio 
communications. However, there is no guarantee that interfer-
ence will not occur in a particular installation. If this equip-
ment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment 
off and on, the user is encouraged to try to correct the inter-
ference by one or more of the following measures:

• Reorient or relocate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit differ-

ent from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.
Changes or modifications not expressly approved by Magellan 
Navigation could void the user's authority to operate this 
equipment.
CAUTION: To comply with FCC RF exposure compliance re-
quirements, a separation distance of at least 20 cm must be 
maintained between the antenna of this device and all per-
sons.

In the presence of RF field, the receiver's satellite 
signal strength may degrade. When removed from 
the RF field, the signal strength should return to 
normal.

RSS-210

This device has been found compliant with the Canadian RSS-
210 specification, issue 5, November 2001 which stipulates 
that operation is subject to the following two conditions: (1) 
this device may not cause interference, and (2) this device 
must accept any interference, including interference that may 
cause undesired operation of the device.

Magellan Professional Products - Limited Warranty (North, 

Central and South America)

Magellan Navigation warrants their GPS receivers and hard-
ware accessories to be free of defects in material and work-
manship and will conform to our published specifications for 
the product for a period of one year from the date of original 
purchase. THIS WARRANTY APPLIES ONLY TO THE ORIGI-
NAL PURCHASER OF THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at its op-
tion, repair or replace the hardware product with no charge to 
the purchaser for parts or labor. The repaired or replaced prod-
uct will be warranted for 90 days from the date of return ship-
ment, or for the balance of the original warranty, whichever is 
longer. Magellan Navigation warrants that software products or 
software included in hardware products will be free from de-
fects in the media for a period of 30 days from the date of 
shipment and will substantially conform to the then-current 
user documentation provided with the software (including up-

dates thereto). Magellan Navigation's sole obligation shall be 
the correction or replacement of the media or the software so 
that it will substantially conform to the then- current user doc-
umentation. Magellan Navigation does not warrant the soft-
ware will meet purchaser's requirements or that its operation 
will be uninterrupted, error-free or virus-free. Purchaser as-
sumes the entire risk of using the software.

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS WRIT-
TEN WARRANTY OR ANY IMPLIED WARRANTY SHALL BE 
LIMITED TO THE REPAIR OR REPLACEMENT, AT MAGEL-
LAN NAVIGATION'S OPTION, OF ANY DEFECTIVE PART OF 
THE RECEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WARRANTY 
SHALL ONLY BE MADE AT AN AUTHORIZED MAGELLAN 
NAVIGATION SERVICE CENTER. ANY REPAIRS BY A SER-
VICE CENTER NOT AUTHORIZED BY MAGELLAN NAVIGA-
TION WILL VOID THIS WARRANTY.

To obtain warranty service the purchaser must obtain a Return 
Materials Authorization (RMA) number prior to shipping by 
calling 1-800-229-2400 (press option #1) (U.S.) or 1-408-
615-3981 (International), or by submitting a repair request 
on-line at: 
http://professional.magellangps.com/en/support/rma.asp. The 
purchaser must return the product postpaid with a copy of the 
original sales receipt to the address provided by Magellan Nav-
igation with the RMA number. Purchaser’s return address and 
the RMA number must be clearly printed on the outside of the 
package.

Magellan Navigation reserves the right to refuse to provide ser-
vice free-of-charge if the sales receipt is not provided or if the 
information contained in it is incomplete or illegible or if the 
serial number is altered or removed. Magellan Navigation will 
not be responsible for any losses or damage to the product in-
curred while the product is in transit or is being shipped for 
repair. Insurance is recommended. Magellan Navigation sug-
gests using a trackable shipping method such as UPS or Fe-
dEx when returning a product for service.

EXCEPT AS SET FORTH IN THIS LIMITED WARRANTY, ALL 
OTHER EXPRESSED OR IMPLIED WARRANTIES, INCLUD-
ING THOSE OF FITNESS FOR ANY PARTICULAR PURPOSE, 
MERCHANTABILITY OR NON-INFRINGEMENT, ARE HERE-
BY DISCLAIMED AND IF APPLICABLE, IMPLIED WARRAN-
TIES UNDER ARTICLE 35 OF THE UNITED NATIONS 
CONVENTION ON CONTRACTS FOR THE INTERNATIONAL 
SALE OF GOODS. Some national, state, or local laws do not 
allow limitations on implied warranty or how long an implied 
warranty lasts, so the above limitation may not apply to you.

The following are excluded from the warranty coverage: (1) pe-
riodic maintenance and repair or replacement of parts due to 
normal wear and tear; (2) batteries and finishes; (3) installa-
tions or defects resulting from installation; (4) any damage 
caused by (i) shipping, misuse, abuse, negligence, tampering, 
or improper use; (ii) disasters such as fire, flood, wind, and 
lightning; (iii) unauthorized attachments or modification; (5) 
service performed or attempted by anyone other than an au-
thorized Magellan Navigations Service Center; (6) any prod-
uct, components or parts not manufactured by Magellan 
Navigation; (7) that the receiver will be free from any claim for 
infringement of any patent, trademark, copyright or other pro-
prietary right, including trade secrets; and (8) any damage due 
to accident, resulting from inaccurate satellite transmissions. 
Inaccurate transmissions can occur due to changes in the po-
sition, health or geometry of a satellite or modifications to the 
receiver that may be required due to any change in the GPS. 
(Note: Magellan Navigation GPS receivers use GPS or 
GPS+GLONASS to obtain position, velocity and time informa-
tion. GPS is operated by the U.S. Government and GLONASS 
is the Global Navigation Satellite System of the Russian Fed-
eration, which are solely responsible for the accuracy and 
maintenance of their systems. Certain conditions can cause 
inaccuracies which could require modifications to the receiv-



er. Examples of such conditions include but are not limited to 
changes in the GPS or GLONASS transmission.)  Opening, dis-
mantling or repairing of this product by anyone other than an 
authorized Magellan Navigation Service Center will void this 
warranty.

MAGELLAN NAVIGATION SHALL NOT BE LIABLE TO PUR-
CHASER OR ANY OTHER PERSON FOR ANY INCIDENTAL 
OR CONSEQUENTIAL DAMAGES WHATSOEVER, INCLUD-
ING BUT NOT LIMITED TO LOST PROFITS, DAMAGES RE-
SULTING FROM DELAY OR LOSS OF USE, LOSS OF OR 
DAMAGES ARISING OUT OF BREACH OF THIS WARRANTY 
OR ANY IMPLIED WARRANTY EVEN THOUGH CAUSED BY 
NEGLIGENCE OR OTHER FAULT OFMAGELLAN NAVIGATION 
OR NEGLIGENT USAGE OF THE PRODUCT. IN NO EVENT 
WILL MAGELLAN NAVIGATION BE RESPONSIBLE FOR 
SUCH DAMAGES, EVEN IF MAGELLAN NAVIGATION HAS 
BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.

This written warranty is the complete, final and exclusive 
agreement between Magellan Navigation and the purchaser 
with respect to the quality of performance of the goods and 
any and all warranties and representations. This warranty sets 
forth all of Magellan Navigation's responsibilities regarding 
this product. This limited warranty is governed by the laws of 
the State of California, without reference to its conflict of law 
provisions or the U.N. Convention on Contracts for the Inter-
national Sale of Goods, and shall benefit Magellan Navigation, 
its successors and assigns.

This warranty gives the purchaser specific rights. The purchas-
er may have other rights which vary from locality to locality (in-
cluding Directive 1999/44/EC in the EC Member States) and 
certain limitations contained in this warranty, including the 
exclusion or limitation of incidental or consequential damages 
may not apply. 

For further information concerning this limited warranty, 
please call or write:

Magellan Navigation, Inc., 960 Overland Court, San Dimas, 
CA 91773, Phone: +1 909-394-5000, Fax: +1 909-394-
7050 or

Magellan Navigation SA - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France  Phone: +33 (0)2 28 09 38 00, 
Fax: +33 (0)2 28 09 39 39.

Magellan Professional Products Limited Warranty (Europe, 

Middle East, Africa)

All Magellan Navigation global positioning system (GPS) re-
ceivers are navigation aids, and are not intended to replace 
other methods of navigation. Purchaser is advised to perform 
careful position charting and use good judgment. READ THE 
USER GUIDE CAREFULLY BEFORE USING THE PRODUCT.

1. MAGELLAN NAVIGATION WARRANTY

Magellan Navigation warrants their GPS receivers and hard-
ware accessories to be free of defects in material and work-
manship and will conform to our published specifications for 
the product for a period of one year from the date of original 
purchase or such longer period as required by law. THIS WAR-
RANTY APPLIES ONLY TO THE ORIGINAL PURCHASER OF 
THIS PRODUCT. 

In the event of a defect, Magellan Navigation will, at its op-
tion, repair or replace the hardware product with no charge to 
the purchaser for parts or labor. The repaired or replaced prod-
uct will be warranted for 90 days from the date of return ship-
ment, or for the balance of the original warranty, whichever is 
longer. Magellan Navigation warrants that software products or 
software included in hardware products will be free from de-
fects in the media for a period of 30 days from the date of 
shipment and will substantially conform to the then-current 
user documentation provided with the software (including up-

dates thereto). Magellan Navigation's sole obligation shall be 
the correction or replacement of the media or the software so 
that it will substantially conform to the then- current user doc-
umentation. Magellan Navigation does not warrant the soft-
ware will meet purchaser's requirements or that its operation 
will be uninterrupted, error-free or virus-free. Purchaser as-
sumes the entire risk of using the software.

2. PURCHASER'S REMEDY

PURCHASER'S EXCLUSIVE REMEDY UNDER THIS WRIT-
TEN WARRANTY OR ANY IMPLIED WARRANTY SHALL BE 
LIMITED TO THE REPAIR OR REPLACEMENT, AT MAGEL-
LAN NAVIGATION'S OPTION, OF ANY DEFECTIVE PART OF 
THE RECEIVER OR ACCESSORIES WHICH ARE COVERED 
BY THIS WARRANTY. REPAIRS UNDER THIS WARRANTY 
SHALL ONLY BE MADE AT AN AUTHORIZED MAGELLAN 
NAVIGATION SERVICE CENTER. ANY REPAIRS BY A SER-
VICE CENTER NOT AUTHORIZED BY MAGELLAN NAVIGA-
TION WILL VOID THIS WARRANTY.

3. PURCHASER'S DUTIES

To obtain service, contact and return the product with a copy 
of the original sales receipt to the dealer from whom you pur-
chased the product.

Magellan Navigation reserves the right to refuse to provide ser-
vice free-of-charge if the sales receipt is not provided or if the 
information contained in it is incomplete or illegible or if the 
serial number is altered or removed. Magellan Navigation will 
not be responsible for any losses or damage to the product in-
curred while the product is in transit or is being shipped for 
repair. Insurance is recommended. Magellan Navigation sug-
gests using a trackable shipping method such as UPS or Fe-
dEx when returning a product for service.

4. LIMITATION OF IMPLIED WARRANTIES

EXCEPT AS SET FORTH IN ITEM 1 ABOVE, ALL OTHER EX-
PRESSED OR IMPLIED WARRANTIES, INCLUDING THOSE 
OF FITNESS FOR ANY PARTICULAR PURPOSE OR MER-
CHANTABILITY, ARE HEREBY DISCLAIMED AND IF APPLI-
CABLE, IMPLIED WARRANTIES UNDER ARTICLE 35 OF THE 
UNITED NATIONS CONVENTION ON CONTRACTS FOR THE 
INTERNATIONAL SALE OF GOODS. 

Some national, state, or local laws do not allow limitations on 
implied warranty or how long an implied warranty lasts, so the 
above limitation may not apply to you.

5. EXCLUSIONS

The following are excluded from the warranty coverage: 

(1) periodic maintenance and repair or replacement of parts 
due to normal wear and tear; 

(2) batteries; 

(3) finishes; 

(4) installations or defects resulting from installation; 

(5) any damage caused by (i) shipping, misuse, abuse, negli-
gence, tampering, or improper use; (ii) disasters such as fire, 
flood, wind, and lightning; (iii) unauthorized attachments or 
modification; 

(6) service performed or attempted by anyone other than an 
authorized Magellan Navigations Service Center; 

(7) any product, components or parts not manufactured by 
Magellan Navigation, 

(8) that the receiver will be free from any claim for infringe-
ment of any patent, trademark, copyright or other proprietary 
right, including trade secrets 

(9) any damage due to accident, resulting from inaccurate sat-
ellite transmissions. Inaccurate transmissions can occur due 
to changes in the position, health or geometry of a satellite or 



modifications to the receiver that may be required due to any 
change in the GPS. (Note: Magellan Navigation GPS receivers 
use GPS or GPS+GLONASS to obtain position, velocity and 
time information. GPS is operated by the U.S. Government 
and GLONASS is the Global Navigation Satellite System of the 
Russian Federation, which are solely responsible for the accu-
racy and maintenance of their systems. Certain conditions can 
cause inaccuracies which could require modifications to the 
receiver. Examples of such conditions include but are not lim-
ited to changes in the GPS or GLONASS transmission.).

Opening, dismantling or repairing of this product by anyone 
other than an authorized Magellan Navigation Service Center 
will void this warranty.

6. EXCLUSION OF INCIDENTAL OR CONSEQUENTIAL DAM-
AGES

MAGELLAN NAVIGATION SHALL NOT BE LIABLE TO PUR-
CHASER OR ANY OTHER PERSON FOR ANY INDIRECT, IN-
CIDENTAL OR CONSEQUENTIAL DAMAGES WHATSOEVER, 
INCLUDING BUT NOT LIMITED TO LOST PROFITS, DAMAG-
ES RESULTING FROM DELAY OR LOSS OF USE, LOSS OF 
OR DAMAGES ARISING OUT OF BREACH OF THIS WARRAN-
TY OR ANY IMPLIED WARRANTY EVEN THOUGH CAUSED 
BY NEGLIGENCE OR OTHER FAULT OFMAGELLAN NAVIGA-
TION OR NEGLIGENT USAGE OF THE PRODUCT. IN NO 
EVENT WILL MAGELLAN NAVIGATION BE RESPONSIBLE 
FOR SUCH DAMAGES, EVEN IF MAGELLAN NAVIGATION 
HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAM-
AGES.

Some national, state, or local laws do not allow the exclusion 
or limitation of incidental or consequential damages, so the 
above limitation or exclusion may not apply to you.

7. COMPLETE AGREEMENT

This written warranty is the complete, final and exclusive 
agreement between Magellan Navigation and the purchaser 
with respect to the quality of performance of the goods and 
any and all warranties and representations. THIS WARRANTY 
SETS FORTH ALL OF MAGELLAN NAVIGATION'S RESPONSI-
BILITIES REGARDING THIS PRODUCT. 

THIS WARRANTY GIVES YOU SPECIFIC RIGHTS. YOU MAY 
HAVE OTHER RIGHTS WHICH VARY FROM LOCALITY TO LO-
CALITY (including Directive 1999/44/EC in the EC Member 
States) AND CERTAIN LIMITATIONS CONTAINED IN THIS 
WARRANTY MAY NOT APPLY TO YOU.

8. CHOICE OF LAW.

This limited warranty is governed by the laws of France, with-
out reference to its conflict of law provisions or the U.N. Con-
vention on Contracts for the International Sale of Goods, and 
shall benefit Magellan Navigation, its successors and assigns.

THIS WARRANTY DOES NOT AFFECT THE CUSTOMER'S 
STATUTORY RIGHTS UNDER APPLICABLE LAWS IN FORCE 
IN THEIR LOCALITY, NOR THE CUSTOMER'S RIGHTS 
AGAINST THE DEALER ARISING FROM THEIR SALES/PUR-
CHASE CONTRACT (such as the guarantees in France for la-
tent defects in accordance with Article 1641 et seq of the 
French Civil Code).

For further information concerning this limited warranty, 
please call or write:

Magellan Navigation SA - ZAC La Fleuriaye - BP 433 - 44474 
Carquefou Cedex - France.

Phone: +33 (0)2 28 09 38 00, Fax: +33 (0)2 28 09 39 39
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In this manual, the term 
“ProMark3” refers to 

both the ProMark3 and 
ProMark3 RTK units. 

When describing a func-
tion specific to the 

ProMark3 RTK, then the 
term “ProMark3 RTK” is 

used.
1. Introduction

What are the ProMark3 and ProMark3 RTK 

Systems?

ProMark3 is a complete GPS system providing precision sur-
veying in post-processing or real-time, GIS feature collection 
and navigation. Real-time surveying is only available with 
ProMark3 RTK.
A typical ProMark3 system used in post-processing surveys in-
cludes two ProMark3 GPS receivers, GPS antennas, and all 
ancillary components (see picture below) required to get you 
up and running and producing quality data in a minimum 
amount of time.

Post-Process Surveying
The ProMark3 system utilizes standard tripods or fixed-height 
GPS tripods to position system components above a given sur-
vey point. The ProMark3 receiver collects signals broadcast 
from GPS satellites, and stores this information in its internal 
solid-state memory or an SD Card. The collected data is ex-
tracted from the ProMark3 receiver via a cable to an office 
computer for post-processing.

x 2
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Real-Time Surveying
With a ProMark3 RTK, or after upgrading your ProMark3 into 
a ProMark3 RTK (see Installing the ProMark3 RTK Firmware 
on page 267), you can perform real-time RTK surveys. The 
system will deliver centimeter-accurate positions thanks to 
Magellan’s new BLADE™ technology.
From an L1-only GPS receiver such as the ProMark3, BLADE 
can deliver RTK accuracies comparable to those of a dual-fre-
quency (L1/L2) receiver. Compared to dual-freaquency receiv-
ers however, initialization times are longer, and  the operating 
range limited to about 1 mile with the base/rover configura-
tion, and up to 10 kilometers with the rover-only configura-
tion.

Mobile Mapping
The ProMark3 receiver enables you to map and describe GIS 
features and then format the data so that later it can be up-
loaded to a GIS. It offers an easy-to-use and easy-to-deploy so-
lution for general mapping and for asset management.
ProMark3 combines all the navigation capabilities with fea-
ture attributing software to support GIS data collection in the 
field.

Office Software
The ProMark3 System operates in conjunction with GNSS So-
lutions, Magellan’s highly-automated office software.
GNSS Solutions is a complete, easy-to-use software package 
which manages and processes both raw GPS and real-time da-
ta, deriving precise positioning data and presenting the results 
in easily understood report formats.
The ProMark3 receiver also operates in conjunction with Mo-
bileMapper Office. This office software operates as the inter-
face between ProMark3 and your GIS. MobileMapper Office is 
also used to refine feature positions for all those field jobs run 
in post-processing mode.



Items Supplied with ProMark3

The items supplied with ProMark3 are described in the follow-
ing paragraphs.

ProMark3 Receiver
Front Panel

Back Panel:

Touch screen Display:
• Full color transflec-

tive liquid crystal dis-
play (LCD)

• ¼ VGA

Scrolling button

Alphanumeric 
keypad

Power button
Power indicator
Battery indicator

GPS Receiver includes:
• Integrated GPS accurate 

to sub-meter with WAAS/
EGNOS

• Ready for RTCM real-time 
corrections

• Internal antenna.

Speaker

Battery door screws:
• Unscrew to open the 

battery door

Power/Communication 
connectors:
• Connects to the I/O 

module with power 
supply and communi-
cation ports

Removable
Handstrap

Battery Compartment

Battery Pack
3



4

Side Panel

I/O Module

External Antenna 
Connector Secure Digital Card Slot 

Door:
• Open the door to ac-

cess the SD card slot 

Mini USB (Type B) port.
Used for connection to PC

Serial port (COM1) DB-9 connectorDC Power Input connector

USB host port (Type A), connect to a 
USB flash drive, card reader etc.



USB Cable
The USB cable is used to connect the ProMark3 to an office 
computer via the ProMark3’s I/O module. Use the mini USB 
port for this connection and not the USB host port.
The mini USB port is located next to the RS232 Sub-D port 
on the I/O module. Refer to diagrams on page 4. 

AC Adapter/Charger
This device is used to power supply the ProMark3 from the AC 
power line.
If an internal battery has been inserted into the ProMark3 
unit, this device will also provide a charging current for the 
battery. (Battery charging will be monitored by the ProMark3 
unit).

External GNSS Antenna
The external GNSS antenna is required for surveying func-
tions. While the built-in antenna is sufficient for navigation, a 
more sophisticated external antenna is required to obtain 
quality data for precision surveying. The external GNSS anten-
na is the physical data collection point for the raw GNSS sat-
ellite data. For this reason, it must be accurately positioned 
over the point to be surveyed, using a standard tripod or fixed-
height GPS tripod.

External Antenna Cable
The external antenna cable connects the ProMark3 receiver to 
the external antenna. The small end of the cable fitted with a 
right-angle plug connects to the ProMark3. The large end of 
the cable screws onto the external antenna.
5
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Vertical Antenna Extension
The vertical antenna extension provides clearance for the an-
tenna cable when the antenna is mounted on a tripod. The 
length is 3 inches (0.0762 m).

Field Receiver Bracket
The field receiver bracket provides the means for mounting 
the ProMark3 receiver to the tripod.

HI (Height of Instrument) Measurement Tape
The HI measurement tape is used to measure height of the 
GPS antenna over the survey point. The end of the tape hooks 
onto the antenna. The tape is extended until the spike on the 
tape case is on the point. Then the height of the antenna is 
noted on the tape.

Field Bag
The field bag is used to transport the components of each 
ProMark3 receiver system between the office and the field.



User Documentation CD
This CD includes the ProMark3 Getting Started Guide (4 lan-
guages) and the present ProMark3 Reference Manual (English 
only).

Initializer Bar and Antenna Adaptor
(Provided with two-receiver systems only.)
The initializer bar can be used to initialize your surveys from 
a base. This 0.20-m bar should be mounted on the base tri-
brach before use. The antenna adaptor will be inserted at the 
free end of the initializer bar and will temporarily receive the 
rover antenna during the initialization phase.

MobileMapper Office CD
This CD includes the MobileMapper Office software and its 
documentation.

GNSS Solutions CD
(Provided with two-receiver systems only.)
The GNSS Solutions software provides the tools required to 
download and process the GPS satellite data from each 
ProMark3 receiver to produce relative positions of all points 
surveyed. GNSS Solutions is provided on a CD which also con-
tains a reference manual and tutorial supplement.
7
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ProMark3 RTK Specific Accessories

License-Free Radio Modems
Radio modems come in pairs, each composed of two similar 
units that can indifferently be used at the base or the rover.
The radio modem used at the base will automatically become 
a transmitter while the other one, used at the rover, will auto-
matically operate as a receiver.
Models. Radio modems come in two different models. One is 
for use in North America (NA) (P/N111360), and the other 
(P/N 111359) is intended for most European countries (EU) 
(except Italy, Slovak Republic and Bulgaria) (This information 
is subject to change without notice). The table below gives the 
main features of the two models.

Frequency channels. Radio modems are plug-and-play units. 
They are all factory-set to operate on their first channel (chan-
nel #0). If however the default transmission channel is 
jammed in your working area, you can select another transmis-
sion channel using the Radio Configuration utility (see Radio 
Configuration on page 255). Don’t forget in that case to 
change the channel on both units.
Frequency hopping in the NA model. The selected channel 
corresponds to the first channel on which the radio transmits/
receives. 
RTCM Rate in the EU Model. In the European Union, license-
free radios are allowed to transmit only 10% of the time. To 
be sure this requirement is always met, Magellan recommends 
that you set the RTCM rate to 2 seconds. Using “1 second” is 
not a guarantee that this 10% requirement will always be met, 
especially if a large number of corrections are transmitted.

Features NA
P/N111360

EU
P/N111359

Radiated Power 0.5 W 0.5 W
Frequency Band 902-928 MHz 869-870 MHz
Number of channels 50 (#0 to #49) 3 (#0 to #2)
Frequency Hopping Yes, every 30 ms No

Duty Cycle No restriction < 10%; 2-sec transmit rate 
min. recommended

Data rate 10 kbits/sec 10 kbits/sec



Power/Data Cable. Each radio modem is fitted with a cable for 
easy connection to the ProMark3. The wiring diagram and pi-
nout are provided below. 

NOTES: In the radio, pins 2 and 3 are shorted internally (pins 
10 and 11 as well). The +5 V DC OUT signal (pin 1) is provid-
ed by the ProMark3 RTK to power the radio.
External Power Source. An external DC source (9 to 17 V DC) 
can be used to power both the radio modem and the ProMark3 
RTK unit and also charge the ProMark3’s internal battery. Us-
ing an external power source is recommended to extend the 
operating time of a ProMark3 RTK base.
In this configuration, keep the power/data cable connected 
between the ProMark3 and the radio modem and add a two-
wire cable (not provided), also passing through the base of the 
radio.
The additional cable should be connected to the screw termi-
nal block, inside the radio modem, according to the table be-
low.

Using another radio model. See Using Another Radio Model 
on page 268.

Wire Color Signal Name Pin Number
White TX (Data) 6
Red +DC IN 11

[Braid] Ground 2
Yellow +5 V DC OUT 1
Blue RX (Data) 5

External
DC Source

Pin Number on Terminal Block
(see these numbers in the diagram above)

+ DC IN 10
- DC IN 3

[Braid]

Blue

White

Red

Contact Side View
(Connector

on ProMark3
side)

Yellow

Power/Data Cable 

Screw Terminal Block
(Inside radio modem)

1110987654321
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Brackets for License-free Radio Modems
Each radio modem comes with its own bracket for easy instal-
lation on a pole. The radio modem is secured on the bracket 
using the four screws and washers provided.
At the base, the radio modem/bracket assembly should be 
mounted on the RTK vertical antenna extension so the radio 
modem and its antenna can easily fit under the GNSS anten-
na.
At the rover, the radio modem/bracket assembly should be 
fixed on the pole range, just underneath the GNSS antenna.

RTK Vertical Antenna Extension
This pole is for use at the base. It has sufficient height to let 
you fasten the radio modem/bracket assembly between the 
GNSS antenna and the tripod.
If the radio modem needs to be installed at a higher height to 
improve the range of the data link, then a separate, higher 
mast should be used for the radio modem. Remember howev-
er that the radio cable is only 1.20 meter long.

FAST Survey Software Option
This software option is a high-end field survey application for 
ProMark3 RTK. The FAST Survey CD includes all the versions 
available for Magellan products (Z-Max.Net, ProMark3 RTK) 
as well as the user documentation.



Additional Items Required but not Supplied

For Static Surveys or Base Stations
These items allow you to firmly position the GPS antenna  over 
the survey point or station site (see opposite) at a measurable 
height from the ground.
These items (tripod, tribrach and tribrach adapter) are illus-
trated below.

Tripod

Tribrach Adapter

Tribrach
Levelling bubble

Optical sightLevelling screw

Lock for antenna 
adapter

Antenna adapter
5/8 x 11 UNC thread

Tribrach Adapter 
mounted to Tribrach:

Locking tab
11
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An option to the tripod, tribrach and tribrach adapter combi-
nation is the fixed-height GPS tripod (see below).

For Kinematic Surveys
An option for mounting the ProMark3 rover when operating in 
kinematic mode is a range pole (see picture below showing a 
ProMark3 ready for post-process kinematic surveying).



Specifications

General Characteristics
• 14 parallel channels
• L1 C/A code and carrier
• SBAS tracking and use in RTK process
• Update rate: 1 Hz
• Time tagged (synchronous) and Fast RTK (extrapolation)
• RTCM 2.3 (rover mode) and 3.1 (base and rover mode)
• Compatible with VRS,FKP,MAC Networks
• Connectivity: NTRIP & Direct IP
• Protocol NMEA0183

Real-Time Accuracy (1) (3) (4)

RTK (horizontal accuracies)

• Fixed: 1cm (0.032ft) +1ppm
• Float: 20cm (0.656ft) +1ppm (CEP), convergence: 3 min

SBAS (WAAS/EGNOS) (rms)

• Horizontal: <1m (3ft)

DGPS (Beacon or RTCM) (rms)

• Horizontal: <1m (3ft)

Post-Processed Accuracy (1) (2)

Static Survey (rms)

• Horizontal: 0.005 m + 1 ppm (0.016 ft + 1 ppm)
• Vertical: 0.01 m + 2 ppm (0.032 ft + 2 ppm)
• Azimuth: < 1 arc second
• Observation Time: Ranges from 4 to 40 min depending on 

distance between the receivers and other environmental 
factors.

(1) Performance varies on satellite conditions and may not apply at all time in 
all area in the world. High-multipath areas, poor satellite geometry, and periods 
of high-activity atmospheric conditions will degrade accuracy. Accuracy and 
TTFF specifications based on tests conducted in Nantes and Moscow. Tests in 
different locations under different conditions may produce different results.
(2) PP accuracies assume minimum of 5 satellites, following the procedures 
recommended in the product manual. Post-processing with GNSS Solutions 
Software.
(3) RTK accuracies assume minimum of 7 satellites (GPS+SBAS), following the 
procedures recommended in the present manual.
(4) For baselines <10 km
13



14
Kinematic Survey

• Horizontal: 0.012 m + 2.5 ppm (0.039 ft + 2.5 ppm)
• Vertical: 0.015 m + 2.5 ppm (0.049 ft + 2.5 ppm)
• Recommended Initializer Bar Occupation: 5 min

Data Logging Characteristics
Recording Interval

• 1 - 30 seconds.

Internal Memory Capacity

• Up to 72 hours of 10 satellite data @ 1 second interval

Physical Characteristics
Receiver

• Size: 19.5 x 9 x 4.6 cm (7.7 x 4.6 x 1.8 in)
• Weight: 0.48 kg (1.05 lb) with battery

Antenna

• Size: 19 x 9.6 cm (7.5 in DIA x 3.8 in H)
• Weight: 0.45 kg (1.00 lb)

Radio

• Size: 14,5 x 10 x 4 cm (5.7 x 3.9 x 1.6 in)
• Weight: 0.20 kg (0.44 lb)

User Interface

• Full color advanced TFT liquid crystal display with back-
light

• 320 x 240 resolution with 262.144 colors
• Resistive touch panel
• Keyboard with backlight 20 buttons
• Audio: built-in speaker

Memory

• 128 MB SDRAM, 128 NAND Flash memory
• Removable SD Card: up to 1 GB

Communication

• Bluetooth wireless technology
• USB: host and slave
• RS232

Radio (base and rover mode)

• License-free radio 500 mW, 869 MHz for Europe, 902-
928 MHz for North America.



Environmental Characteristics
Receiver

• Operating Temp: -10°C to 60°C (14°F to 140°F)
• Storage Temp: -20°C to 70°C (-4°F to 158°F)
• Weather: Water-resistant
• Shock: 1.5 m (4.9 ft) drop on concrete.

Antenna

• Operating Temp: -55°C to 85°C (-67°F to 185°F)
• Weather: Waterproof
• Shock: 2 m (6.6 ft) drop on concrete.

Radio

• Temp: -20°C to 70°C (-4°F to 158°F)
• Meets IP65

Power Characteristics
• Battery type: 3.7 V Li-Ion, 3900 mAh
• Battery life: 8 hours (typical operation), 6 hours with radio 

connected
• External power for extended operation time.
15
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Post-Process Surveying with ProMark3

The ProMark3 system is designed to perform GPS surveys us-
ing static, stop-and-go, and kinematic modes of GPS data col-
lection. The three modes run independently.
In the Static data collection mode, the GPS receiver systems 
simultaneously collect raw data from all available satellites 
while remaining stationary on their respective points. Data 
collection continues at these locations for a duration depen-
dent upon the distance between the receivers, the satellite ge-
ometry, and the obstruction conditions at the data collection 
locations (i.e., trees or buildings blocking some of the sky).

When data collection is complete at these specific points, you 
move the GPS receiver systems to a new set of points to begin 
another data collection session. In most cases, one GPS re-
ceiver system will remain on its current point (pivot point) in 
order to link the previous set of points to the new set of points, 
in leap-frog fashion. After data collection is complete, data is 
downloaded form the GPS receivers to an office computer for 
post-processing using the GNSS Solutions software.

Data collected on surveyed point:

Base

Baseline
(Range)

Observation time

Data collected at base:

Known Point Survey Point

Rover



The post-processing activity computes vectors (position differ-
ences) to determine the position of all observed points relative 
to one or more fixed point positions. The static data collection 
method produces the most accurate and reliable results of any 
mode of GPS data collection. This is due primarily to the ex-
tended observation periods required for static data collection.

In the Stop-and-Go data collection mode, the GPS receiver 
systems simultaneously collect raw data from all available sat-
ellites while stationary on their respective points and while 
moving between points. In most cases, one GPS receiver is lo-
cated on a known point serving as a base station collecting 
data at that location for the duration of the survey. Additional 
GPS receivers are used to locate objects and move between 
points. The occupation period for the stop-and-go method is 
much shorter than the static method.

Data collected by rover:

Base

Data collected at base:

Known Point Survey Point

Rover

Base
0001

0002

0003

0004

000500060007

0001 0002 0003 0004 0005 0006 0007

Occupation: 15 sec. typical

Init

Rover
Init Point
17
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After data collection is complete, data is downloaded from the 
GPS receivers to an office computer for post-processing using 
the GNSS Solutions software. The post-processing activity 
computes vectors (position differences) to determine the po-
sition of all observed points relative to one or more fixed point 
positions. The Stop-and-Go data collection method is faster 
than the static method, but not as accurate since the occupa-
tion period is much shorter.

In the Kinematic data collection mode, the GPS receiver sys-
tems simultaneously collect raw data from all available satel-
lites while a receiver is moving.

In most cases, one GPS receiver is located on a known point 
serving as a base station collecting data at that location for the 
duration of the survey.

Data collected by rover:

Base

Data collected at base:

Known Point Survey Point

Rover

0001... 0015...Init

Base

Rover

Init Point

5 min. with bar

0014

0015

0001



Additional GPS receivers are used to locate linear objects 
such as roads or collect data in a linear fashion for developing 
topographic elevation data.
The recording interval should be set to collect the amount of 
data needed relative to the speed of travel.
A recording interval too long will result in insufficient data.
After data collection is complete, data is downloaded from the 
GPS receivers to an office computer for post-processing using 
the GNSS Solutions software. The post-processing activity 
computes positions of all observed points relative to one or 
more fixed point positions. The Kinematic data collection 
method is best used for delineating linear type features such 
as roads, fences, lakes, etc.

Real-Time Surveying with ProMark3 RTK

The ProMark3 RTK system has all the survey and mobile map-
ping functions of a ProMark3, but in addition, it can perform 
real-time surveys. In this operating mode, the ProMark3 RTK 
delivers real-time, centimeter-accurate position solutions.
The ProMark3 RTK allows you to also log raw data while a real-
time survey is in progress.
As shown in the diagram below, there are two possible system 
configurations to implement RTK in the ProMark3 RTK:

- In base/rover configuration, you need to install your own 
base as well as a radio link to transfer RTCM corrections 
from the base to the rover.

- In rover-only configuration, you need a Bluetooth-enabled, 
GPRS-enabled cell phone to connect the ProMark3 RTK to 
the Internet. RTCM corrections will be delivered to the 
unit by an external corrections provider, via the Internet 
and the cell phone.

Base/Rover Rover-Only
(Network Connection)

Base
RoverRadio Data Link Rover

GPRS Data LinkInternet

+ Cell
Phone
19
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Three different real-time jobs can be performed with the 
ProMark3 RTK:
- Point Logging: RTK positions of points that you visit in 

turn are logged in a file (a vector file with the “O” prefix).
- Kinematic: Logging a trajectory. Each point logged by the 

system while you are walking along the trajectory will fea-
ture centimeter accuracy. The trajectory can be logged 
either in Time or Distance mode. With the first mode, a 
new position will be logged every x seconds of time 
elapsed. In the second mode, a new position will be 
logged every x meters of distance traveled.

- Stakeout: Taking you to the exact location of a stakeout 
point. Stakeout points are initially target points in a GNSS 
Solutions project. Uploading these points to ProMark3 
RTK using GNSS Solutions converts them into control 
points. ProMark3 RTK helps you to find the exact location 
of these control points in the field through adequate guid-
ance screens.



Mobile Mapping with ProMark3

The ProMark3 system is also designed to log GIS features in 
a job file.
GIS features can be of the following types: points, lines, areas 
and grids. Grid features are Magellan’s specific features de-
tailed in Logging GIS Data on a Preset Grid Feature on 
page 134.
ProMark3 provides in real-time the length of the line you are 
logging or the surface area of the area you are logging.
You don’t need an external antenna or any other accessories 
to collect GIS jobs. You just need to hold the unit at 45° from 
horizontal, not too close to you, and make sure you constantly 
have an open view of the sky.
If however you want your GIS surveys to benefit from the RTK 
precision level, you will have to use an external antenna and 
set the RTK surveying method as explained in RTK Setup on 
page 34.
When you start a new GIS job, ProMark3 asks you to:
1. Choose a feature library for the job.

A feature library lists all the possible feature types you will 
see in the field. It also provides all the possible attributes 
for each feature type and all the possible values for each 
attribute.
After you have chosen a feature library, you will only be 
able to log features that comply with those prompted in 
this library. You will not be able to add an extra feature 
type or an extra attribute to an existing feature. So choos-
ing a library implies that you know the type of job you 
want to do.

2. Choose between Real-Time and Post-Processing.
GIS features can be logged in Real-Time or Post-Process-
ing mode.
In Real-Time mode, any logged feature is georeferenced 
using the real-time position determined by the ProMark3.
In Post-Processing mode, it is also the real-time position 
that is associated with each logged feature but you have 
the possibility to improve the accuracy of this real-time 
solution through post-processing. This can be achieved 
using MobileMapper Office.
21
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After making these two choices you can start logging your GIS 
features in the open job. The navigation screens may be help-
ful to guide you to the features you have to go to. 
When you are next to the feature type you want to log, a point 
feature type for example, describing the feature is very quick 
and easy as you just have to scroll through the different at-
tributes prompted by the library and set them according to the 
information you get from the field (examples: the “color” of 
the feature is “black” or the “condition” of the feature is 
“needs maintenance”, etc.).
In the background, ProMark3 will add georeferencing informa-
tion (i.e. one position for a point feature, several positions for 
a line or area feature) to the description of the feature.
After data collection is complete, data is downloaded from the 
ProMark3 to an office computer using the MobileMapper 
Transfer utility of the MobileMapper Office software.
From this software you can export the job to your GIS in a stan-
dard GIS format (SHP, MIF, CSV or DXF).
If the job was logged in Post-Processing mode, MobileMapper 
Office will allow you to post-process the job. Real-time posi-
tions of features will be differentially corrected using raw GPS 
data from a nearby reference station.
You can also use MobileMapper Office to upload a previous 
job to ProMark3. In this case, the ProMark3 will be used to 
update the content of this job. The different features con-
tained in the job will be revisited in the field to update their 
attribute values or positions.



More information on SBAS 
is available at http://

www.faa.gov/asd/interna-
tional/sbas.htm

More information on 
WAAS is available at the 

FAA web site http://
gps.faa.gov/Programs/

WAAS/waas.htm.
More information on 

EGNOS is available at 
http://www.esa.int/

EGNOS/. 
Navigating with ProMark3

The ProMark3 includes a wide range of navigational capabili-
ties that you will find useful in your day-to-day surveying and 
mobile mapping operations. Two useful navigation features 
are:
• The map screen can be utilized to help you find a project 

site.
• The ProMark3 serves as an excellent reconnaissance tool. 

You can enter the known coordinates of the feature you 
wish to reckon as a waypoint, and use ProMark3 to navi-
gate to within 3 meters (10 feet) of the feature in the 
field. Be sure to select the correct map datum and coordi-
nate system (use the USER option from the Map Datum 
list to define a custom map datum).

ProMark3 includes the capability to utilize SBAS (Space-
Based Augmentation System).
SBAS includes the Wide Area Augmentation System (WAAS) 
for the North American continent and the European Geosta-
tionary Navigation Overlay System (EGNOS) to provide im-
proved positioning accuracy.
These systems calculate errors in the GPS signal, then trans-
mit correction messages to capable GPS receivers. Typical ac-
curacy with SBAS is three meters, although this accuracy can 
be degraded by multipath reflections and poor satellite geom-
etry.
ProMark3 can also deliver real-time DGPS position fixes for 
your navigation using the MobileMapper Beacon from Magel-
lan or any other external corrections receiver.
ProMark3 RTK can deliver RTK position fixes that you can use 
for your navigation.
23
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Time Spent in The Field

Post-Processing
In general, the amount of time required to occupy a point de-
pends on several factors:
1. Distance between survey points. In general, the greater 

this distance, the longer the observation time.
2. Environmental conditions, or the amount of obstruction or 

canopy preventing a completely open sky view. Some 
obstructions may block the reception of the satellite sig-
nal, requiring longer observation times to collect addi-
tional data for accurate processing.
Too much obstruction prevents ProMark3 (or any GPS 
receiver) from receiving enough data to establish quality 
survey positions.

3. Satellite Geometry (PDOP): This refers to the position of 
the satellites that are orbiting the earth. If the satellites 
are positioned poorly (i.e. all on one side of the sky), it is 
more difficult to get an accurate position. The Mission 
Planning Tool in GNSS Solutions assists in planning sur-
vey times with optimal geometry.

Static
You will find that Static observation times will vary between 4 
and 40 minutes depending upon factors 1, 2, and 3 above. 
The Observation Range feature of ProMark3 is designed to as-
sist in determining observation times.
The Observation Range takes into consideration the number of 
satellites and satellite geometry, and determines when enough 
data has been collected for a given distance between points.
For more information on the observation range, please refer to 
pages  87 and 93.

Stop-and-Go
Since the Stop-and-Go method requires an initialization, the 
occupation times are much shorter than the static method.
Initialization on a known point can be accomplished in as lit-
tle as 15 seconds with a 1 second recording interval.
Initialization with the initializer bar is typically 5 minutes.
Stop-and-Go point occupations can be accomplished in as lit-
tle as 15 seconds with a 1 second recording interval.
These occupation times may vary depending upon the three 
factors 1, 2 and 3 described above.



Kinematic
The Kinematic method also requires an initialization as de-
tailed in the Stop-and-Go method.
Kinematic data collection does not use an occupation timer 
since kinematic data is collected while moving. The recording 
interval must be set to a value that properly matches the 
speed you are moving.
A recording interval set too slow may result in data that does 
not represent the feature being surveyed. A recording interval 
set too fast may result in data too dense for a particular appli-
cation (This is also true in Static and Stop-and-Go).
The base and kinematic units must be set to the same record-
ing interval for successful kinematic survey.

Real-Time Surveying
If a base/rover configuration is used, time is needed first to in-
stall and run the base. Allow for about 5 to 15 minutes to 
complete this installation phase.
Then, and whatever the survey type, rover initialization is re-
quired at power-on before operators can start their jobs.
The initialization time depends on the environmental condi-
tions, mainly sky view, which has a direct impact on the num-
ber of satellites received, and the baseline length, i.e. the 
distance to the base providing the RTCM corrections.
In general, RTK initialization is achieved after 1 to 3 minutes 
of operation under open sky, and for a baseline length less 
than 6 miles (10 km). See performance figures in Time to First 
Fix (TTFF) on page 223.
In point logging mode, operators will have to stay on each 
point for typically 10 to 15 seconds to let the ProMark3 RTK 
average the successive position solutions computed during 
this time. Operators are however allowed to reduce this time 
but they should be aware this may affect position accuracy.
In kinematic mode, operators should adjust the pace to the re-
cording interval they choose. In Time mode, the recording in-
terval can range from 1 to 30 seconds. In Distance mode, the 
default setting is 10 meters.
In stakeout mode, once operators get close to their stakeout 
points (about 20 meters still to go), they should slow down the 
pace to let the ProMark3 RTK respond to their moves. By do-
ing this, they will allow their units to deliver the accurate guid-
ance instructions they need to get to their points.
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Mobile Mapping
The ProMark3 needs 2 or 3 seconds to open a feature, record 
at least one epoch and close the file successfully. So when you 
open a point feature, please record for 2 or 3 seconds before 
closing the feature. To improve accuracy of point features, we 
recommend recording for 30 seconds - or even longer for op-
timal accuracy.
For jobs performed in post-processing mode, the time require-
ments are those defined above for Stop-and-Go and Kinematic 
surveys keeping in mind that all GIS/Mapping jobs implicitly 
use an OTF initialization.

Where to Find Information

This manual is designed to guide you through the ProMark3 
Surveying and Mobile Mapping procedures as well as provide 
general reference. You can find additional information in the 
following documents:
ProMark3 Getting Started Guide: This manual describes the 
basic procedures to start using ProMark3 in surveying and mo-
bile mapping. It also briefly explains how to download your 
field data to the office software and how to process this data.
GNSS Solutions Reference Manual: This manual provides de-
tailed instructions for post-processing and presenting the data 
collected by ProMark3.
MobileMapper Office User Manual: This manual provides de-
tailed instructions for interfacing the ProMark3 with your GIS.
Magellan Navigation FTP site:  Many useful documents relat-
ing to the ProMark3 are available at the following FTP site:  
ftp://ftp.magellangps.com/Reference Manuals/ProMark3



Battery Life

Whether used as a rover or 
a base, ProMark3 will run 
for 8 hours with its inter-
nal battery in typical con-

ditions of use. 
2. Preparing For First-Time Use

Charging the ProMark3 Battery Pack

The ProMark3 includes a rechargeable, replaceable battery 
pack. Before using the receiver, you must first charge the bat-
tery pack:
1. Locate the removable battery provided.
2. Open the battery door, located in the back of the receiver, 

using a screwdriver or a coin.
3. Insert the battery –label side upward, contact towards the 

top of the unit– into the battery compartment:

4. Close the battery door and tighten the screws.
5. Attach the Clip-on I/O module to the receiver as shown 

below (Insert bottom first, hold down release button, press 
I/O module against unit and release button):

6. Connect the AC adapter (see below) and then let it charge 
the battery for approximately six hours.

Connect cable from AC 
adapter to this input
27
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ProMark3 Start-up Screen
7. To detach the clip-on I/O module, press the release button 
on the module.

Turning On/Off the Receiver

Once you have charged the battery, press the red key (the pow-
er key) on the front of the receiver until the power indicator 
turns solid green.
You will first see the receiver’s start-up 
screen (see opposite left). Wait for the 
progress bar to complete its sequence. 
The screen then displays the ProMark3 
workspace with its main icons (see op-
posite right).
There are three categories of programs 
behind these icons:
- ProMark3 primary functions: Survey-

ing and Mobile Mapping icons.
For a ProMark3 RTK with the FAST 
Survey software option installed and 
unlocked, you will also see the FAST Survey icon.

- DGPS Configuration icon, for a quick access to the DGPS 
configuration options.

- Settings and Utilities icons giving access to the complete 
sets of setup and utility programs.

When you need to turn off ProMark3, simply press the  red 
key until the screen displays the Shut Down window and then 
tap OK.

ProMark3 Workspace



Calibrating the Screen

For the first-time use, you need to align your display screen so 
the cursor on the touch screen align with the tip of your stylus. 
Use the stylus pen to tap the center of each target that ap-
pears on the Calibration screen with the tip of the stylus. Tap 
anywhere on the display when finished.
To re-calibrate your screen at anytime, double-tap the Settings 
icon then double-tap Stylus from the list, tap the Calibration 
tab and then follow the instructions.

Automatic System Time Update

ProMark3 will automatically update the system date & time 
using the GPS time determined by the integrated GPS receiver 
and the time zone that you specify. To set the time zone:
• In the ProMark3 workspace, double-tap the Settings icon.
• Double-tap the Date/Time function. This opens the Date/

Time Properties screen. 
• Set the time zone field (see opposite) and then select OK 

on top of the screen.
Please note that you should wait for a few seconds, after 
turning on ProMark3, before system time can effectively 
be updated.

Adjusting the Backlight

To switch the backlight on/off for both the keypad and display, 
or to adjust the brightness and screen contrast, double-tap the 
Settings icon on the ProMark3 workspace and then double-tap 
the Backlight Control function.
To conserve battery power, we recommend you to switch the 
backlight off whenever possible.
For other settings, please refer to the ProMark3 Reference 
Manual.
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Please Go Outside to Per-

form Initialization!
Initialization is required 
when 1) the receiver is 
brand new, 2) you have 
moved more than 500 

miles from the last place 
you were using it, 3) mem-

ory has been completely 
erased or 4) the receiver 

has not been used for more 
than a few months.
Initializing GPS

Take the receiver to a location where there is a clear view of 
the sky, then:
- From the ProMark3 workspace, tap successively the Utili-

ties icon and then the GPSInit icon.
- Initialize the receiver using one of the two methods below:

1.If you don’t have the slightest idea of what the coordi-
nates of your current position are, check the Choose 
Country option (see screen below left), select respec-
tively your region and country in the two fields under-
neath, enter the date and time (bottom of the screen) 
and then tap OK to start the initialization process. This 
closes the GPS Initialization window.

2.If you have a rough idea of what the coordinates of 
your current position are, directly enter these coordi-
nates in the Latitude and Longitude fields (see screen 
above right), enter the date and time (bottom of the 
screen) and then tap OK to start the initialization pro-
cess. This closes the GPS Initialization window.



Preliminary Settings

From the ProMark3 workspace, do the following:
• Double-tap the Surveying icon if you want to perform a 

real-time (ProMark3 RTK only) or post-processing survey.
• Or double-tap the Mobile Mapping icon if you want to per-

form a GIS job.
Whatever your choice, ProMark3 will then display a navigation 
screen.
Just press the NAV or ESC button to scroll through the differ-
ent available navigation screens.
For more information on Navigation screens, please refer to 
Navigation on page 143.

Access to Preliminary Settings
Now that ProMark3 displays a navigation screen, press the 
MENU key and tap Setup (see screen opposite).
There are many options to select among, and all are explained 
in full from page 226. For the purposes of getting started, 
however, we will concentrate on just a few of these options.
As a general rule, tap an option to open the corresponding set-
ting window. Then tap the desired value. This will enable the 
value and take you back to the Setup menu. You can also re-
turn to the Setup menu by pressing the ESC button.

Choosing the Storage Medium
ProMark3 can store your jobs either in its internal memory or 
on the SD card you have inserted in the unit. Tap the desired 
option.
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Entering the Receiver ID
(From within Surveying function only)
The Receiver ID screen provides you with the ability to enter 
the 4-character receiver ID which is used in naming the raw 
data files. Each raw data file from this receiver will include 
this 4-character receiver ID.

Specifying the Antenna Used
You select this option to define the type of external antenna 
used.
Three different types of antennas are listed (ProMark Antenna 
110454, NAP100 or Other). If you choose “Other”, you will 
have to define the following parameters for your antenna: an-
tenna radius, phase center offset and Slant Height Measure-
ment Point offset (SHMP offset).
The choices made through the External Antenna option be-
come the default antenna settings for all the ProMark3 survey-
ing and mobile mapping functions.

Choosing the Units
You select this option to set the units of measurement you 
want to use. Units are presented in this order: long distances, 
short distances, speed and area. You can set these units to 
“kilometers, meters, kph and hectares” or “miles, feet, mph, 
acres” if you like, or to three other standard sets of units. You 
can also create a custom mix of units by selecting the Ad-
vanced option that contains a wide variety of units for dis-
tance, speed, elevation, bearing and area.

Antenna Radius

SHMP
Offset

Phase Center 
Offset



Satellite Status screen
Checking that ProMark3 Receives Satellites
Press NAV repeatedly until the Satellite Status screen is dis-
played. This screen shows which satellites the receiver is 
tracking and where they are located in the sky. If you are not 
tracking 3 or more satellites you may have to move to a more 
open area.
When used with its internal antenna (Mobile Mapping only), 
the receiver will have the best view of the sky when you hold 
it at an angle of 45 degrees from horizontal and not too close 
to you.

This allows the internal antenna to function optimally for the 
best accuracy.
In Survey jobs for which the external antenna is mandatory, 
only the vertical orientation of this antenna is important.

45°
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When the base setup is 

under your responsibil-

ity, make sure the base 

is sited in a clear area 

giving the best possible 

view of the sky!

When this is possible, 
avoid trees, buildings 

or any high obstacles in 
the vicinity of the base. 

Having a clear view of 
the sky will allow the 
base to collect data 
from a maximum of 

visible satellites, which 
is highly recommended 

to perform a 
successful, accurate 

and fast survey. 
3. RTK Setup

Introduction to RTK 

Enabling the RTK algorithm in the ProMark3 RTK is simply 
done by launching “Surveying”, pressing MENU, selecting 
Receiver Mode and then Real-Time or Real-Time & Raw Data 
Recording.
From this time on, the ProMark3 RTK will operate to deliver 
fixed position solutions, provided the operating requirements 
are met.
Selecting Real-Time & Raw Data Recording is a safe way to 
perform a real-time survey. With raw data recorded in the 
background, you will have the capability to post-process the 
raw data in the office. This however requires that base raw 
data be also available for the same period of time (see also 
page 74).
The table below summarizes the keywords and principles used 
in the RTK technique. Please carefully read this table before 

getting started.

1. Corrections. Corrections generated by a static receiver 
(“base”) are needed for the rover to be able to deliver 
centimeter-accurate positions. 

2. Data Link. The data link that must be established to 
transfer corrections from the base to the rover can be 
implemented in three different ways with 
ProMark3 RTK: license-free radio, cellular phone 
(GPRS) or any other external RTCM device.

3. Base. Depending on the chosen data link, the base will 
be either:
• A ProMark3 RTK set as a base and generating 

RTCM3.1 corrections.
• Or an external provider delivering its corrections via 

the Internet. In this case, corrections may be the 
following: RTCM3 or RTCM2.3.



4. ProMark3 RTK Configurations

5. Rover Initialization. Before starting a survey, the rover 
must be initialized. There are four possible methods: 
“On The Fly”, “Static”, “Known Point” and “Bar”. The 
“Bar” method can only be used if you have your own 
base.
Three of the initialization methods are introduced in 
the post-processing chapter (see page 98). The de-
scription is accurate for real-time processing too. Un-
like post-processing though, real-time processing tells 
you in real time when initialization is complete. The ad-
ditional “Static” method is similar to “On The Fly” but 
requires that the antenna be kept still (on an unknown 
point). 
The time required for initializing the rover ranges from 
a few seconds to a few minutes, depending on the base-
line length, the GPS constellation and the initialization 
method used.
“Known Point” and “Bar” are the fastest initialization 
methods.

6.  Baseline Length. Whatever the base used, its distance 
to the rover, called “baseline” (up to 1.6 km or 1.0 mile 
with license-free radios, up to 10 km with a network 
connection), must roughly be known to make sure RTK 
positions will achieve the expected level of accuracy.

Base/Rover
(Base/rover System)

Rover-Only
(Network Connection)

Base
RoverRadio Data Link Rover

GPRS Data LinkInternet

+ Cell
Phone
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Base/Rover Configuration

You are using your own ProMark3 RTK base to generate the 
RTCM corrections needed by the rover. A pair of Magellan li-
cense-free, plug-and-play radios is used for the data link.

About the Base Position
In addition to the good reception conditions required at the 
base (see page 37), you must also think about whether the 
base position should accurately be known with great precision 
or not. The explanations below will help you understand what 
you need in terms of base position accuracy.
1. If you are only interested in performing relative measure-

ments (i.e. positions of points relatively to other points), 
then the base can be installed on an unknown point meet-
ing the reception requirements (see page 37). In this 
case, the position to be entered in the base can only have 
meter accuracy.
Caution! Keep in mind you will not be able in this case to 
attach your points to a known coordinate system unless 
later you accurately determine one of these points in the 
desired coordinate system. If you are using FAST Survey, 
you can also use the Localization function to attach your 
job to your local system.

2. If you want to obtain absolute, centimeter-accurate posi-

tions attached to a particular coordinate system for all 
your surveyed points, then the base position must be 
known with the same centimeter accuracy.
If this position is already defined in a GNSS Solutions 
project, just upload this position as a control point from 
the GNSS Solutions project to the ProMark3 RTK base. 
You will then simply have to select this point in the base’s 
Site ID field (see page 39).
If the chosen position for the base is unknown whereas 
you need centimeter accuracy for this point in the coordi-
nate system used, you can determine it through a static 
post-processing survey. You will however need a reference 
position to determine this point (see page 84).



5.

6.
2.

3.

4.
7.

11.

1.

Setup with Kinematic Bar
Setting Up the Base
The installation site should offer the best possible GPS recep-
tion conditions. The antenna should have a clear view of the 
sky in all directions. There should be no, or a minimum of sat-
ellite obstructions in the vicinity.

1. Set up the tripod / tribrach combination over the point.
2. Screw the RTK vertical antenna extension into the tri-

brach.
3. If you wish to initialize the rover through the “Bar” initial-

ization method, insert the kinematic bar on top of the RTK 
vertical antenna extension. If you will be using the “On 
The Fly”, “Static” or “Known Point” initialization method, 
skip step 3.

4. Attach the GNSS antenna on top of the kinematic bar (for 
the “Bar” initialization method), or on top of the RTK ver-
tical antenna extension (for all other initialization meth-
ods).

5. Mount the license-free radio onto its bracket using the 
screws, nuts and washers provided.

10.

8.

12.

H Slant

H Vertical

5.

9.

Setup without the Kinematic Bar
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The higher the radio, the 

better the quality and 
range of the radio link.

Warning!
Unscrewing the radio 
antenna protection is 

pointless or even hazard-
ous for the antenna.
6. Secure the radio bracket onto the RTK vertical antenna 
extension. Place it as high as possible, just underneath 
the GNSS antenna, as shown. Placing the radio too low 
will reduce the radio range.

7. Connect the external antenna cable to the GNSS antenna.
8. Connect the other end of the external antenna cable to the 

ProMark3 RTK. Lift the flap on the side on the unit to 
access the antenna input connector.

9. Connect the radio cable to the back of the receiver. The 
connection is secure after you have fully tightened the 
thumb screw.

10.Place the ProMark3 RTK receiver into the field bracket.
11.Attach the field bracket / ProMark3 RTK combination 

onto the tripod.
12.Measure and record the instrument height (HI) of the 

GNSS antenna:
• Slant measurement (preferred): Use the measurement 

tape provided. Insert the end of the tape into one of 
the three or four hooks located on the circumference 
of the GNSS antenna radome. Unroll the tape toward 
the reference point. Position the tip of the tape meas-
urement onto the reference point. Block the tape and 
read the value indicated at the base of the tape: this is 
the slant height.

• Vertical measurement (more difficult; tribrach and tri-
pod are in the way): Use a conventional tape to meas-
ure the vertical distance from the base of the GNSS 
antenna to the reference point.

13.Turn on the ProMark3 RTK and check that the green LED 
indicator on the radio is on. This means the connection 
between the radio and the ProMark3 RTK is correct and 
the radio is normally powered.



Configuring the Base
1. Double-tap the Surveying icon.
2. Press MENU, tap Receiver Mode, then Real-Time.
3. Press MENU, tap Base Station and then enter the base 

parameters:
• Station ID: Enter a 4-character string (0.. 4095) for an 

unambiguous identification of this base.
• Height Type: Indicate the type of height (Slant or Verti-

cal) you measured while setting up the base ( see step 
12 on page 38).

• Antenna Height: Enter the height you measured while 
setting up the base (see step 12 on page 38).

• Units: Indicate the unit used to measure the antenna 
height (meters, US feet or Int feet).

Depending on whether the base is installed over an 
unknown or known point, do the following to enter the 
base position:
Unknown:

• Tap on the right arrow next to the Site ID field. Select 
Current Position from the list. This assigns the current 
position computed by the ProMark3 RTK to the base 
(see Location and Elevation fields). Before making this 
selection, make sure the ProMark3 RTK has deter-
mined the position (see Position screens on page 147) 
and this position has been averaged for some time. 
Note that the Site ID field is changed to ???? in this 
case.

Known: Two possible scenarios:
• Base installed on a control point stored in the 

ProMark3 RTK: Tap on the right arrow next to the Site 
ID field. This opens a points list from which you can 
select the control point name corresponding to where 
the base is installed. Choose this point name. This 
automatically sets the Location and Elevation fields to 
the right coordinates.
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NOTE: Control points uploaded to ProMark3 RTK have 
always their coordinates converted to WGS84. When 
you select a control point for use as the base position, 
these coordinates are again converted, this time to the 
coordinate system (see page 237) and map datum 
(see page 238) used in the ProMark3. The converted 
coordinates are displayed in the Location and Elevation 
fields.

• Manual entry: Tap successively inside the Location and 
Elevation fields and enter the known coordinates. Make 
sure your entries are compatible with the coordinate 
system (see page 237) and map datum (see 
page 238) used in the ProMark3.

4. Tap Start. The ProMark3 RTK starts operating as a base. 
RTCM 3.1 corrections are now broadcast via the radio 
modem. The screen shows the following parameters:
• Site ID: As a reminder
• Elapsed: Time elapsed since you started the base sta-

tion
• # Sats: Current number of satellites received
• PDOP: Current PDOP value
• Base Station Position: 3D coordinates of the point above 

which the base is installed.
• Power indicator (all green: fully charged)
• Free memory indicator (all green: maximum)

Later, after you have finished your survey and you come back 
to the base to switch it off, first tap Stop. The ProMark3 RTK 
will instantly stop transmitting RTCM corrections.



7

6

5

H Slant

H Vertical
Setting Up the Rover
Install the unit on its range pole:
1. Mount the GNSS antenna on top of 

the pole. For a “Bar” initialization, 
use a quick release extension so you 
can easily move the antenna between 
the kinematic bar and the range 
pole. For the other initialization 
methods, there is no such require-
ment.

2. Mount the radio modem onto its 
bracket using the screws, nuts and 
washers provided.

3. Secure the radio bracket onto the 
pole.

4. Connect the GNSS antenna to the 
ProMark3 RTK using the cable pro-
vided.

5. Connect the radio cable to the back 
of the ProMark3 RTK.

6. Attach the field bracket onto the pole
7. Place the ProMark3 RTK into the field bracket
8. Measure or read the height of the GNSS antenna:

• Slant measurement: Use the measurement tape pro-
vided. Insert the end of the tape into one of the three 
or four hooks located on the circumference of the 
GNSS antenna radome. Unroll the tape toward the 
ground. Position the tip of the tape measurement onto 
the ground. Block the tape and read the value indi-
cated at the base of the tape: this is the slant height.

• Vertical measurement: Use a conventional tape to 
measure the vertical distance from the base of the 
GNSS antenna to the ground. If you are using a gradu-
ated range pole, read the value given by the gradua-
tion.

1

2-3

6-7

4

8
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Configuring the Rover
1. Turn on the ProMark3 RTK.
2. Double-tap the DGPS Configuration icon. This opens the 

DGPS Configuration window.
3. Tap Select Mode, select UHF and tap OK. Tap OK again to 

close the DGPS Configuration window.

Initializing the Rover
1. For a “Bar” initialization, move 

the rover antenna from the range 
pole to the kinematic bar (see pic-
ture right). For all other initializa-
tion methods, skip step 1.

2. On rover side, double-tap the Sur-
veying icon.

3. Press MENU, tap Receiver Mode, 
then Real-Time.

4. Press MENU and tap Initialize RTK.
5. Select one of the available initiali-

zation methods, from the slowest 
to the fastest:
• On The Fly: Initialization will 

take place with a free moving rover antenna. If you 
choose this option, the message “Reset RTK Engine is 
OK!” will first appear. Just tap OK and then, using the 
NAV key, select the Position screen to monitor the ini-
tialization process (see screen example in the left col-
umn). When the screen indicates a “Fixed” status for 
the position, then the rover is initialized. Refer to 
Standard RTK: “Surveying” on page 51 to start your 
survey.

• Static: The rover antenna, placed over an unknown 
point of your choice, should not be moved until initial-
ization is achieved. If you choose this option, the Ini-
tialization screen will then be displayed (see screen 
example in the left column). Skip to step 6.



• Known Point: The rover antenna, placed over a known 
point, should not be moved until initialization is 
achieved. If you choose this option, the receiver will 
first ask you to indicate the name of the control point 
from which you initialize the rover. Select a point from 
the prompted list. The initialization screen is then dis-
played (see screen example in the left column). Skip 
to step 6.
Warning! This method will be successful only if the 
antenna height has already been entered. If that is not 
the case, the “Known Point” method can only be com-
pleted using the on-screen INIT button after entering 
the antenna height (see page 52 and page 54). 

• Bar: The rover antenna should temporarily be placed at 
the end of the base’s initializer bar until initialization 
is achieved. This means initialization is performed 
close to the base. If you wish to use this option, first 
move the rover antenna to the free end of the kine-
matic bar and then choose this option. The Initializa-
tion screen is then displayed (see screen example in 
the left column). Go to step 6.

6. Keep an eye on the displayed parameters while the 
receiver initializes:
• Baseline: Baseline length. Should stay 0.0 km in the 

case of a bar initialization.
• Elapsed: Counts the time since you started initializa-

tion.
• # Sats: Should be 6 or more for fast initialization.
• PDOP: Should be less than 3.
• Age: Should stay around 2 seconds. If it starts increas-

ing steadily, this probably means RTCM corrections are 
no longer received. Check your radios.

• Solution: Position solution status. Should be a blinking 
“Float” throughout initialization.
When “Fixed” appears in the Solution field, this means 
the rover is initialized. A new button (OK) then appears 
next to the Cancel button.
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7. Tap OK to close the Initialization window.
8. For a bar initialization, move the rover antenna from the 

initializer bar to the top of the rover pole (see picture 
below right). While doing this, take care not to mask the 
rover antenna or else you would have to resume initializa-
tion. For all the other initialization methods, skip step 8.

9. Refer to Standard RTK: “Surveying” on page 51 to start 
your survey.



3.

2.
Rover-Only Configuration (Network)

Two types of connections are possible: NTRIP and Direct IP. 
Both rely on the use of a Bluetooth-enabled, GPRS-enabled 
cell phone within range of the ProMark3 RTK.
No user-owned base needs to be deployed in this configura-
tion.
The “Rover-Only” Configuration requires that you establish a 
Bluetooth link to your cell phone and then a GPRS connection 
from the ProMark3 RTK via the Bluetooth link and the cell 
phone. Although this connection phase is accurately de-
scribed in this section, you can also refer to Step-by-Step Pro-
cedure for Establishing a GPRS Connection Via Bluetooth on 
page 198. For more information about Bluetooth, you can also 
refer to Bluetooth Manager Module on page 190.

Setting Up the Rover
Install the unit on its range pole:
1. Mount the GNSS antenna on the pole
2. Attach the field bracket onto the pole
3. Place the ProMark3 receiver into the field 

bracket
4. Connect the GNSS antenna to the unit 

using the cable provided.
5. Measure the antenna height.

1.

4.
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For step 5, you need to 
know how to activate 
Bluetooth on your cell 

phone and how to make it 
discoverable.

Please refer to its Instruc-
tions Manual.

Your cell phone may also 
ask you for a paired con-

nection with the ProMark3 

RTK. Please accept to be 
able to proceed. 
Configuring the Rover in NTRIP Mode
1. Turn on the ProMark3 RTK.
2. Double-tap the DGPS Configuration icon.
3. Tap the Select Mode button.
4. Select NTRIP and then tap OK. This gives access to the 

NTRIP settings window from which you can now do the 
following:
a) Establish a Bluetooth connection with your cell phone.
b) Establish an Internet connection via the cell phone.
c) Gain access to the NTRIP provider via the cell phone 

and download the provider’s NTRIP source table.

5. To establish a wireless connection between the cell phone 
and the ProMark3 RTK:

• Tap  on the NTRIP Settings window.
• Turn on your cell phone. Activate its Bluetooth device. Make 

its local Bluetooth device discoverable from external Blue-
tooth devices.

• On ProMark3 RTK, tap  to search for the Bluetooth 
devices present in the vicinity. At the end of the search 
sequence, an icon representing your cell phone should be vis-
ible in the Bluetooth Manager window.

• Double-tap the cell phone icon. The Bluetooth Manager win-
dow now shows the Bluetooth services offered by your cell 
phone.

• Double-tap the Dial-Up Networking icon. As a result, a con-
nection is automatically implemented using the first Blue-
tooth virtual port available on ProMark3 RTK. The message 
“Connection succeeded on communication port COMx:” is 
displayed.

• Tap OK to close the message window. Note the presence of a 
plug in a green circle on the Dial-Up Networking icon showing 
that the connection is effective.

• Tap  to close the Bluetooth Manager window. The NTRIP 
Settings window now shows the Bluetooth connection to your 
cell phone.



For step 6, you need to 
know the GPRS call num-
ber as well as your GPRS 

connection profile (user 
name, password, domain).

Please ask your phone 
operator and/or GPRS pro-

vider if you don’t know 

these parameters.
6. To establish a GPRS connection to the Internet via the cell 
phone:

• Tap  on the NTRIP Settings window.
• In the window that opens, double-tap the Make New Connec-

tion icon.
• Name the new connection (for example “My Cell Phone”) 

using the virtual keyboard, keep Dial-Up Connection checked 
on and then tap Next>. 

• In the Select a modem field, select the port used on 
ProMark3 RTK (i.e. the port assigned previously) to commu-
nicate with the Bluetooth modem of the cell phone (the 
selected modem should be in the form “BT Modem on 
<Cell_Phone_Name> COMx”)

• In the Modem window, tap Next>.
• In the Phone Number field, type the GPRS call number corre-

sponding to your cell phone model and GPRS operator.
• Tap Finish. A new icon appears in the Connection window.
• Double-tap the icon you have just created in the connection 

window.
• Enter the following parameters:

- User Name
- Password
- Domain

• Enable the Save password option.
• Tap on the Dial Properties button and then on the Edit but-

ton. This opens the Edit Dialing Patterns window.
• Correct the content of this window in order to read “G” in the 

three fields.
• Tap OK twice to return to the Dial-up Connection window.
• Tap on the Connect button. The following messages appear 

successively: “Opening Port”, “Dialing...”,... “User Authenti-
cated” and “Connected”. The GPRS connection is now estab-
lished.

• Tap Hide to close the message window.

• Tap  to close the Connection window. The NTRIP Settings 
window now shows the connection to the GPRS operator.
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For step 7, you need to 

know your NTRIP connec-
tion profile (host, port, 

login, password).

Please contact your 
NTRIP provider if you 

don’t know these parame-
ters.
7. To choose a station from which to receive RTCM correc-
tions:

• Tap  on the NTRIP Settings window. The NtripCaster Con-
nection window opens in which you can store several NTRIP 
configurations.

• To enter your first NTRIP configuration, with New selected in 
the NTRIP Configuration field, tap on the Add button and 
then enter the following parameters:

- Name: NTRIP Configuration Name (choose a name at your 
convenience)

- Host: Host IP address
- Port: Port number
- Login: User name
- Password: User password

• Tap OK. The name of the configuration you have just created 
is now pre-selected in the NTRIP Configuration field. Tap OK 
again. This takes you back to the NTRIP Settings window (see 
example opposite).

• Set the Network and Station fields to select the base to work 
with.

• Tap OK. This takes you back to the DGPS Configuration win-
dow. On top of the screen, you can read part of the settings 
you have just made.

• Tap the Connect button. The DGPS Configuration screen now 
indicates the amount of incoming data packets (bottom of the 
screen) as well as the status of the DGPS mode (top of the 
screen).

• Tap OK to close the DGPS Configuration window. The follow-
ing two messages are displayed successively: “Please wait...” 
and “Processing incoming data packets...”.

• Tap OK to close the message window.



For step 7, you need to 
know your Direct IP con-

nection profile (host IP 
address and port number).

Please contact your Direct 
IP provider if you don’t 
know these parameters.
Configuring the Rover in Direct IP mode
1. Turn on the ProMark3 RTK.
2. Double-tap the DGPS Configuration icon.
3. Tap the Select Mode button.
4. Select Direct IP and then tap OK. This gives access to the 

Direct IP settings window from which you can now do the 
following:
a) Establish a Bluetooth connection with your cell phone.
b) Establish an Internet connection via the cell phone.
c) Enter the IP address from which corrections can be 

obtained.
5. Establish a wireless connection between the cell phone 

and the ProMark3 RTK as explained in Step 5. on 
page 46.

6. Establish a GPRS connection to the Internet via the cell 
phone as explained in Step 6. on page 47.

7. To enter the IP address of the corrections provider:

• Tap  on the Direct IP Settings window. The Direct IP Con-
nection window opens in which you can store several Direct 
IP configurations.

• To enter your first Direct IP configuration, with New selected 
in the Direct IP Configuration field, tap on the Add button 
and then enter the following parameters:

- Name: Direct IP configuration name (choose a name at 
your convenience)

- Host: Host IP address
- Port: Port number

• Tap OK. The name of the configuration you have just created 
is now pre-selected in the Direct IP Configuration field. Tap 
OK again. This takes you back to the Direct IP Settings win-
dow (see example opposite).

• Tap OK. This takes you back to the DGPS Configuration win-
dow. On top of the screen, you can read part of the settings 
you have just made.

• Tap the Connect button. The DGPS Configuration screen now 
indicates the amount of incoming data packets (bottom of the 
screen) as well as the status of the DGPS mode (top of the 
screen).

• Tap OK to close the DGPS Configuration window. The follow-
ing two messages are displayed successively: “Please wait...” 
and “Processing incoming data packets...”.

• Tap OK to close the message window.
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Initializing the Rover
The initialization phase is similar to that described for a base/
rover configuration (see page 42). The only difference is that 
you cannot initialize the rover using a kinematic bar since the 
base is not your property.



4. Standard RTK: “Surveying”

It is assumed that RTK has been implemented according to 
the instructions provided in chapter RTK Setup on page 34.
Once the rover has been initialized (see page 42 or page 49, 
depending on whether you are in base/rover or rover-only con-
figuration), you can move on to the survey as such. Always 
take care to maintain maximum satellite visibility from the an-
tenna in order to preserve system initialization.
If the rover loses initialization, you will need to resume this 
step using whichever initialization method is preferable in 
your context of use (see page 35).

Logging Points in Real Time

1. Walk to the first point you want to log and stand still on 
that point.

2. Press the LOG key and then enter the following parame-
ters:
• Site ID: A 4-character string.
• Survey Mode: Select Logging Point.
• Site Description: An optional 20-character narrative 

description of the point. Tap inside the field, enter 
your text from the on-screen keypad and press ENTER.

• Antenna Height: Enter the height you measured in the 
setup phase (see page 41). ProMark3 RTK will save 
and indefinitely use this value until you change it 
manually.

• Units: Specify the unit that was used to measure the 
antenna height (meters, US feet or Int feet).

• Height Type: Specify the type of measurement you 
made (Slant or Vertical) to determine the antenna 
height.

• Time on site (sec): Time, in seconds, that must elapse, 
with the antenna not moving, before the rover stores 
the position of the point (default: 15 seconds). You 
decide the duration of the occupation (If it is greater 
than 1 second, the position solutions will be averaged 
over this period of time to improve accuracy. If it is 
1 second, there is no position averaging but work 
proceeds more quickly).
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If the point you save has a 

“Fixed” solution, then it is 
stored as a control point.

 

This means it can later be 
selected from the list of 

control points to initialize 

the system with the rover 
precisely located over this 

point. 
3. Tap the OK button. This opens a new screen on which you 
can see the following parameters:
• The name of the opened log file is shown in the title 

bar between brackets.
• Baseline: Baseline length in km (distance between 

base and rover).
• Solution: Solution status. Check that it is “Fixed” for 

centimeter accuracy.
• Receiver status:

SV: Number of received SVs. Should be 6 or more.
PDOP: Should be less than 3.
Age: Age of corrections (should not be greater than 
2 sec).
HRMS and VRMS: Should be in the order of 
0.03 meters (0.1 ft) when the position is fixed.

• Your position’s current coordinates, as determined by 
the system.

• INIT button: The use of this button is required now if 
you want to use the “Known Point” method to initial-
ize the system. See Initializing the Rover on page 42.

4. If you are satisfied with the quality of the displayed data, 
tap the on-screen LOG button. This opens a new screen on 
which you can now see the Remain field count down. When 
Remain=00:00:00, the STORE button appears at the bot-
tom of the screen (see screen below right).

5. Tap the STORE button. This saves the point position and 
takes you back to the Logging Point screen where you can 
see that the Site ID has automatically been incremented by 
one.



6. Move to the next point you want to log.
7. Resume steps 3 through 6 as many times as necessary.
8. When all points have been logged, tap DONE on the 

screen. This closes the open log file, which now contains 
the positions of all the logged points, and takes you back 
to the last displayed navigation screen.

Logging Trajectories in Real Time

1. Walk to the start point of the trajectory and stand still on 
that point.

2. Press the LOG key and then enter the following parame-
ters:
• Site ID: A 4-character string.
• Survey Mode: Select Kinematic.
• Site Description: An optional 20-character narrative 

description of the point. Tap inside the field, enter 
your text from the on-screen keypad and press ENTER.

• Antenna Height: Enter the height you measured in the 
setup phase (see page 41). ProMark3 RTK will save 
and indefinitely use this value until you change it 
manually.

• Units: Specify the unit that was used to measure the 
antenna height (meters, US feet or Int feet).

• Height Type: Specify the type of measurement you 
made (Slant or Vertical) to determine the antenna 
height.

• Interval Type: Time or Distance, according to whether you 
want the points of the trajectory to be created and 
logged at regular intervals of time or distance.

• Interval: Time elapsed, in seconds, or distance traveled, 
in meters, between any two point positions logged 
along the trajectory followed.
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3. Tap the OK button. This opens a new screen on which you 
can see the following parameters:
• The name of the opened log file is shown in the title 

bar between brackets.
• Baseline: Baseline length
• Solution: Solution status. Check that is “Fixed” (for 

centimeter accuracy). 
• Receiver status:

SV: Number of received SVs. Should be 6 or more.
PDOP: Should be less than 3.
Age: Age of corrections (should not be greater than 
2 sec).
HRMS and VRMS: Should be in the order of 
0.03 meters (0.1 ft) when the position is fixed.

• Your position’s current coordinates, as determined by 
the system.

• INIT button: The use of this button is required now if 
you want to use the “Known Point” method to initial-
ize the system. See Initializing the Rover on page 42.

4. Tap the START button to start logging the trajectory.
5. Walk along the trajectory and let the system operate on its 

own. You can see that the Site ID is automatically incre-
mented as you walk. Note that using the PAUSE button, 
you can pause the position logging if you need to do so.

6. When you have reached the end of the trajectory, tap the 
DONE button. This closes the open log file, which now 
contains the positions of all the logged points along the 
trajectory, and takes you back to the last displayed naviga-
tion screen.



Staking Out

It is assumed that the rover has already been RTK initialized.
1. Press the LOG key and then enter the following parame-

ters:
• Survey Mode: Select Stakeout.
• Antenna Height: Enter the height you measured in the 

setup phase (see page 41). ProMark3 RTK will save 
and indefinitely use this value until you change it 
manually.

• Units: Specify the unit that was used to measure the 
antenna height (meters, US feet or Int feet).

• Height Type: Specify the type of measurement you 
made (Slant or Vertical) to determine the antenna 
height.

• Time on site (sec): Time, in seconds, that must elapse, 
with the antenna not moving, before the rover stores 
the position of the point (default: 15 seconds). You 
decide the duration of the occupation (If it is greater 
than 1 second, the position solutions will be averaged 
over this period of time to improve accuracy. If it is 
1 second, there is no position averaging but work pro-
ceeds more quickly).

• Enter coordinates manually check button: Do not check 
this button if the points you want to stake out are con-
trol points already stored in memory. Check it on if you 
want to enter the coordinates for a point to stake out.

2. Tap the OK button. Depending on how you set the Enter 
coordinates manually check button, the receiver now dis-
plays the list of control points, so you can select one 
(below left), or asks you to enter the coordinates of the 
point to stake out (below right). In the latter case, make 
sure the coordinate system used is the right one (MENU 
key> Setup> Coord Sys).
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3. After you have selected a point from the list or entered 
coordinates manually, the ProMark3 RTK switches to the 
compass screen. The arrow indicates the direction in 
which you are currently walking and the  symbol indi-
cates the direction to the stakeout point.

4. Change direction, and walk slowly, in order to align the 
arrow with the stakeout point. When you walk in the right 
direction, you’ll see that the arrow is vertical and the 
stakeout point at the top of the compass. When the dis-
tance to the point is only about one meter, the screen 
automatically displays the following:

NOTE: You can return to the compass screen by pressing the NAV key. Con-
versely, when the default screen is the compass screen, you can display the 
above screen by pressing NAV.

5. Check the distances displayed at the top of the screen. 
Move the pole slowly to zero these values (see diagram 
above left). Carefully plumb the pole for precise staking. 
The displayed distances should be interpreted as follows:
• East 0.233 M means you must move east to zero this 

value.
• North 0.367 M means you must move north to zero 

this value.
6. When these values are all zero, stop moving. You are on 

the point.
7. Set the stake.
8. You may want to take another reading to save the as-

staked position. Obviously, this position should be the 
same as that of the stakeout point but later you can com-
pare your field work with the target coordinates.

East
Distance

North 
Distance

Target Point

0, 0



To save the as-staked position:
• Tap the OK button. This opens a new screen on which 

you can now see the Remain field count down. In the 
window’s title bar is the name of the log file where the 
position is about to be saved. Note that a non-editable 
Site ID, different from the name of the target point, is 
automatically assigned to that position. GNSS Solu-
tions will automatically make the correspondence 
between the target point and the saved position.
When Remain=00:00:00, the STORE button appears at 
the bottom of the screen (see screen below right).

• Tap the STORE button. This saves the point position 
and takes you back to the stakeout screen. 

9. Tap Next to display the list of control points from which 
you can select a new target point.

10.Resume steps 4 through 7 until all the points have been 
staked out, then tap Done to end the stake out survey. This 
takes you back to the last displayed navigation screen.
If you have also logged the positions where you placed 
your stakes, tapping Done also closes the log file contain-
ing the measured positions of all these points.

Quitting The Surveying Function

Press the MENU key and tap Exit. This takes you back to the 
ProMark3 RTK workspace.
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5. Advanced RTK: FAST Survey Option

Introduction

The two requirements for running FAST Survey are: 1) You are 
using a ProMark3 RTK and 2) FAST Survey has been un-
locked.
This section focuses on three basic functions: Store Points, 
Stakeout Points and Localization. Note also that the functions 
supported by FAST Survey to control conventional systems are 
not discussed in this section. For more information on these 
functions, please refer to the FAST Survey Reference Manual 
provided on CD-ROM.

Launching FAST Survey
From the ProMark3 RTK workspace, double-tap the FAST Sur-
vey icon to launch FAST Survey. The software takes full control 
of the platform and re-assigns new functions to the function 
keys. See re-allocation table below.

Key New Function

IN Zooms in on all screens where is displayed

OUT Zooms out on all screens where is displayed

MENU Switches between and

NAV Displays the Monitor Skyplot screen

LOG Equivalent to tapping on the different survey screens.



MENU Screen
This screen shows five different tabs giving access to the main 
functions of FAST Survey. Although all function titles on each 
tab are self-explanatory, a more detailed definition of these 
functions is provided below.
The right arrow located in the upper-right corner of the MENU 
screen allows you to access the MAP screen (see page 63).

File tab
Job: Allows you to select an existing coordinate file for your job 
or to create a new coordinate file. A job consists of real-time 
data only. Several types of files are associated with a job (.crd, 
.rw5,.inf, etc.).
Job Settings: Allows you to set configuration options for data 
collection.
List Points:  Lists all of the points in the current coordinate 
file (.crd).
Configure Reading: Allows you to select settings and prefer-
ences that apply to observations taken in the field. (4 tabs in-
stead of 2 if TS option installed???)
Feature Code List: Used to define feature code lists.
Data Transfer: Prepares FAST Survey for transferring data to 
and from a PC.
Import/Export ASCII: Allows you to import an ASCII file to job 
data or export job data to an ACSII file.
Delete File: Allows you to remove any existing file from any di-
rectory to free up memory on the ProMark3 RTK.
Add Job Notes: Allows you to enter job notes as ASCII text.
Exit: Will exit the FAST Survey program.
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Rover Equip Tab

Base Equip Tab
Equip tab
Instrument: Allows you to set the equipment type that you will 
be using (ProMark3 Base or ProMark3 Rover).
If Instrument=ProMark3 Rover, the three buttons that follow 
are the following:

Rover Settings:  Used to set the rover receiver to the correct 
parameters and to instruct the receiver that it is a rover.
DGPS Configuration: Runs the DGPS Configuration utility 
through which UHF, Beacon, NTRIP or Direct IP configu-
rations can be implemented.
RTK Initialization: Gives access to the list of initialization 
methods through which the rover can be initialized.

If Instrument=ProMark3 Base, the button that follows is:
Configure Base: Sets up the base antenna, records the 
correct antenna height and the antenna type, and sets the 
raw data recording function.

The rest of the buttons on this tab is independent of the se-
lected instrument:
Localization: Allows you to align on a local coordinate system.
Monitor/Skyplot: Allows you to view GPS constellation, posi-
tion result and data quality.
Tolerances: Allows you to set operating tolerances.
Comm Setup: Not used (all parameters dimmed).
Peripherals: Allows you to acivate and set peripherals (laser, 
depth sounder, light bar).
About FAST Survey: Allows you to view information about 
FAST Survey and change your registration.



Surv tab
Store Points: Principal data collection routine (gives access to 
the Point Logging function)
Stakeout Points: Allows you to stakeout to a selected point by 
guiding you to the point with a series of commands and direc-
tions (Point Stakeout function)
Stakeout Line/Arc: Opens a secondary dialog where you can 
choose between Stake Line, Stake Centerline, Stake Arc (3 
points) and Stake Arc (PC, R, PT)
Offset Stakeout: Will stake out up to 2 user defined horizontal 
offsets to a centerline at any station as well as an unlimited 
number of offsets per station if you are using a predefined 
Cutsheet Station and Offset List
Elevation Difference: Will report a cut/fill in comparison with 
your current location to a design surface at any location within 
a project
Auto by Interval: Allows you to acquire and store data at a set 
interval value of either distance or time (Point Logging per-
formed at regular intervals of time or distance)
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COGO tab
Keyboard Input: Allows you to manually enter or edit coordi-
nates in the current job file or the current control file.
Inverse: Reports the bearing and horizontal distance between 
any two user specified points that are contained within the 
current job.
Areas: Calculates the area of a closed figure that is defined in-
ternally by user-entered point numbers contained within the 
current job or by a polyline picked from the screen.
Intersections: Allows for the calculation and storing of points 
based upon standard surveying practices of Bearing-Bearing, 
Bearing-Distance, or Distance-Distance Intersection calcula-
tions.
Point Projection: Allows you to calculate the station and offset 
of any entered or surveyed point relative to a known centerline 
or baseline.
Station Store: A pure calculation routine that will create point 
numbers based on a station and offset from an alignment
Translate, Rotate, Scale: Allows you to translate, rotate, and/
or scale points in the current job.
Calculator: Eliminates the need to carry a separate calculator 
in the field. The calculator can be used to do scientific com-
putations, standard calculations, conversions, triangle calcu-
lations including angles, and curve calculations.
Process Raw File: Creates a raw file (.RW5) that contains var-
ious lines of survey data similar to a surveyor’s field book
Point in Direction: Allows for manual entry of angles and dis-
tances and calculates sideshots or traverses from a known oc-
cupied point.

Road tab
Contrary to the Z-Max.Net version of FAST Survey, the 
ProMark3 RTK version of this software does not come with the 
Road function as a software option. However, the software in-
cludes a few functions related to roading such as creating and 
and editing profiles and centerlines. These functions are all 
located on the Road tab. 



: This icon, located at the top of the MENU screen, indi-
cates the type of survey equipment selected (GPS or Conven-
tional). Clicking on this icon allows you to access the 
Instrument window (see opposite) in which you may either 
save the current FAST Survey configuration or recall a previ-
ous one. Clicking on the Current tab allows you indentify the 
survey equipement (Type, firmware version, etc.).

MAP Screen

This screen provides a graphic representation of your job. It 
also shows the points you have to stake, the points that have 
already been logged and receiver status data. The right arrow 
located in the upper-right corner of the screen allows you to 
return to the MENU screen.

Battery life indicator Back to MENU screen

Viewing
parameters

Graphic Display area

Zoom settings
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Getting Started With FAST Survey

Creating a New Job
FAST Survey first asks you to open a job (a crd file). Do the 
following:
1. Choose Select New/Existing Job. A new screen is now dis-

played.
2. In the Name field, type in the name of the job you wish to 

create. For example, type in “tuto1.crd”.
3. Then tap OK to create the job. The screen then displays 

the Units tab.
4. On the Units tab, set the desired units and parameters for 

the job.
5. Tap on the GPS tab.

On the GPS tab, choose the coordinate system to be used 
in the job as well as the geoid model. A large number of 
coordinate systems are stored in FAST Survey. To select 
one of them, click on the Edit Projection List button and 
then Add Predefined. Some coordinate systems require that 
a datum grid (or projection grid) be uploaded before you 
are allowed to use them. Some geoids are provided on the 
FAST Survey CD and can be installed through the Install 
FAST Survey  utility (see Install FAST Survey (and Datum 
Grids) on page 253 and Getting ProMark3 Ready for FAST 
Survey Installation on page 267). Geoids can also be 
uploaded using GNSS Solutions (see Uploading a Geoid to 
ProMark3 on page 184).

6. After selecting all the desired parameters, click OK 
(located on top of the screen).



Configuring a Base
It is assumed that the ProMark3 RTK base has been set up as 
explained in RTK Setup on page 34. If you want to use the Bar 
method to initialize the rover, don’t forget the kinematic bar 
between the antenna and the tribrach.
Before running FAST Survey, run the DGPS Configuration util-
ity, tap Select Mode, choose UHF and tap OK twice to close 
DGPS Configuration. This is to make sure the serial line be-
tween the radio and the ProMark3 RTK is properly configured.

1. If FAST Survey is running, select File>Exit to quit the pro-
gram.

2. Run the DGPS Configuration utility.
3. Tap Select Mode, choose UHF and tap OK.
4. Tap OK again to close DGPS Configuration. This was to 

make sure the serial line between the radio and the 
ProMark3 RTK is properly configured.

5. Run FAST Survey
6. Tap on the Equip tab.
7. Tap the on the Instrument button.
8. Select ProMark3 Magellan Base and tap OK.
9. Tap on the Configure Base button, define the antenna 

height and type as well as the elevation mask.
If you intend to log base raw data, check on the Data 
Recording option, set the recording interval in seconds, 
define the media where to store the data (SD Card or 
Internal memory) and enter a Unit ID. Reminder: This 
parameter is used as header in raw data filenames.

10.Tap OK to enter all these settings. FAST Survey then asks 
you to enter the position of the base and then the refer-
ence station ID.

11.When base configuration is complete, FAST Survey asks 
you to save the base settings in a ref file (<job_name.ref). 
The ProMark3 RTK will then run as a base until you exit 
FAST Survey.
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Configuring a Rover
It is assumed that the ProMark3 RTK rover has been set up as 
explained in RTK Setup on page 34.

1. Tap on the Equip tab.
2. Tap the on the Instrument button.
3. Select ProMark3 Magellan Rover and tap OK.
4. Tap on the Rover Settings button, define the antenna 

height and type as well as the elevation mask. Indicate the 
type of position solution that is expected from the rover 
(“Float” or “Fixed” status).
If you intend to log rover raw data, check on the Data 
Recording option, set the recording interval in seconds, 
define the media where to store the data (SD Card or 
Internal memory) and enter a Unit ID. Reminder: This 
parameter is used as the header in raw data filenames.

5. Tap OK to enter all these settings and complete the rover 
configuration.

Initializing the Rover
1. Tap on the RTK Initialization button (Equip tab)
2. Select the type of initialization you wish to use (see oppo-

site) and then follow the instructions on the screen.
Compared with Surveying, FAST Survey proposes a fourth 
initialization method called “Static On-The-Fly initializa-
tion”. With this method, the antenna should stay still over 
an unknown point until initialization is achieved. This 
method gives faster initialization than On-The-Fly initial-
ization in the same operating conditions.
NOTE: Except for “On The Fly Initialization”, the message 
“Please do not move the antenna until the position is Fixed!” 
will appear when you choose an initialization method. Tap 
OK to close this message window.

3. After you have selected an initialization method, FAST 
Survey will switch to the Monitor/Skyplot screen. This 
screen shows the progress of the initialization phase 
(HRMS, VRMS, Status, Latency, etc.).

4. A beep can be heard when the position solution is fixed. 
You can then tap BACK at the top of the screen and move 
on to your survey, taking care not to lose system initializa-
tion.
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Localization

This operating mode is used in the following cases:
- The coordinate system is unknown or its characteristics 

are not accurate enough.
- The base station is operated on a reference point whose 

position was only determined in autonomous GPS mode.
- A local coordinate system is used for field operations.

 
In either of these three cases, you will have to localize your 
system before starting your job, using control points. The use 
of 3 control points or more is highly recommended to achieve 
horizontal localization. This number should be raised up to 4, 
or more, to ensure vertical localization, as this will guarantee 
the consistency of your control points.
Click on the Equip tab and select Localization. The screen that 
appears is described below.

Control coordinates can be entered manually or read from a 
file stored in the handheld computer. When you click Add to 
add a point, a new screen is displayed.
You may either enter the points coordinates manually  (see 
screen example opposite) or select an existing point from the 
pre-defined list.

Edits the selected pointletes the selected point

ds a new point to the list

Saves the current points list 
as a *.dat file

Enables/disables the se-
lected point for/from the lo-
calization process

Points list

Loads a points list from 
the specified *.dat file

Provides access to Solution 
Monitoring screen

 the geographic or plane 
tes of the selected point
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Click on the  button to access the list of points available 
from the open job.
Click OK after selecting a point from the list. A new screen 
then appears asking you to enter the true coordinates of the 
point. There are three different methods for entering these co-
ordinates (see screen opposite):
1. They can be read from the rover receiver. In this case, the 

rover should be positioned over the concerned control 
point.

2. They can be entered manually (WGS84 coordinates).
3. They can be loaded from the results of a point that was 

logged earlier during the same job.

If you choose to use the coordinates computed by the 
ProMark3 RTK, then FAST Survey will ask you to indicate the 
number of measurement samples required before the receiver 
outputs the coordinates measured for the point (see screen 
opposite).
Click OK to enable the result of that computation. FAST Sur-
vey then takes you back to the screen showing the points list.
Resume the previous steps until the coordinates of all the con-
trol points involved in the localization process have been de-
termined.
On the points list screen (see screen example opposite), check 
the amount of residual for each control point involved in the 
localization. The lower these values, the better the consisten-
cy of your control point network.
Should some residuals be abnormally high, the relevant 
point(s) should be deleted using the Delete button, or removed 
from the localization process using the On/Off button.
Warning! At least 3 points are required to compute residuals 
in a horizontal system, and at least 4 points in a horizontal + 
vertical system.
The On/Off button gives access to a menu allowing you to en-
able/disable the selected control point for the horizontal con-
trol process, for the vertical control process, or for both (see 
screen opposite).
The localization parameters can be saved as a *.DAT file for 
further use. Click on the Save button to do this.
To quit the localization function, click on the OK button.
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Logging RTK Points

1. Tap on the Surv tab and then on Store Points. The screen 
now displayed allows you to log all your points.
The figure below summarizes all the functions available 
from that screen.

For example, you are on a point that you want to log. Do 
the following:

2. Type in the point name and description in the correspond-
ing two fields (see above)

3. Tap on the “A” button
4. Enter the number of readings you want before FAST Sur-

vey is allowed to compute an average position for this 
point. For example, type in “5” and tap OK.
Messages follow successively indicating that the system is 
taking the 5 requested readings. Then FAST Survey dis-
plays the average coordinates it has determined.

5. Tap OK if you agree. The “Point Stored” message appears 
briefly. The screen then shows the location of the point 
together with its name and description.
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6. After logging all your points, tap MENU in the upper-right 
corner of the screen to return to the menu.

Logging RTK Points in Continuous Mode

1. On the Surv tab, select the Auto by Interval function. Two 
different modes are possible: Time or Distance.

2. If you choose Distance, enter the horizontal and vertical 
increment value respectively in the X/Y and Z fields, 
according to the chosen unit. If you choose Time, enter the 
increment value, in seconds.

3. Enter a point Id. for the start point in the Starting Pt ID 
field. This field will be incremented by one after each 
point logging. You do not need to define a name finishing 
with a figure. FAST Survey will place one anyway when 
incrementing this field.

4. Press OK to switch to the graphic screen (see figure below) 
and start logging the first point.

The S button lets you instantly log the position of a point.
The X button allows you to pause data logging in continu-
ous mode.
If data logging in continuous mode is paused, you can still 
continue to log points in manual mode using the S button.

Used to pause/resume 
data logging

Point Id.
incremented

automatically

Used to log a point’s 
position manually
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Tap the X button again (changed into a right arrow during 
pause) to resume data logging in continuous mode.
If you come back to the main menu by tapping on MENU, 
then data logging in continuous mode is automatically 
stopped.

Staking out RTK Points

1. Tap on the Surv tab and then select Stakeout Points. The 
screen now displayed allows you to stake out your points.

2. On this screen, FAST Survey asks you to choose the point 
you want to stake out. You can either type in its coordi-
nates in the Northing, Easting and Elevation fields, or select 
a pre-defined point from the points list (see File>List 
Points). You can also, define graphically this point by tap-
ping on the point on the graphic screen, or define that 
point according to azimuth, slope and horizontal distance.

oint 
 out

t to 
 out Provides access to 

graphic screen

Provides access to points list. 
Example of points list:
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3. Once you have chosen a point, tapping on the OK button 
will display a graphic screen from which you can easily 
stake out your point:

The target radius is automatically changed as the distance 
from you to the point changes.
When getting closer to the point, markers appear at the 
four corners of the target (see below left) informing you 
that you nearly are on the point. You can now set the stake 
and log the position of this point.

4. Tapping on the STORE button allows you to start perform-
ing measurements to determine the position of the point.
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The number of measurements will depend on the value 
entered earlier through the File tab>Configure Readings 
function. Once the position has been determined, FAST 
Survey displays the results of the computation so that you 
can check them (see below right).

5. Tap OK if you are satisfied with the results. FAST Survey 
will then save these results and will take you back to the 
stakeout screen for the next point.

Downloading Land Survey Projects

See Downloading RTK Data Collected With FAST Survey on 
page 169.
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6. Post-Processing Surveying

This chapter presents step-by-step procedures for performing 
a GPS survey with the ProMark3 system. Review this chapter 
thoroughly before attempting to perform your first survey. As 
an exercise, take your system outside of your office and per-
form a sample survey following the procedures outlined below. 
Then download and process the collected data with GNSS So-
lutions. After this exercise, you will be ready to perform your 
first real survey with the ProMark3 system.

Introduction to Static Surveying

Prior to venturing out into the field, you must first plan how 
you will execute your static survey. Proper planning will greatly 
increase the chances of success. There are two primary areas 
of static survey planning, the network design and observation 
plan. Each is discussed below.

Network Design
You have identified a survey for which you wish to use the 
ProMark3 system to establish control. Regardless if the num-
ber of control points to be established is 2 or 20, you must 
design a network defining the number and location of obser-
vations (vectors in our case) that will be required to effectively 
position the new points. 



Three-Point Control Survey 
Example

Closed-Loop Traverse 
Design
As an illustration, consider an example where two new inter-
visible points are to be established on a project site for use as 
control for a boundary survey. The two new points need to be 
tied to an existing control point 3 kilometers (1.9 miles) away.

If you were to perform this survey with a conventional total sta-
tion, you would probably plan on running a closed-loop 
traverse from the existing control point through the two new 
points (see figure below). The same philosophy can be used 
for GPS surveys. The figure below is your network design for 
this survey
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15-Point Control Survey 
Example

Network Design for 15-
Point Control Survey
The previous example resulted in a very simple network de-
sign. The figure below represents a more complex control sur-
vey where 10 new points are to be established based on 2 
existing horizontal and 3 existing vertical control points.

Again, if you were to perform this survey with a conventional 
total station, you would design a traverse plan which produced 
a strong looking network of closed-loop traverses through the 
points of the survey. The figure below shows one possible net-
work design.

Although this network design was produced with conventional 
traversing in mind, this same design can also be used if per-
forming the survey with GPS equipment.



Closed-Loop Traverse of 3-
Point Control Survey
When designing your network, keep the following principles in 
mind:
• Design loops through the network points which resemble a 

square or circle. Avoid loops that are long and skinny. Cir-
cular or square shaped loops are stronger geometrically.

• Keep the number of points in each loop fewer than 10.
• Always include a direct link between intervisible points, 

i.e. points which may be used as a pair for orientation of a 
conventional traverse. Since, in most instances, intervisi-
ble points are relatively close to each other, it is important 
to get a direct observation between them.

Observation Plan
With the network design completed, the next step is to deter-
mine how and when data collection will be performed to pro-
duce the desired network. First let’s discuss the how.
If you were to use a conventional total station to perform our 
three-point survey example, your resulting traverse could 
probably look something like this:

The number of traverse legs required to traverse between each 
point in the network will depend upon the conditions on the 
ground between the points.
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Network Design for 3-Point 
Control Survey
If you are in luck, the area is relatively flat and there is a 
straight road running from the existing control point to the two 
new points to be established, thus minimizing the number of 
legs required to complete the loop. 
Surveying with GPS has the advantage of not requiring line-of-
sight between the points surveyed. This allows for direct ob-
servations between the points. To illustrate this, let’s take our 
3-point control survey network design, shown again below.

Assume that a 2-receiver ProMark3 system will be used to per-
form the above survey. To produce the link between the exist-
ing control point 1 and the new point 2, simply place one 
ProMark3 receiver system on point 1, place the other receiver 
on point 2 and simultaneously collect data between the two 
points. When the observation is complete, move the ProMark3 
receiver from point 2 to point 3. Perform another observation, 
simultaneously collecting data on points 1 and 3. When com-
pleted, move the ProMark3 receiver from point 1 to point 2. 
Perform the final observation between points 3 and 2. When 
this data is downloaded and processed, the result will be three 
vectors (delta positions) forming the network design seen in 
the above figure.

1

2

3



Network Design for 15-
Point Control Survey
Now consider the situation where a 3-receiver ProMark3 sys-
tem is used. By placing one receiver on each of the 3 points 
in our network, the data for all three vectors can be collected 
in one observation, rather than the 3 separate observations re-
quired with using a 2-receiver system.
Now consider the observation plan for the more complex 15-
point survey, shown again below.

To execute this network design, you must perform a direct 
GPS observation between all points directly linked. Each link 
can be viewed as a required GPS vector. Counting the links in 
this network design, you will find that 19 GPS vectors are re-
quired to execute this design.
If the survey was to be performed using a 2-receiver ProMark3 
system, 19 separate data collection sessions (observations) 
would be required. For example, you can start with a receiver 
on point 1 and another on point 2. After this observation, you 
would move the receiver from point 1 to point 3 to perform an 
observation between points 2 and 3, and so on until all vectors 
were observed.

1

2
3
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Receiver Observation Plan 
for 15-Point Control Survey
Now consider the situation where the 15-point control survey 
above is to be performed using a 3-receiver ProMark3 system. 
With 3 receivers, each observation session will produce 2 vec-
tors from the network design. For example, you may start by 
placing one receiver on point 1, the second on point 2, and 
the third on point 7. These three receivers would simulta-
neously collect data on these three points, resulting in the 
vectors between points 1 and 2, and points 1 and 7. In addi-
tion to these two vectors, a third vector is produced between 
points 2 and 7. At the end of this first observation, you could 
move the receiver from point 2 to point 9 and the receiver 
from point 1 to point 8.
The receiver at point 7 would remain as the pivot point, con-
necting the first observation to the second. This would contin-
ue until all vectors were observed.
The figure below shows what the observation plan might look 
like with a 3-receiver ProMark3 system.

The observation plan shows that it will take 10 separate ob-
servation sessions to complete the survey based on the net-
work design shown on page 79.
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Notice that all observation sessions, except for session 6, pro-
duce 2 vectors required from the network design. Observation 
6 produces only one since there were an odd number of re-
quired vectors (19).
This completes the discussion on how to execute the observa-
tion plan.
The next question to answer is “When do we perform the ob-
servations?”
The best time to perform GPS surveys is determined by an ex-
amination of the GPS satellite constellation at your location 
for a given time of day. The number of visible GPS satellites 
and the distribution of the satellites in the sky are important 
factors impacting the observation time required to produce 
quality GPS vectors.
Times when the number of visible GPS satellites is low or the 
satellite distribution is poor will require extended data collec-
tion periods to ensure quality results. In rare instances, avail-
ability and distribution may be so poor that you are better off 
not performing your survey during these periods.
Included in the GNSS Solutions processing software package 
is a module called Mission Planning. The Mission Planning 
software provides you with the tools to examine the GPS sat-
ellite constellation. Using satellite almanac information, 
which predicts the location of the GPS satellites into the fu-
ture, you can examine satellite availability and distribution for 
the day(s) when you wish to perform your survey to isolate any 
time periods were observation times may need to be extended 
or periods where it is best not to collect data.
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You provide the software with your current location and the 
date when you wish to perform your survey. The software then 
provides you with multiple ways of examining the satellite 
constellation at your location for the given time. Pay particular 
attention to satellite availability (number of satellites in view) 
and the satellite distribution.
To assist in analyzing the quality of satellite distribution, Di-
lution of Precision (DOP) values are presented. DOP is a qual-
ity analysis value for satellite distribution. The most popular 
DOP value is PDOP, which stands for Positional Dilution of 
Precision. The PDOP value estimates the impact on the preci-
sion of your GPS observations due to satellite geometry. The 
smaller the PDOP value the better the satellite distribution 
(geometry) and therefore the better the precision of your ob-
servations.
With the current constellation of 26+ GPS satellites, it is un-
common to find periods in the day when satellite availability 
and distribution are so poor that data collection should be 
avoided. Time of poor availability and distribution are usually 
short in duration.
When using the static mode of GPS data collection, where ob-
servation times are usually 20+ minutes, short periods of poor 
availability and distribution can be tolerated.
When performing an observation during which a period of poor 
availability and distribution appears, observation times will 
normally need to be extended to compensate for this event.



The ProMark3 receiver includes a feature which estimates the 
observation time required to produce a quality solution. This 
feature is called the “Observation Range” and is discussed in 
more detail later on in this chapter. The Observation Range (or 
Observation Timer) takes into account satellite availability and 
distribution when determining the required observation time. 
If you are collecting data during a period of poor availability 
and distribution, you will find the Observation Timer will take 
longer to inform you when your survey is completed. It is au-
tomatically extending the observation period to compensate 
for the poor availability and distribution of satellites.
Analysis of the satellite constellation with Mission Planning 
prior to data collection will give you an idea of the time periods 
when extended observations will be required
NOTE: The ProMark3 receiver is designed to store GPS data 
for only those satellites that are at least 10° above the horizon. 
The receiver may lock onto a satellite between 0° and 10° but 
will not record this data. When using the Mission Planning 
software to analyze the satellite constellation, be sure to set 
the satellite cut-off angle to 10°. This will ensure that the sat-
ellite availability and distribution presented by Mission Plan-
ning matches what is being used by the ProMark3 receiver for 
data storage.
NOTE: The ProMark3 will track up to 12 satellites simulta-
neously. If more than 12 are available, ProMark3 will track the 
12 satellites with the highest elevation.
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Running a Static Survey

The procedures for performing a static survey with the 
ProMark3 system can be broken down into five primary cate-
gories: equipment check, site selection, system setup, static 
survey setup and data collection. Following the steps present-
ed below should result in successful execution of your GPS 
survey.
Note: Remember that data must be simultaneously collected 
between 2 or more ProMark3 receiver systems in order to pro-
duce vectors between the receivers. Therefore, the following 
procedures must be followed for each ProMark3 receiver sys-
tem used in the survey. There is no problem in setting up one 
ProMark3 receiver system and then moving to another site to 
set up another. Just be aware that the observation time is de-
termined by the last receiver set up. For example, if you were 
alone and wanted to perform a survey with a 2-receiver 
ProMark3 system, you could set up the first receiver and start 
data collection. You could then move to the next site and set 
up the second receiver. Only when the second receiver is col-
lecting data does simultaneous data collection begin. All the 
data collected by the first receiver up to this time is of no use 
and will be ignored during data processing.



Equipment Check
Prior to leaving the office to perform your survey, be sure to 
perform a thorough check of your GPS equipment:
1. Check through the ProMark3 system to ensure all compo-

nents are present to successfully perform the survey.
2. Check to ensure that you have sufficient battery power to 

complete the survey. Bring along a spare set of batteries 
for insurance.

3. Bring along a copy of your network design and printout of 
the satellite availability and distribution analysis. These 
will be needed throughout the course of your survey.

With the equipment check completed, it’s time to move to the 
field to perform your survey.

Site Selection
Proper site selection of performing GPS data collection is crit-
ical to the success of your survey. Not all sites are appropriate 
for GPS data collection.
GPS depends on reception of radio signals transmitted by sat-
ellites approximately 21,000 km from Earth. Being of rela-
tively high frequency and low power, these signals are not very 
effective at penetrating through objects that may obstruct the 
line-of-sight between the satellites and the GPS receiver.
Virtually any object that lies in the path between the GPS re-
ceiver and the satellites will be detrimental to the operation of 
the system. Some objects, such as buildings, will completely 
block out the satellite signals. Therefore, GPS can not be used 
indoors.
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For the same reason, GPS cannot be used in tunnels or under 
water. Other objects such as trees will partially obstruct or re-
flect/refract the signal; reception of GPS signals is thus very 
difficult in a heavily forested area.
In some cases, enough signal can be observed to compute a 
rough position. But in virtually every case, the signal is not 
clean enough to produce centimeter-level positions. There-
fore, GPS is not effective in the forest.
This is not to say that your ProMark3 surveying system can 
only be used in areas with wide-open view of the sky. GPS can 
be used effectively and accurately in partially obstructed ar-
eas. The trick is to be able to observe, at any given time, 
enough satellites to accurately and reliably compute a posi-
tion.
At any given time and location, 7-10 GPS satellites may be 
visible and available for use. The GPS system does not require 
this many satellites to function. Accurate and reliable posi-
tions can be determined with 5 satellites properly distributed 
throughout the sky. Therefore, an obstructed location can be 
surveyed if at least 5 satellites can be observed. This makes 
GPS use possible along a tree line or against the face of a 
building but only if that location leaves enough of the sky open 
to allow the system to observe at least 5 satellites.
For the above reasons, make every effort to locate new points 
to be established in areas where obstructions are at a mini-
mum. Unfortunately, the site location is not always flexible.



You may need to determine the position of an existing point 
where, obviously, the location is not debatable. In situations 
were an existing point is in a heavily obstructed area, you may 
be forced to establish a new point offset from the existing 
point, or preferably a pair of intervisible points, and conven-
tionally traverse to the required point to establish its position.
Be aware that obstructions at a GPS data collection site will 
affect the observation time required to accurately determine 
its location. Obstructed areas will require longer observation 
times.
The Observation Range function of the ProMark3 will auto-
matically extend observation times at obstruction sites but in 
some cases, it may not extend the observation period long 
enough. You will have to use your own judgement of observa-
tion times when surveying obstructed site. Your judgement 
will improve through experience.
For large surveys utilizing 3 or more ProMark3 receiver sys-
tems, you may want to reckon all the site locations as part of 
your survey planning. This will eliminate any delays during the 
actual execution of the survey if problems are encountered 
finding an appropriate site.
The more receiver systems utilized during the survey, the 
harder the task of coordinating the data collection becomes.
Remember, data must be collected simultaneously between 
points where a vector is desired. If one receiver operator is late 
in starting data collection due to problems with site location, 
this could cause problems.
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4.

Typical setup with tripod is 
described here. You can 

also use a fixed-height 
tripod.
System Setup (Base and Rover)
Now that the survey site is identified, it is time to set up the 
ProMark3 receiver system over the point to be surveyed.  The 
setup procedure is illustrated below.

1. Set up the tripod / tribrach combination over the survey 
point.
This is done in precisely the same manner as for a conven-
tional total station. If using a fixed-height GPS tripod 
rather than a conventional tripod, a tribrach is not 
required.

1.

2.

3.

5.

6.

7.

H SlantH Vertical



2. Attach the vertical extension bar and a tribrach adapter to 
the GPS antenna.
With the GPS antenna in hand, attach the included verti-
cal extension bar to the 5/8-11 thread on the bottom of 
the antenna. Attach a tribrach adapter to the other end of 
the vertical extension bar. If using a fixed-height GPS tri-
pod rather than a conventional tripod, a tribrach adapter is 
not required

3. Place the GPS antenna assembly on the tripod.
Be careful not to disturb the tripod when mounting the 
antenna assembly.

4. Place the ProMark3 receiver into the field bracket.
With the field bracket in hand, insert the two flexible 
hooks located at the top of the bracket into the slots on 
either side of the loudspeaker grid at the back of the 
receiver and then tilt the receiver into place.

5. Attach the field bracket / ProMark3 combination onto the 
tripod.

6. Connect the GPS antenna cable to the unit
7. Measure and record instrument height (HI) of GPS 

antenna.
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Satellite Status screen
Static Survey Setup (Base and Rover)

1. Turn on the receiver by pressing the  red key. Wait for 
the ProMark3 workspace to appear on the screen.

2. Double-tap the Surveying icon to run the Surveying func-
tion. The screen displays the navigation screen that was 
last displayed.

3. Make the settings required when first using the Surveying 
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the 

options you need to set. Remember you need to define 
the Storage medium (internal memory or SD card) and 
the Receiver ID. If you have a ProMark3 RTK, press 
the MENU key again, tap Receiver Mode and then 
select Post-Processing. Skip step 3 when next using the 
Surveying function.

4. Press the NAV key until you see the Satellite Status screen 
(see opposite). Wait until at least 4 satellites are received.

5. When there is enough satellites received, press the LOG 
key. The Survey Settings screen opens.



You must assign a unique 
site ID to each point 

surveyed.
6. Enter the following parameters:
• Site ID: Tap inside the field and enter a 4-character 

string using the virtual (on-screen) or real keyboard. 
Then press the ENTER key, or tap  on the on-
screen keyboard, to validate the site ID.

• Survey Mode: For a static survey, tap the currently 
selected mode and then tap Static.

• Site Description: (Optional) Tap inside the field and 
enter a narrative description of the point (20 charac-
ters max.). Then press the ENTER key, or tap  on 
the on-screen keyboard, to validate the content of this 
field.
When several Site Descriptions have previously been 
defined, you can quickly retrieve these by tapping the 
left arrow to the right of the field. The list of existing 
descriptions then appears in which you can tap the 
desired one. This automatically sets the Site Description 
field on the Survey Settings screen. 

• Antenna Height: Tap inside this field and enter the verti-
cal distance between the antenna and the surveyed 
point. Be careful when entering the antenna height as 
this field uses a fixed format (xx.xxx). Then press the 
ENTER key, or tap  on the on-screen keyboard, to 
validate the content of this field.

• Units: Tap inside this field and then tap the unit used 
to express the antenna height (meters, US feet or Int 
feet)
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VerticalSlant
• Height Type: Tap inside this field and then tap the 
method used to measure the antenna height: Slant if 
you measured the antenna height to the outside edge 
of the GPS antenna, or Vertical if you measured the 
antenna height to the bottom of the GPS antenna 
mounting thread (see opposite).

• Recording Interval: Tap inside this field and then tap the 
recording interval (time in seconds between any two 
consecutive acquisitions of GPS data) you wish to use 
in your static survey. Make sure the same recording 
interval is used at the base and in the rover.

• Control Point check box: If you tap on this box to check 
it, you will be able, later on, to use the point associ-
ated with this Site ID as a control point.

Data Collection
7. Tap the Log button at the bottom of the screen.



With an antenna that has 
the best possible view of 
the sky, you should have 

#Sats continuously greater 
than 4 and PDOP 

continuously less than 4.

Obs. Range is equivalent to 
Obs. Timer in ProMark2.
The Static Survey screen opens providing information on 
the status of your survey during the data collection period.

Information provided here will help you determine when 
enough data has been collected.
• Obs. Range (Observation Range): Indicates the maxi-

mum length of the baseline that could be accurately 
determined through post-processing considering the 
amount of data currently collected. The more you col-
lect data, the larger the value displayed in this field.

• Elapsed: Displays the amount of time since data stor-
age began for the current observation session. The 
update rate of this field is tied to the recording interval 
you have chosen.
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• # Sats: Displays the current number of healthy satel-
lites – seen above the elevation mask – being logged 
into memory.

• PDOP: Displays the PDOP value at any given time, 
computed from all observed healthy satellites above 
the elevation mask.

• Site ID: Reminds you of the name you have given to the 
point you are surveying.

• File Name: Indicates the name of the file in which data 
is being collected. The file is automatically named by 
the receiver according to conventions provided in 
Appendices on page 262.

• Current Power and Memory statuses in graphical form.

8. When according to the Obs. Range parameter on the rover, 
enough data has been collected in this observation session 
(this implies that you must have a rough idea of the dis-
tance between the base and the rover), tap the Done but-
ton at the bottom of the screen or press the ENTER key.

9. Follow the steps presented above for each observation ses-
sion required to complete your survey. After data collec-
tion is complete, take all ProMark3 receivers used in the 
survey to the office and download the data to an office 
computer as described in Processing Field Data Collected 
With “Surveying” on page 164. The data is now ready for 
post-processing using GNSS Solutions.

NOTE: If the base used is not a ProMark3 base, Magellan 
recommends you double the occupation times.



Introduction to Kinematic Surveying

The kinematic data collection process requires at least two re-
ceivers collecting data simultaneously.
One receiver is called the base and must remain stationary 
throughout the data collection. Typically, the base receiver will 
occupy a survey point for which the precise position is already 
known.
Once operational, the base system simply collects and stores 
raw data from all satellites with line of sight to the GPS anten-
na (cf. Static survey).
The kinematic base is essentially the same as a static occupa-
tion.
The other simultaneously operating GPS receiver(s) during a 
kinematic survey is (are) designated as the rover(s). The rover 
unit(s) can move during the survey and are used to position 
new points relative to the base.
There are two types of kinematic survey supported by the 
ProMark3 system:
• Stop-and-go (designated as “stop-and-go” in the receiver 

menus)
• Continuous kinematic (designated as “kinematic” in the 

receiver menus).

Stop-and-Go
Stop-and-go surveying is best suited for collection of points. 
During Stop-and-go, the system is centered over a point and 
collects data for a period of time. The occupation time for 
stop-and-go will typically range from 15-60 seconds.
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It is highly recommended that a pole with bipod legs be used 
for Stop-and-go data collection to insure that the antenna is 
stable during this data collection period.
Once the point occupation is finished the system can be car-
ried to the next survey point and the procedure is repeated.

Kinematic
Continuous kinematic data collection is suited for collecting 
bulk points with minimal attributing (terrain modelling) or lin-
ear features such as a road centerline.
During continuous kinematic data collection the user never 
has to stop moving. A point is collected every time the receiver 
records a data record.
The recording interval for this application would typically be 
1-5 seconds, and the accuracy is typically 0.03 to 0.05 
meters.
The rover system is designed to be carried easily and is mount-
ed entirely to a range pole.
Kinematic data collection has the advantage of high produc-
tivity. However there are some trade-offs to be considered. Ac-
curacy is not as good as with GPS static data collection 
methods (see data sheet for specifications). In addition, field 
procedures require more planning and care.
Before beginning the kinematic survey, the rover unit must go 
though an initialization stage. Initialization lasts from 15 sec-
onds to 5 minutes depending on conditions. Procedures for 
initialization will be described in detail later in this manual.



During the kinematic data collection, the receiver must main-
tain lock on at least 5 satellites which are common at both the 
base and rover stations.
If the receiver detects that less than 5 satellites are tracked, 
it will send out an alarm indicating that the system must be 
re-initialized.
In cases of loss of lock due to obstructions, it is possible that 
the accuracy of processed results will be degraded if re-initial-
ization is not performed in the field. Therefore, re-initializa-
tion in the field after a loss of lock is critical to maintaining 
survey accuracy.
Finally, kinematic surveys are most successful when the kine-
matic base receiver is close to the kinematic rover. Accuracies 
of GPS-derived positions are distance-dependent. The greater 
the distance between the GPS receivers, the larger the uncer-
tainty.
In an ideal case, the kinematic base should be on the same 
project site as the kinematic rover. Kinematic surveys with a 
separation of more than 10 kilometers (6 miles) between the 
kinematic base and rover should be avoided. Such a separa-
tion makes kinematic initialization more difficult, increasing 
the chances of poor results.
When performing a kinematic survey, ProMark3 provides you 
with the tools to perform the following tasks:
• Manage data files in the GPS receiver
• Enter pertinent survey point attribute information required 

for data processing
• Monitor the progress of the kinematic survey.
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The initialization phase is 
required to ensure that 
your kinematic surveys, 

whether continuous or Stop 
& Go, will reach 

centimeter-level accuracies 
through post-processing.

With the “Known” method, 
you can make a survey at a 

fairly long distance from 
the base. 

Conversely, with the “Bar” 
method (the method we 

recommend), your survey 
will necessarily start from 

the base and obviously the 
points to be surveyed 

should not be too far away 
from the base.

With the “<None>” 
method, the  survey start 

point can be any point but 
you should have a rough 

idea of the distance from 
your working area to the 

base so you can estimate 
the overall time you should 
spend collecting data (15 

to 30 minutes typical).
Initialization Methods

Three possible methods, from fastest to slowest:
• Known: Initialization on Known point. 

• Bar: On Initializer Bar Installed at the Base

• <None>: On The Fly (OTF) Initialization 

1. You have to enter the Site ID of the known point
2. GPS antenna held stationary over known point for about 15 seconds
3. Countdown indicates when initialization is achieved.

1. You freely enter a Site ID for the rover’s start point
2. GPS antenna held stationary on the initializer bar for about 5 minutes.
3. Countdown indicates when initialization is achieved.
4. Move the antenna from the bar to the range pole taking care not to 

mask the antenna while doing this. Then start your job

1. You freely enter a Site ID for the rover’s start point
2. There is no countdown indicating when initialization is achieved.

Initialization achieved 
in 15 seconds
Init point can be several kilo-
meters away from the base.

Init point is a known 
point

RoverBase

Known Point
This vector is accurately known

Initialization
achieved
in 5 minutes
Init point is 20 cm 
off the base loca-
tion.

Base

Known Point

1 2Initializing... Move antenna to range pole 
once countdown complete.

Rover

No initialization point

Rover’s start point is 
an unknown point

RoverBase

Known Point

D



 Allowing for kinematic 
initialization using 

Initializer bar at the base
“Known” point means a point that is stored in the receiver’s 
memory as a control point.
With the “Known” initialization method, the total duration of 
the survey required for a successful survey increases with the 
distance from the rover to the base.

Running a “Stop & Go” Survey

Base Setup and Operation
The base is setup and operated in the same way as it is in 
static surveys (see page 88). The only difference is the possi-
ble use of the initializer bar at the base station.
The base antenna should be centered and levelled above the 
known point. To be able to use the initializer bar for initializa-
tion, be sure to incorporate the bar as part of the base setup 
as shown opposite. This bar gives an accurate baseline of 0.2 
m (0.656 ft) for initialization.
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1.

4.

5.

Temporary Setup for Bar Ini
Rover Setup
Install the unit on its range pole:
1. Attach the field bracket onto the pole.
2. Place the ProMark3 receiver into the field 

bracket.
3. Connect the GPS antenna cable to the unit.
4. Mount the GPS antenna on top of the pole or, 

in the case of a bar initialization, at the end of 
the base’s initializer bar.

5. Connect the other end of the antenna cable to 
the rover antenna.

Stop & Go Survey Rover Setup

1. Turn on the receiver by pressing the  red key. Wait for 
the ProMark3 workspace to appear on the screen.

2.

3. 4.

3.

5.

tialization: Setup for Known or <None> Initialization
(and Final Rover Setup after initialization step)



Satellite Status screen

Initialization method:

1) None
2. Double-tap the Surveying icon to run the Surveying func-
tion. The screen displays the navigation screen that was 
last displayed.

3. Make the settings required when first using the Surveying 
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the 

options you need to set. Remember you need to define 
the Storage medium (internal memory or SD card) and 
the Receiver ID. If you have a ProMark3 RTK, press 
the MENU key again, tap Receiver Mode and then 
select Post-Processing. Skip step 3 when next using the 
Surveying function.

4. Press the NAV key until you see the Satellite Status screen 
(see opposite). Wait until at least 4 satellites are received.

5. When there is enough satellites received, press the LOG 
key. The Survey Settings screen opens.

6. Tap inside the Survey Mode field and then tap Stop-and-go. 
The content of the screen will be different depending on 
the choice you make in the Initialize field (see below). This 
is explained in detail below.

2) With initializer bar 3) On known position
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VerticalSlant
Enter the following parameters:
• Site ID and Site Description: Set these two parameters 

after choosing the Initialization method (see below 
after the Initialize parameter).

• Antenna Height: Tap inside this field and enter the verti-
cal distance between the antenna and the surveyed 
point. Be careful when entering the antenna height as 
this field uses a fixed format (xx.xxx). Then press the 
ENTER key, or tap  on the on-screen keyboard, to 
validate the content of this field.

• Units: Tap inside this field and then tap the unit used 
to express the antenna height (meters, US feet or Int 
feet)

• Height Type: Tap inside this field and then tap the 
method used to measure the antenna height: Slant if 
you measured the antenna height to the outside edge 
of the GPS antenna, or Vertical if you measured the 
antenna height to the bottom of the GPS antenna 
mounting thread (see opposite).

• Recording Interval: Tap inside this field and then tap the 
recording interval (time in seconds between any two 
consecutive acquisitions of GPS data) you wish to use 
in your stop & go survey. Make sure the same recording 
interval is used at the base and in the rover.

• Initialize: Choose the method to initialize the stop & go 
survey (Known, bar or <None>; see page 98).



Carefully choose the Site 

ID!
Remember ProMark3 will 
automatically increment 

the Site ID as you progress 
in your Stop-and-go sur-

vey.  So make sure the 
Site ID you choose will not 

generate Site IDs that 
already exist. If that was 

the case, ProMark3 would 
overwrite these Site IDs 

without warning you. 
• Site ID: Set this parameter according to the initializa-
tion method you choose:
- If <None> or Bar is selected, you can freely enter a 

Site ID from the keyboard. Tap inside the field and 
enter a 4-character string using the virtual (on-
screen) or real keyboard. Then press the ENTER 
key, or tap  on the on-screen keyboard, to vali-
date the site ID.

- When you select Known, the receiver prompts you to 
choose a Site ID from the list of existing control 
points. Tap the desired Site ID.

• Site Description: (Optional) Tap inside the field and 
enter a narrative description of the point (20 charac-
ters max.). Then press the ENTER key, or tap  on 
the on-screen keyboard, to validate the content of this 
field.
When several Site Descriptions have previously been 
defined, you can quickly retrieve these by tapping the 
left arrow to the right of the field. The list of existing 
descriptions then appears in which you can tap the 
desired one. This automatically sets the Site Description 
field on the Survey Settings screen.

• Time on site (sec): If Bar or Known is selected as the Ini-
tialization method, enter the occupation time on site, 
in seconds, required for initialization. If <None> is 
selected as the Initialization method, enter the occu-
pation time required on the first point you want to sur-
vey.
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Initialization count-down. 
• Control Point check box: Displayed only if <None> is 
selected in the Initialize field. If you check this box, you 
will be able, later on, to use the start point -i.e. the 
point where initialization took place- as a control 
point.

Initialization Phase
7. Tap the Log button at the bottom of the screen. This starts 

data collection which will stop only at the end of the Stop 
& Go survey. So be sure from now on, and until the end of 
the survey, that you will not mask the antenna.
What happens after starting data collection depends on 
the chosen initialization method:
• With Bar or Known selected, the receiver first goes 

through an intermediate screen showing the counting-
down of the initialization phase (see screen opposite). 
The Remain field will count down beginning from the 
value of the Time on site field set in the Survey Settings 
screen. At the end of the countdown sequence, the 
Remain field reads “00:00:00”.
If you are performing initialization on known point, you 
are now ready to start the stop & Go survey. Continued 
in next chapter Data Collection.



If you are performing ini-
tialization on bar, you 
now have to move the 
rover antenna from the 
initializer bar to the top 
of the rover pole (see 
illustration opposite). 
While doing this, take 
care not to mask the rover 
antenna or else you would 
have to resume the ini-
tialization.

• With <None> selected, 
because there is no ini-
tialization phase, 
ProMark3 directly 
switches to data collec-
tion. Continued in next 
chapter Data Collection.

Data Collection
8. Walk to the 1st point you want to survey, making sure you 

will not mask the antenna.
9. If you have initialized on bar or known point, you may 

need to change some of the survey settings (typically you 
need to change the antenna height after moving the rover 
antenna from the initializer bar to the pole).
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In this case, press the LOG key, which here is different 
from tapping the on-screen Log button, and then review 
and correct if necessary the following parameters:

- Site ID: Enter a name for the 1st point to be sur-
veyed

- Site Description: (Optional) Tap inside the field and 
enter a narrative description of the point (20 char-
acters max.). Then press the ENTER key, or tap  
on the on-screen keyboard, to validate the content 
of this field.

When several Site Descriptions have previously been 
defined, you can quickly retrieve these by tapping the 
left arrow to the right of the field. The list of existing 
descriptions then appears in which you can tap the 
desired one. This automatically sets the Site Description 
field on the Survey Settings screen. 
- Antenna Height: After bar initialization, you need to 

enter the new height of the rover antenna as it is 
now located on top of the pole. After initialization 
on known point, you should not have to change this 
parameter.

- Initialize: Check that <None> is now selected.
- Time on Site: Enter the occupation time needed on 

each point that you will survey (typically 15 sec-
onds).

If you have selected <None> as the initialization method, 
skip step 9.



Make sure the rover 
antenna has the best 

possible view of the sky at 
all times during the 

survey. This should result 
in #Sats continuously 

greater than 4 and PDOP 
continuously less than 4.

The Obs. Range field is 
irrelevant to the Stop & Go 

mode and for this reason 
is left blank.

You may shorten the static 
occupation time (i.e. end 

the static occupation time 
before Remain =00:00:00) 

by tapping the Cancel
button. ProMark3 will then 

take you directly to the 
next screen on which the 
Site ID will have normally 

been incremented.
10.While holding the antenna pole stationary above this 
point, tap Log on the screen. The receiver then displays 
the screen below.

Information provided here will help you determine when 
enough data has been collected.
• Obs. Range (Observation Range): Field left blank as it 

is irrelevant to Stop & Go survey.
• Remain: Displays the remaining amount of time during 

which you should keep the antenna stationary over the 
surveyed point. At the end of the countdown, you can 
walk to the next point.

• # Sats: Displays the current number of healthy satel-
lites – seen above the elevation mask – being logged 
into memory.
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• PDOP: Displays the PDOP value at any given time, 
computed from all observed healthy satellites above 
the elevation mask.

• Site ID: Reminds you of the name given to the point you 
are surveying.

• File Name: Indicates the name of the file in which data 
is being collected. The file is automatically named by 
the receiver according to conventions provided in 
Appendices on page 262.

• Current Power and Memory statuses in graphical form.

11.Wait until Remain = 00:00:00. The receiver then displays 
the screen below:
 



Cross points indicate 
where static occupations 

take place.
The line indicates 
continuous  data 

collection, from the first to 
the last point.

0001
0002

0003

0004

000500060007

Rover

 Allowing for kinematic 
initialization using 

Initializer bar at the base
Note that the content of the Site ID field is incremented by 
1 after ending static occupation on a point (increment: 0 
to 9, then A to Z, then 0.. again, etc.). You can however 
change the Site ID between any two occupation times by 
pressing the LOG key (not the on-screen LOG button) and 
editing the Site ID field.

12.Move to the next point and resume the above two steps 
until all the points have been visited.

13.Tap Done after surveying the last point. This completes the 
data collection phase.

Running a Kinematic Survey

Base Setup and Operation
The base is setup and operated in the same way as it is in 
static surveys (see page 88). The only difference is the possi-
ble use of the initializer bar at the base station.
The base antenna should be centered and levelled above the 
known point. To be able to use the initializer bar for initializa-
tion, be sure to incorporate the bar as part of the base setup 
as shown opposite. This bar gives an accurate baseline of 0.2 
m (0.656 ft) for initialization.
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1.

4.

5.

Temporary Setup for Bar Ini
Rover Setup
Install the unit on its range pole:
1. Attach the field bracket onto the pole.
2. Place the ProMark3 receiver into the field 

bracket.
3. Connect the GPS antenna cable to the unit.
4. Mount the GPS antenna on top of the pole or, 

in the case of a bar initialization, at the end of 
the base’s initializer bar.

5. Connect the other end of the antenna cable to 
the rover antenna.

6. Measure the antenna height.

Kinematic Survey Rover Setup

1. Turn on the receiver by pressing the  red key. Wait for 
the ProMark3 workspace to appear on the screen.

2.

3. 4.

3.

5.

tialization: Setup for Known or <None> Initialization
(and Final Rover Setup after initialization step)



Satellite Status screen

Initialization method:

1) None
2. Double-tap the Surveying icon to run the Surveying func-
tion. The screen displays the navigation screen that was 
last displayed.

3. Make the settings required when first using the Surveying 
function:
• Press the MENU key
• Tap Setup. In the Setup menu, tap successively the 

options you need to set. Remember you need to define 
the Storage medium (internal memory or SD card) and 
the Receiver ID. If you have a ProMark3 RTK, press 
the MENU key again, tap Receiver Mode and then 
select Post-Processing. Skip step 3 when next using the 
Surveying function.

4. Press the NAV key until you see the Satellite Status screen 
(see opposite). Wait until at least 4 satellites are received.

5. When there is enough satellites received, press the LOG 
key. The Survey Settings screen opens.

6. Tap inside the Survey Mode field and then tap Kinematic. 
The content of the screen will be different depending on 
the choice you make in the Initialize field (see below). This 
is explained in detail below.

2) With initializer bar 3) On known position
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VerticalSlant
Enter the following parameters:
• Site ID and Site Description: Set these two parameters 

after choosing the Initialization method (see below 
after the Initialize parameter).

• Antenna Height: Tap inside this field and enter the verti-
cal distance between the antenna and the surveyed 
point. Be careful when entering the antenna height as 
this field uses a fixed format (xx.xxx). Then press the 
ENTER key, or tap  on the on-screen keyboard, to 
validate the content of this field.

• Units: Tap inside this field and then tap the unit used 
to express the antenna height (meters, US feet or Int 
feet)

• Height Type: Tap inside this field and then tap the 
method used to measure the antenna height: Slant if 
you measured the antenna height to the outside edge 
of the GPS antenna, or Vertical if you measured the 
antenna height to the bottom of the GPS antenna 
mounting thread (see opposite).

• Recording Interval: Tap inside this field and then tap the 
recording interval (time in seconds between any two 
consecutive acquisitions of GPS data) you wish to use 
in your kinematic survey. Make sure the same record-
ing interval is used at the base and in the rover.

• Initialize: Choose the method to initialize the kinematic 
survey (Known, bar or <None>; see page 98).



Carefully choose the Site 

ID!
Remember ProMark3 will 
automatically increment 

the Site ID as you progress 
in your Kinematic survey. 
So make sure the Site ID 

you choose will not gener-
ate Site IDs that already 

exist. If that was the case, 
ProMark3 would overwrite 

these Site IDs without 
warning you. 
• Site ID: Set this parameter according to the initializa-
tion method you choose:
-If <None> or Bar is selected, you can freely enter a Site 

ID from the keyboard. Tap inside the field and enter 
a 4-character string using the virtual (on-screen) or 
real keyboard. Then press the ENTER key, or tap 

 on the on-screen keyboard, to validate the site 
ID.

-When you select Known, the receiver prompts you to 
choose a Site ID from the list of existing control 
points. Tap the desired Site ID.

• Site Description: (Optional) Tap inside the field and 
enter a narrative description of the point (20 charac-
ters max.). Then press the ENTER key, or tap  on 
the on-screen keyboard, to validate the content of this 
field.
When several Site Descriptions have previously been 
defined, you can quickly retrieve these by tapping the 
left arrow to the right of the field. The list of existing 
descriptions then appears in which you can tap the 
desired one. This automatically sets the Site Description 
field on the Survey Settings screen. 

• Time on site (sec): If Bar or Known is selected as the Ini-
tialization method, enter the occupation time on site, 
in seconds, required for initialization. If you select 
<None>, this field is removed from the screen.

Initialization Phase
7. Tap the Log button at the bottom of the screen. This starts 

data collection which will stop only at the end of the Kine-
matic survey. So be sure from now on, and until the end of 
the survey, that you will not mask the antenna.
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Initialization count-down.
What happens after starting data collection depends on 
the chosen initialization method:
• With Bar or Known selected, the receiver first goes 

through an intermediate screen showing the counting-
down of the initialization phase (see screen opposite). 
The Remain field will count down beginning from the 
value of the Time on site field set in the Survey Settings 
screen. At the end of the countdown sequence, the 
Remain field reads “00:00:00”.
If you are performing initialization on known point, you 
are now ready to start the stop & Go survey. Continued 
in next chapter Data Collection.
If you are performing ini-
tialization on bar, you 
now have to move the 
rover antenna from the 
initializer bar to the top 
of the rover pole (see 
illustration opposite). 
While doing this, take 
care not to mask the rover 
antenna or else you would 
have to resume the ini-
tialization.

• With <None> selected, 
because there is no ini-
tialization phase, 
ProMark3 directly 
switches to data collec-
tion. Continued in next 
chapter Data Collection.



Make sure the rover 
antenna has the best 

possible view of the sky at 
all times during the 

survey. This should result 
in #Sats continuously 

greater than 4 and PDOP 
continuously less than 4.

The Obs. Range field is 
irrelevant to the kinematic 

mode and for this reason 
is left blank.
Data Collection
8. Walk to the start point of the trajectory you want to survey, 

making sure you will not mask the antenna.
9. If you have initialized on bar or known point, you may 

need to change some of the survey settings (typically you 
need to change the antenna height after moving the rover 
antenna from the initializer bar to the pole).
In this case, press the LOG key, which here is different 
from tapping the on-screen Log button, and then review 
and correct if necessary the following parameters:

- Antenna Height: After bar initialization, you need to 
enter the new height of the rover antenna as it is 
now located on top of the pole. After initialization 
on known point, you should not have to change this 
parameter.

- Initialize: Check that <None> is now selected.
If you have selected <None> as the initialization method, 
skip step 9.

10.Tap the on-screen Log button and then walk along the tra-
jectory. The screen then looks like this:
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Information provided here will help you monitor the survey 
of the trajectory.
• Obs. Range (Observation Range): Field left blank as it 

is irrelevant to Kinemativ survey.
• Elapsed: Displays the time elapsed, in hours, minutes, 

seconds, since you tapped the Log button (at the beg-
ginning of the trajectrory).

• # Sats: Displays the current number of healthy satel-
lites – seen above the elevation mask – being logged 
into memory.

• PDOP: Displays the PDOP value at any given time, 
computed from all observed healthy satellites above 
the elevation mask.

• Site ID: Indicates the name of the last logged position 
along the trajectory.

• File Name: Indicates the name of the file in which data 
is being collected. The file is automatically named by 
the receiver according to conventions provided in 
Appendices on page 262.

• Current Power and Memory statuses in graphical form.
As you are progressing along the trajectory, the content of 
the Site ID field will be incremented by 1 at the recording 
interval rate (increment: 0 to 9, then A to Z, then 0.. 
again, etc.).



Bold lines indicate the 
trajectories surveyed.

Data collection is NOT 
suspended between the 

trajectories.

Log
0001...

Log

Pause

Rover

00014...

0015...

0028
11.Use the buttons at the bottom of the screen to do the fol-
lowing:
• Pause: Tap this button when you arrive at the end of 

the trajectory. Remember tapping this button does not 
mean that you stop data collection: actually data col-
lection continues! When you tap Pause, the button is 
then renamed “Log”. Tap the Log button when you are 
at the start point of a new trajectory you want to sur-
vey..

• Done: Will end the kinematic survey by closing the 
data file and taking you back to the last displayed nav-
igation screen. This ends data collection. (After select-
ing Done, the receiver is idle but still in the Surveying 
function.)
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Re-Initialization

When is Re-Initialization Required?
Re-initialization is required when the following message ap-
pears on the screen, due to poor GPS reception, while you are 
running a Stop & Go or Kinematic survey that you initialized 
through the “Bar” or “Known” initialization method:

When this occurs, you will unfortunately have to resume all or 
part of your survey. The reason for this is that due to a break 
in the flow of collected data, the post-processing software will 
not be able to deliver the expected level of accuracy for all 
those points that you might have surveyed AFTER the data 
break.
Following the occurrence of this message, tap anywhere out-
side of the message window to acknowledge the Reinitialize 
alarm. Then resume the survey from the last control point you 
surveyed (see next section).
The next section describes a preventive procedure that you  
can use to better respond to possible re-initialization require-
ments.



Preventive Steps to Facilitate Re-initialization
If you take care to create “intermediate” control points as you 
are progressing in your stop-and-go surveys, you will make re-
initialization easier in the sense that you will not have to re-
sume the survey from the beginning. Instead, you will just 
have to walk back to the last “intermediate” control point you 
will have surveyed and run a new initialization on this point 
using the “Known” option. Kinematic surveys conducted in 
the vicinity can also benefit from this intermediate control 
point should they undergo the same re-initialization problem.

1. Creating an intermediate control point

A couple of times during your stop & go surveys:
• Spot a location where reception is particularly good and 

where it is easy to come back (the location should clearly 
be marked one way or another).

• Keep still on that point.
• Press LOG (which here is different from tapping the on-

screen Log button).
• Change the Site ID. Keep in mind the Site ID that is dis-

played (e.g. “1034”) and the one you enter (e.g. “CP10”).
• Check the Control Point option and tap Log.
• Keep still until the Remain field is zeroed.
• Then press LOG again, re-enter the former Site ID 

(“1034”), clear the Control Point option and continue with 
your survey.
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2. Re-initializing on an intermediate control point

If the “Loss of Lock. Reinitialize” message arises when you 
are performing a Stop & Go survey:
• Acknowledge the alarm by tapping anywhere outside of 

the message window.
• Walk to the control point you last surveyed.
• Check that you have enough satellites and a good PDOP 

on that point
• Press the LOG key.
• Select “Known” in the Initialize field, then tap the Site ID 

corresponding to this point (remember in our example you 
named that point“CP10”).

• Tap Log and wait for the Remain field to countdown to zero.
• Walk to the point where the alarm message occurred keep-

ing the pole range always vertical and making sure the 
antenna has continuously an open view of the sky.

• When you have arrived at the point, press the LOG button, 
rename the Site ID and continue with your survey.

If the “Loss of Lock. Reinitialize” message arises when you 
are performing a Kinematic survey:
• Acknowledge the alarm by tapping anywhere outside of 

the message window.
• Tap Done to close the observation file.
• Walk to the control point you last surveyed.
• Check that you have enough satellites and a good PDOP 

on that point
• Press the LOG key.



• Select “Kinematic” as the Survey mode
• Select “Known” in the Initialize field, then tap the Site ID 

corresponding to the “intermediate” control point (remem-
ber in our example you named that point “CP10”).

• Tap Log and wait for the Remain field to countdown to zero.
• Walk to the beginning of the trajectory you were surveying 

when the alarm message occurred.
• Press the LOG key, rename the Site ID.
• Tap Log to resume the survey of the trajectory you have not 

been able to complete the first time.

Quitting the Surveying Function

Press the MENU key and tap Exit. This takes you back to the 
ProMark3 workspace screen.
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A feature library is a hierar-
chical structure that guides 
you through the description 

process so you know you 
will describe thoroughly 

and quickly each feature 
you visit. You will not have 

to remember what 
attributes of each feature 

you should record: the fea-
ture library will tell you!

Example of a “streetlight” 
point feature, as may be 

described in a feature 

library 

Feature libraries are cre-
ated using the Feature 

Library Editor module in 
MobileMapper Office.

Condition

# of bulbs

Closest

Address

List Attribute
valuesof streetlight 

- Good
- Needs repair
- Needs paint

Enter

Type in

numeric value

Street

address

attributes
7. Mobile Mapping

Feature Libraries

Feature libraries contain lists of features that you should be 
visiting during your field sessions.
Features are four types:
- Point feature: The geometrical representation of this fea-

ture is a point. Logging this type of feature requires static 
occupation at the point.

- Line feature: The geometrical representation of this fea-
ture is a line. Logging this type of feature requires that you 
move along this line.

- Area feature: The geometrical representation of this fea-
ture is an area. Logging this type of feature requires that 
you move along its contour.

- Grid feature: The geometrical representation of this fea-
ture is an array of evenly-distributed waypoints. ProMark3 
will guide you to each of these waypoints where you 
should enter a measurement performed at this point.

Each feature also has a number of attributes. There are three 
categories of attributes:
- Menu style where the attribute values are words or phrases 

that you pick off a list (e.g. a list of values for the attribute 
Condition might include Good, Needs Repair, etc.; see 
opposite)

- Numeric style where you select a number within a speci-
fied range (e.g. the # of bulbs might be in the range 0 to 
3)

- Text style where you type in a note that can contain both 
numbers and letters (e.g. the closest street address)



Satellite Status screen
You can upload as many feature libraries as you want into 
ProMark3. Just remember that you can use only one feature 
library for logging data to an individual job.

Logging New GPS/GIS Data

Remember you can use the real-time DGPS capability if you 
need it. See Selecting a DGPS Mode on page 209.
With a ProMark3 RTK using an external antenna, MobileMap-
ping can also be run in RTK mode, thus offering the same ac-
curacy level as in surveying.
Once you know how to perform RTK surveys with ProMark3 
RTK (see RTK Setup on page 34), it’s easy to understand how 
you can extend the use of RTK to Mobile Mapping. However 
the current position status (“Float”, “Fixed”, etc.) can only be 
seen on the Position screen (see Position Screens on 
page 147).

1. Turn on the receiver by pressing the  red button. 
2. Double-tap the Mobile Mapping icon.
3. Press the NAV key until you see the Satellite Status screen 

(see opposite) Wait until at least 4 satellites are received. 
For the best accuracy it is important to hold the receiver at 
an angle of 45° from horizontal and not too close to you.

4. Follow the instructions below to log GIS features.

45°
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Entering a job name

Note that each ProMark3 
includes a "Generic" library 

containing default fea-
tures. This library contains 
a point feature, a line fea-
ture, an area feature and a 
grid feature. Each of these 
features has a single text-

style attribute. Use this 
library only as a “backup” 

library.
1. Creating a Job and Selecting a Feature Library

- Press the LOG button
- Tap Create New Job. The screen displays the Job Name 

field in which you should enter the name of the new 
job. A keyboard is displayed underneath to let you 
enter this name.
To enter a name, tap on the corresponding letters on 
the keyboard.

- When you have finished entering the name, tap  on 
the on-screen keyboard or press the ENTER key. A new 
screen is then displayed listing the feature libraries 
stored in ProMark3. 

- Tap the name of the feature library you want to use. A 
new screen is then displayed asking you to choose the 
job mode:
• Real-time: If you select this job mode, the receiver 

will record only feature positions and descriptions 
and GPS metadata. Jobs recorded in real-time mode 
cannot be differentially corrected later on.

• Post-processing: Select this job mode to allow 
ProMark3 to record the job so that later on, it can be 
post-processed in MobileMapper Office. In this job 
mode, ProMark3 will record GPS measurements files 
in addition to the MMJ job file that is recorded in 
real time. For more information, see MobileMapper 
Office User Manual.

- Tap one of these modes. The screen now lists all the 
features available from the selected feature library.



ProMark3 uses a fixed, 
time-based logging inter-
val (1 second) when you 
log a point feature. The 

logging interval parameter 
cannot be accessed when 

you log a point feature. 

Logging screen

The Logging screen also 
displays the time elapsed 

since you started logging at 
this point feature, the 

number of satellites cur-
rently received and the cur-

rent value of PDOP (see 
also page 139).

If you start logging a new 
feature and you realize this 
is a mistake, then you can 

delete the new feature 
being logged by tapping 
the Options button and 

selecting Delete <feature 
name>.

Deleting features only 
applies to new features 

being logged, not to fea-
tures already logged.
2. Logging and Describing a Point Feature

- Choose the type of feature you want to log from this 
list. You can tell by the name of this feature whether it 
is a point feature, a line feature or an area feature.

- Tap a point feature (you are supposed to be near one of 
these features) and tap the on-screen Log button. This 
starts feature logging. A sound is heard every time 
ProMark3 logs data.
The Logging screen is now displayed where you can 
see the list of attributes pertaining to this feature. You 
will now enter the “Description” phase of the feature.

- Tap the first attribute and enter the right attribute 
value describing the feature near you. This takes you 
back to the Logging screen.

- Highlight the next attribute in the list and repeat the 
previous step. Repeat this step until all the attributes 
have been properly described.
“Describing” the feature only takes a few seconds. By 
the time you are done with the feature description, the 
feature’s GPS position will have been saved in the job. 
You can also stay more time on the feature to let the 
receiver determine several positions. This will give an 
even more accurate position for the feature as 
ProMark3 will average all the GPS positions it has 
computed on the feature.

- To stop logging the feature, tap Done. This takes you 
back to the Feature List screen

- Move to the next feature and resume the above 
instructions to log this feature.
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Selecting the logging inter-
val option
3. Logging and Describing a Line Feature

Basically, you use the same procedure as when you log a 
point feature (see 2. above). There are however two differ-
ences when you log a line feature:
- You need to define a logging interval when you start 

logging the feature
- And then you are supposed to move from the begin-

ning to the end of the line feature before stopping the 
logging.

These differences are explained below.
After tapping a line feature from the Feature List screen 
(for example a road) and tapping the Log button, 
ProMark3 starts logging GPS positions from the position 
where you are. The default logging interval is 5 seconds.
By decreasing the logging interval you can increase the 
level of detail in your maps. By increasing the logging 
interval, you can save memory. In general, you should set 
the logging interval to the smallest setting possible with-
out running out of memory. Remember you can take multi-
ple SD cards with you to the field. The only requirement is 
that you close the job file before replacing the SD card.

To change this interval:
- Tap Options on the screen and then Logging Interval.



The Logging screen also 
displays the distance trav-
eled since you started log-

ging the line feature, the 
number of satellites cur-

rently received and the cur-
rent value of PDOP (see 

also page 225).

Logging screen
Two options are then prompted:
By Time: Select this option when you want to log a new 
GPS position at regular intervals of time regardless of 
the distance traveled since the last position logged. 
After tapping this option, tap the desired time interval. 
This takes you back to the Logging screen where you 
can see the list of attributes pertaining to the feature.
By Distance: Select this option when you want to log a 
new GPS position only after you have moved by a cer-
tain distance since the last position logged. After tap-
ping this option, tap the desired distance interval. This 
takes you back to the Logging screen where you can 
see the list of attributes pertaining to the feature.

- As you would for a point feature, describe the feature 
by describing the different attributes pertaining to the 
feature

- When the description is finished, you can start walking 
along the line feature

- When you arrive at the end of the line feature, with 
ProMark3 still displaying the Logging screen, tap Done 
to stop logging the feature.

The receiver determines the length of a line feature by 
estimating the distance between successive points on the 
line feature with the assumption that each point is on a 
sphere of average Earth radius. The elevations of the 
points are not factored into the equation. Thus the 
receiver calculates the spherical distance rather than the 
horizontal or slope distance between the successive posi-
tions.
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This screen displays the 
current values of perime-

ter and area measured 
since you started logging 
the feature (+ number of 

satellites and PDOP)

Logging screen
If you wish to change the logging interval while you are 
logging a line feature, you first need to pause the logging 
of the feature:
- Tap Options and then Pause <line feature name>
- Tap Options again and then Logging Interval. Set the 

new logging interval as explained above.
- After changing the logging interval, tap Options and 

then Resume <line feature name>. The receiver will con-
tinue to log the feature, but this time according to the 
new logging interval.

4. Logging and Describing an Area Feature

Basically, you use the same procedure as when you log a 
line feature, especially regarding the need for defining a 
logging interval (see 3. above). The only difference 
between a line and area feature is that for an area feature, 
the first and last position calculated by the receiver are 
connected when you close the feature.

Record the attributes of an area feature as you do for a 
line feature (see page 126):
- Tap the name of the area feature from the list of fea-

tures and tap the Log button. ProMark3 starts logging 
the area feature.

- Choose a logging interval (see explanations given for a 
line area on page 127). This takes you back to the 
Logging screen where the list of attributes for the fea-
ture is displayed

- Describe each attribute by selecting or entering the 
appropriate attribute value for each of them.



Selecting the Pause Park 
option
The receiver determines the perimeter of an area feature 
by estimating the distance between successive points on 
the line feature with the assumption that each point is on 
a sphere of average Earth radius. The elevations of the 
points are not factored into the equation. Thus the 
receiver calculates the spherical distance rather than the 
horizontal or slope distance between the successive posi-
tions. The perimeter of the area feature is the sum of all 
these distances. For the same reason, the measured area 
is that of a curved, not flat, feature.

5. Pausing a Feature

When you are recording lines or areas, it is sometimes 
impossible to walk or drive the entire length of the feature 
because of obstacles in your way such as fences, build-
ings, bodies of water, etc. When you must interrupt the 
recording of any feature (excluding point features), follow 
these steps:
- Tap Options and then Pause <feature name>. This pauses 

the logging of the feature.
- Move around the obstacle to the next accessible por-

tion of the feature
- To resume logging, tap Options and then Resume <fea-

ture name>. This resumes the logging.
- When you finish logging the feature, just tap Done.
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Selecting the Repeat 
Attributes option
6. Logging New Features with Same Attributes as Those Set 

in the Previously Logged Feature

If you close a point, line or area feature and want to log 
the location of another feature of the same type and with 
an identical description, use the Repeat Attributes function.
After closing a feature, ProMark3 takes you back to the 
Feature List screen on which the same feature type is still 
selected. Just do the following:
- Move to the next similar feature you want to log.
- Tap Log to start logging the new feature.
- Tap Options and then Repeat Attributes. As a result, all 

the attributes of the previously logged feature are 
immediately assigned to the feature been logged.

- After logging the GPS position(s) of this feature, tap 
Done to close the feature.

7. Nesting a Feature

When you are logging GPS positions to a feature, you may 
find another feature that you also want to log. Rather than 
log the entire feature and come back to record this other 
feature, you can simply pause the feature being logged, 
log the other feature, close it and resume logging the first 
feature.
Logging one feature while you have paused another fea-
ture is called “nesting.” You can nest any feature, point 
line or area, into any line or area feature. It is not possible 
to nest a point feature inside another point feature.
Nesting is particularly useful when you are mapping things 
such as a road with streetlights along the route or a shore-
line with stretches of erosion along it and the locations of 
certain habitats.



Assuming you are logging a line feature and the Logging 
screen is displayed, do the following, for example to nest a 
point feature:
- Tap Options and then Pause <feature name>. This pauses 

the logging of the line feature.
- Tap Options again and then Nest Feature
- Move to the location of the feature you want to nest
- In the Feature List screen now displayed, tap the fea-

ture type you want to nest.
- Tap Log to start logging this feature.
- Describe the attributes of the feature as explained 

above
- Tap Done when you have finished logging the nested 

feature.
- Tap Options and then Resume <feature name>. This takes 

you back to the Logging screen from which you can 
normally finish the logging of the line feature.

8. Offsetting a Point Feature

Sometimes the feature you want to put on the map is in 
area of poor GPS reception or is not accessible. This is 
when you can map the feature using the offset utility. By 
combining the receiver’s position with the bearing and dis-
tance to the feature, ProMark3 will automatically calcu-
late and record the position of the feature.
To input an offset for a point feature, assuming the Fea-
ture List screen is now displayed, do the following:
- Tap one of the listed point features available from the 

selected feature library.
- Tap Log to start logging the feature
- Tap Options and then Offset.
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Point Offset screen

If you do not have a com-
pass, you can use 

ProMark3’s Compass 
screen (see also page 145) 
to determine the bearing to 

the offset feature. If you 
have been moving for 5 to 

10 seconds along a 
straight line, the Compass 

screen will tell you your 
bearing. You can use this 

to determine the bearing to 
the offset feature. CAU-

TION! The receiver cannot 
determine direction while 

stationary and the compass 
direction remains the same 

even if you rotate the 
receiver.

Visual estimation for horz. 
& vert. distances is usually 

good enough in terms of 
accuracy.
This displays the Point Offset screen on which you 
should enter the following parameters:
Bearing: Compass direction to the feature from your 
current position. You need a compass to measure this 
angle (see also opposite). To input a value for Bearing, 
press ENTER and type in the new value from the key-
board or the on-screen keyboard. Then press ENTER 
again.
Press the down arrow to move the cursor to the next 
field.
Horz. Distance: Horizontal distance to the feature from 
your current position. To input a value for Horz. Dis-
tance, press ENTER and type in the new value from the 
keyboard or the on-screen keyboard. Then press 
ENTER again.
Press the down arrow to move the cursor to the next 
field.
Vert. Distance: Vertical distance to the feature from your 
current position (“0” if the feature and yourself are at 
the same elevation -on a flat area). To input a value for 
Vert. Distance, press ENTER and type in the new value 
from the keyboard or the on-screen keyboard. Then 
press ENTER again.
Press the down arrow to move the cursor to the next 
field.

- Then tap OK to return to the Logging screen. This 
writes the offset into memory, but you can edit it later 
if you like by going through the same process. If you 
close the feature and return to the Map screen, you 
will see that the feature is offset from your position in 
the middle of the screen.



Line or Area Offset screen 

On the left On the right

Line Area

Visual estimation for horz. 
& vert. distances is usually 

good enough in terms of 
accuracy.
9. Offsetting a Line or Area Feature

For the same reasons as a point feature (see previous 
page), you may need to use the offset utility to map a line 
or area feature. By combining the receiver’s position with 
the direction and the distance to the feature, ProMark3 
will automatically calculate and record the location of the 
feature.
To input an offset for a line or area feature, assuming the 
Feature List screen is now displayed, do the following:
- Tap one of the line or area features available from the 

open feature library.
- Tap the Log button to start logging the feature.
- Tap Options and then Offset. This displays the Line or 

Area Offset screen on which you should enter the fol-
lowing parameters:
Direction: Location of the feature with respect to your 
actual path. To input a value for Direction, tap the down 
arrow and then tap the desired option (Right or Left). 
Press the down arrow to move the cursor to the next 
field.
Horz. Distance: Horizontal distance to the feature from 
your current position. To input a value for Horz. Dis-
tance, press ENTER and type in the new value from the 
keyboard or the on-screen keyboard. Then press 
ENTER again.
Press the down arrow to move the cursor to the next 
field.
Vert. Distance: Vertical distance to the feature from your 
current position (“0” if the feature and yourself are at 
the same elevation -on a flat area). To input a value for 
Vert. Distance, press ENTER and type in the new value 
from the keyboard or the on-screen keyboard. Then 
press ENTER again.
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To operate the grid map-
ping utility, you will need a 
measurement device - any-
thing from a depth sounder 

to a ruler, your own sense 
of smell or your ability to 
make visual observations. 
You will also need a com-

pass. 
Press the down arrow to move the cursor to the next 
field.

- Tap OK to return to the Logging screen. This writes the 
offset into memory, but you can edit it later if you like 
by going through the same process.
Note: Offsets to area features are applied in 
MobileMapper Office and not in the receiver.

10.Logging GIS Data on a Preset Grid Feature

 The ProMark3's Grid Mapping Utility is an easy way to 
automatically set up a series of GPS waypoints to facilitate 
the logging of data in an orthogonal grid.This utility 
assures that you gather measurements made using field 
sensors such as chemical detectors, depth sounders and 
magnetometers at an evenly distributed set of locations. 
This in turn assures the creation in your GIS of contour 
maps with a prescribed density of data and without any 
gaps that might force you to return to the field.
The Grid Mapping Utility deals with two different grid con-
cepts: grid features and grid points.
- Grid features are arrays of uniformly spaced waypoints 

oriented in rows and columns
- Grid points are navigation features similar to way-

points.
Important Notice: Once you have logged a grid feature in a 
job (assuming the selected feature library allows you to do 
so), you cannot log any other feature type in the job, not 
even another grid feature. Conversely, once you have 
logged a point, line or area feature, you cannot log a grid 
feature even though the feature library selected for the job 
does initially include a grid feature type.
For this reason, you should collect your grid data in spe-
cific jobs.



GOTO will not be shown in 
the menu list if you press 
MENU while the unit dis-

plays the Map screen in 
cursor mode. In that case, 

just press NAV and then 
MENU again.

Grid Setup screen 
To log GIS data on a preset grid, do the following:
- If you have created a waypoint to help you locate the 

first grid point, you can use any of ProMark3's naviga-
tion screens to get there. Press MENU and tap GOTO. 
Using the Left or Right arrow, make sure Alphabetical is 
selected at the bottom of the screen. Then tap User 
Waypoint. In the list of waypoints now displayed, tap 
the name of the waypoint you want to go to. Again, you 
may use any of the ProMark3's navigation screens to 
arrive at this waypoint

- Once you arrive at the point of beginning, you should 
open up the job file that includes the feature library 
describing the grid. If you opened an existing job, 
press LOG to take you to the New Feature screen. Then 
tap the grid feature type listed on the screen. Usually 
the term “grid” is included somewhere in the feature 
name so that you can easily recognize this type of fea-
ture. Tap the on-screen Log button. The Grid Setup 
screen appears on which you can read the definition of 
the grid (see opposite)..
When you navigate to the location of the grid, you may 
decide to readjust the size and orientation of the grid 
based on field observations that you did not foresee 
back in the office. For example, you may find that nav-
igating to waypoints with an east-west orientation is 
not feasible if the area of interest is situated on a nar-
row strip of land between two north-south running 
streams.
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When you change the definition of a grid, ProMark3 
always assumes that you are standing in the corner of 
the grid from which you can see the grid extend in 
front of you and to the right.
The definition of a grid is based on the following four 
parameters:

Spacing: Distance between any two consecutive way-
points in any row or column (default: 50 meters or 
100 feet, depending on the units used)
Columns: Number of waypoints along the axis facing 
you (default: 10; Max.: 100)
Rows: Number of waypoints along the axis perpen-
dicular to the direction you are facing (default: 10; 
Max.: 100)
Heading: Direction you face when the grid’s columns 
extend in front of you and the rows extend to your 
right.

- To change the above parameters, use the up/down 
arrows to move the cursor to each of these fields, press 
ENTER and edit the field using either keyboard. When 
you are done with the definition of a field, press 
ENTER. Then press the down/up arrow to access the 
next field, etc.

- Record an observation or measurement: Tap OK at the 
bottom of the screen. This takes you to the Logging 
screen that indicates that you have begun logging data 
to the feature and that the receiver is ready to log the 
feature's attributes. Remember that you remain sta-
tionary for all point features. Describe the feature as 
you would any other point feature.



It is also possible to navi-
gate to any grid point (or 

any location for that mat-
ter) on the Map screen by 
tapping over another grid 

point. After you record data 
at this location, you will 

still be prompted to go to 
the next grid point .
- Navigate to the next grid point: When you have fin-
ished recording the first point feature, tap Done. A 
message prompts you to go to the next grid point. Tap 
Yes to navigate to the next grid waypoint and record 
the next point feature within the grid. This takes you to 
the Map screen where you can see your current posi-
tion marked by the arrow and the next grid waypoint 
highlighted with a “crossed box” target symbol. Small 
hollow squares indicate the locations of all the unvis-
ited grid waypoints. Small filled squares (“black” 
squares) indicate the locations of where you recorded 
point feature.
As you begin moving toward the target symbol, you will 
see your heading indicated by the direction of the 
arrow marking your position. Adjust your movement as 
necessary until you are positioned over the target sym-
bol. You may also use any of the other navigation 
screens available with your ProMark3. The Arrival 
alarm is disabled when navigating to grid points. It is 
best to note your distance to the next point and stop 
when this value goes to zero. When you arrive at the 
next grid point, press the LOG button and you will see 
the same Logging screen you used for the earlier mea-
surement or observation.
Each grid point is a geographic coordinate you should 
make every effort to occupy so that the data you record 
is evenly spaced and complete. However, each grid 
point is merely an aid for navigating to the ideal loca-
tion for an observation or measurement. All the data 
you record is ascribed to the position of the ProMark3 
receiver and NOT to the grid point.
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If you cannot physically occupy this point, but can 
make the necessary visual observation, you should do 
so and record an offset estimating the distance and 
bearing to the grid point. If you are recording measure-
ments made by an instrument, you should NOT record 
an offset but rather try to make a recording as close as 
possible to the position.

- When you have occupied as many of the grid points as 
you can and recorded the necessary observations and 
measurements at each, tap Done at the bottom of the 
Logging screen.

- Tap No when ProMark3 asks you to go to the next grid 
point.

- Press the LOG button and tap Yes to close the job.

11.Closing the Job

To close a job, from the screen showing the list of attributes, 
tap Done then confirm by tapping Yes.



Job List screen 

Screen prompting you to go 

to the selected feature

When you know which 
attributes must be changed 

for a point feature, which 
means you don’t really 
need to visit the point, 

then tap Edit rather than 
Goto and change the 

attributes directly.
Revisiting and Updating Existing GPS/GIS 

Jobs

You can use ProMark3 not only to position and describe new 
GIS features but also to update information gathered previ-
ously. This is particularly useful when collecting data on 
things that change over time: streetlight bulbs burn out, new 
roads are added to housing developments, new crops are 
planted, etc.

1. General Procedure

Return to the area where the original job was recorded, turn 
ProMark3 on and double-tap the Mobile Mapping icon. When it 
has calculated a GPS position, follow the procedure below to 
update the job or to append more data to it.
- Press the LOG button and tap Open Existing Job.
- Tap the name of the job you want to revisit.
- Unless this screen is already displayed, press NAV repeat-

edly until the Map screen is displayed. The Map screen 
provides a geographical view of the different featutes 
present in the job. From this screen, you will now indicate 
the first feature you want to revisit. If necessary, press the 
IN or OUT button to adjust the scale so you can see this 
feature.

- On the Map screen, tap on the feature you want to revisit 
first. (The feature name appears in the lower part of the 
screen when the cursor is positioned over the feature.)

- When the map cursor is positioned over the feature to be 
updated, press ENTER. A new screen is displayed showing 
the attribute values currently ascribed to the feature. Note 
that the Goto field is highlighted at the bottom of the 
screen.
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Map screen showing 

straight line to target 
- Tap Goto to ask ProMark3 to guide you to this feature. By 
doing this, you will make the selected feature your desti-
nation and all the navigation screens will be set to help 
you reach that feature. The Map screen will also be auto-
matically displayed showing a straight line connecting 
your current destination to the selected feature.

- Walk to the feature according to the navigation instruc-
tions provided on the Map screen. You can use other navi-
gation screens if you prefer (see also Navigation Screens 
on Navigation Screens on page 143). You will know when 
you are close to the feature when the distance to the fea-
ture goes to zero or close to zero, or simply because you 
can identify it visually. Another nice way of being informed 
that you have arrived at the feature is to set the Alarms 
option.

- After arriving at the feature, press the LOG key. This takes 
you to the Feature Attributes screen.

- Now that you are near the feature and you can see which 
of its attributes need to be changed, tap successively each 
of these attributes and change them.

- After reviewing the attributes, tap the Done field at the 
bottom of the screen. This ends the review of this feature 
and displays the Map screen again.

- Follow the same steps described above to revisit and 
update the other features present in the job.



2. Repositioning a Point Feature

If a point feature appears to be mislocated on the Map screen, 
do the following after you have arrived at the feature:
- Press the LOG key and tap the on-screen Log button. Let 

the ProMark3 recompute the point position and then tap 
the Done button to close the feature.
Note that only point features can be repositioned. If you 
wish to reposition a line or area feature, you should record 
a new feature and then delete the old one in MobileMap-
per Office.

3. Adding More Features and Attributes to the Job

If you want to add more features and descriptions to the exist-
ing job, you just have to record them exactly as you record fea-
tures into a new job.

4. Closing the Job

To close a job, from the screen showing the list of attributes, 
tap Done then confirm by tapping Yes.
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Using ProMark3 as a Reference Station

- Mount ProMark3 on a tripod placed over a control point, 
turn it on and then double-tap the Mobile Mapping icon.

- Press the MENU key, tap successively Setup and Storage to 
choose the media (SD Card or Internal Memory; SD Card 
recommended) where to store the reference station data 
ProMark3 is going to collect.

- Press the LOG key and then tap Reference Station. The Site 
ID screen is now displayed.

- Enter a Site ID (there is a four-character limit) as you 
would enter a job name, and then press ENTER.
From now on, ProMark3 will operate as a reference station 
until you quit the Mobile Mapping function. It is therefore 
important that you not move the receiver or any optional 
external antenna until you quit the function.
Before leaving the reference station, press the NAV key 
until you can see the Satellite Status screen. Check that 
the letter “R” now appears in the upper-right. This means 
the receiver is recording reference station data and you 
can now proceed with your job.

- After your job is complete, come back to the ProMark3 
reference station, press the MENU key and tap Exit. The 
ProMark3 exits from the Mobile Mapping function.

- Turn off the unit.

Quitting the Mobile Mapping Function

Press the MENU key and tap Exit. This takes you back to the 
ProMark3 workspace screen.



You will be able to view the 
different navigation 

screens only after launch-
ing the Surveying or 

MobileMapping applica-
tion.

The Map screen has two 
modes: Position and Cur-
sor. Using the stylus, tap 
anywhere on the map, or 

press any arrow key, to 
select Cursor mode. Press 
ESC to return to Position 

mode. 

When a Position screen is 
displayed, press the Left or 

Right arrow key to display 
the other. Press this key 

again to return to the previ-
ous screen.

Except for the Satellite 
Status screen, all naviga-
tion screens can be cus-

tomized. 
8. Navigation

ProMark3 offers very helpful navigation functions that you can 
use while performing your field operations, whether Surveying 
or Mobile Mapping.
The present chapter tells you how to use the navigation 
screens, how to create waypoints and how to work with the 
GOTO and Routes functions.

Navigation Screens

ProMark3 of-
fers 7 different 
navigation 
screens to help 
you locate your-
self or navigate 
to waypoints or 
GIS features in 
an existing job. 
From any dis-
played screen, 
simply press 
the NAV button to access the last-used navigation screen. To 
display the next navigation screen, press NAV again. The se-
quence of navigation screens is as shown above. It can be 
scrolled in the reverse direction by pressing ESC once any of 
these navigation screens is displayed.
You may find that you do not regularly use all of these screens. 
To make it faster to move among those screens that you do 
use, you may turn off individual navigation screens (except 
the Map and Satellite Status screens) by pressing the MENU 
button, selecting the Setup option and then the Nav Screens 
option.

Press NAV

Position Screen 2

Large Data Screen

Compass Screen

Map Screen

Satellite Status Screen

Speedometer Screen

Data Screen

Road Screen

Position Screen 1

Press NAV

etc.
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Map screen in Position 
mode

Map screen in Cursor mode
Select either On or Off for each screen until you see the Setup 
menu once more. Note that you must cycle through all the 
screens in order to put your selections into effect.
The following is a description of each of the navigation 
screens.

Map Screen
The Map screen shows a map of the area surrounding your cur-
rent location. Use the IN and OUT buttons to adjust the scale.
The Map screen is always in the Position mode when you ac-
cess this screen. In this mode, your present position is indi-
cated by the large arrow icon in the center of the display. If 
you are moving, the arrow will point in the direction that you 
are heading. At the bottom of the screen is the scale for the 
map displayed and two data fields that can be customized, or 
turned off, depending upon your needs.
The present position icon will change to an hourglass when 
the ProMark3 is unable to compute a position fix due to poor 
signal reception.
Tap anywhere on the Map screen or press any of the arrow keys 
to switch to the Cursor mode. In this mode, you are provided 
with a cross hair cursor that can be moved using the stylus 
(you tap directly where you would like the cursor to be) or, for 
a step-by-step move, by using the arrow keys.
At the bottom of the display is the information for the position 
of the cursor relative to your present position (heading and 
distance). Also any points of interest or GIS features that the 
cursor is over will be shown.
To return to the Position mode, press ESC. The cursor will dis-
appear and the present position icon will appear centered on 
the map.
Waypoints and control points are represented on the map 
screen using the following symbols:

Symbol Point Type Comment

Control Point Uploaded from GNSS Solutions.

Control Point Created during post-process survey per-
formed in static or stop&go mode.

Waypoint

• Uploaded from GNSS Solutions or 
MobileMapper Office.
• Default symbol used when created with 
ProMark3’s Mark function.



Compass screen
Compass Screen
The two data fields on top are customizable. The lower portion 
of the Compass screen displays your heading in a graphical 
manner.
The Compass screen contains the following information, from 
top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Icon representing destination: Displayed outside the com-
pass when you are using the Goto function. This provides 
you with the direction you need to head to arrive at the 
destination. When you are on course and heading straight 
for the destination, the destination icon will be lined up 
with the heading marker

- Compass/Heading marker: Using the compass and the 
heading marker, you can view your heading information in 
a familiar manner. Note that you need to be moving for 
this data to be valid.

The compass screen is used in the ProMark3 RTK to help the 
field operator walk to the selected stakeout point (a target 
point). When the field operator is close enough to the stakeout 
point (a few meters), thhe screen automatically switches to 
the stakeout screen (see page 56).
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Large Data screen
Large Data Screen
The Large Data screen is similar to the Compass screen but 
here the compass has been removed to allow for large display 
of the navigation data. This screen is ideal for when you have 
your unit mounted on the dashboard of a vehicle. Even from a 
distance the customizable information can be read with ease.
The Large Data screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.



Position screens 1 & 2

To switch from a screen to 
the other, just press the 
Left or Right arrow key.

The same data as on Posi-
tion screen 1 is displayed 

on Position screen 2 
except that the lower part 
of the screen, containing 

the two data fields and the 
trip odometer field, is 

replaced with the current 
position’s coordinates 

expressed in the chosen 
secondary coordinate sys-

tem and map datum.
Position Screens
Position screens #1 and #2 display your present position us-
ing the coordinate systems that you have selected (see how to 
select these systems in the two sections Coord System on 
page 237 and Map Datum on page 238.
This screen shows all of the basic position, time and satellite 
information. Additionally, on Position screen #1, current nav-
igation information is shown in the bottom half of the screen.
For the sake of comparison, Position screen #2 provides the 
coordinates of your present position both in the selected pri-
mary coordinate system and map datum, and in the selected 
secondary coordinate system and map datum.
Position screen #1 contains the following information, from 
top to bottom:
- Coordinates and elevation of your current position: Dis-

plays your current position in the chosen coordinate sys-
tem. Also displays the elevation of the current position. If 
ProMark3 is not computing position fixes, the last com-
puted position is displayed.

- GPS Satellite Status/Position Status: Provides information 
on the current status of the GPS receiver section of the 
ProMark3 (see table below).
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- Data Fields: customizable data fields (see Customize 
option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Trip Odometer: The odometer performs like the odometer 
in your car. It can be reset through the MENU button.

To customize the Position screens, use the functions de-
scribed below. The first of these context-sensitive functions is 
prompted when you press the MENU button while a Position 
screen is displayed. Some of these functions also exist in the 
Setup menu.

Message Description
Searching - 1st sat Searching for 1st satellite.

Searching - 2nd sat 1st satellite found; searching for 2nd satellite.

Searching - 3rd sat 2 satellites are being tracked; searching for a 3rd.

Searching - 4th sat 3 satellites are being tracked; searching for a 4th.

Collecting Data All satellites needed for position fix are being tracked 
and position is being computed.

Averaging ProMark3 is computing fixes; speed is near 0.0 and so 
position is being averaged.

WAAS Averag ProMark3 is computing fixes using SBAS; speed is near 
0.0 and so position is being averaged.

EPE xxx. Estimated Position Error. ProMark3 is computing fixes 
while moving.

DGPS
DGPS Averag

Computed fixes are being differentially corrected using 
RTCM corrections (“DGPS Averaging” when speed near 
0.0.).

FLOAT ProMark3 RTK provides a float position solution.

FIXED ProMark3 RTK provides a fixed position solution.



Road screen
Road Screen
The Road screen presents your route as if you were travelling 
on a road. When you need to make a turn, the road will graph-
ically display the turn and the direction. Waypoint and desti-
nation icons will be displayed relative to your position as they 
come into view. Above the road is a compass that displays your 
heading and above that are four customizable data fields.
The Road screen contains the following information, from top 
to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Compass: Displays your heading in a familiar compass for-
mat.

- Road: This graphically displays the route (Goto) that is 
active. As you move left or right of your intended track, the 
road will move on the display indicating which way you 
need to steer to get back on track. Ideally, the road would 
be centered on the display. Also, you will see upcoming 
turns in advance allowing you to make necessary prepara-
tions.

- Scale indicator: Use Zoom In/Out to change the scale.
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Data screen
Data Screen
When you need to see a lot of information in one place then 
you will appreciate the Data screen. The Data screen provides 
you with six data fields and an active compass that is the same 
as the one used on the road screen. You have the option of 
customizing this screen by selecting what data is displayed in 
the upper six fields. The lower portion of the screen is occu-
pied by a compass providing your heading.
The Data screen contains the following information, from top 
to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Compass: Displays your heading in a familiar compass for-
mat.



Speedometer screen
Speedometer Screen
The Speedometer screen displays your speed in a familiar 
graphical format. There are four additional data fields at the 
top of the display that can be customized to display the data 
that you need. The bottom of the screen contains a trip odom-
eter that will record the distance travelled since the last time 
the odometer was reset.
The Speedometer screen contains the following information, 
from top to bottom:
- In the title bar: destination name if you are using the Goto 

function
- Data Fields: customizable data fields (see Customize 

option on page 244). Some of the data displayed requires 
you to be moving to be computed. Invalid data is indi-
cated by dashes.

- Speedometer: Displays your speed using a familiar speed-
ometer display. The scale of the speedometer is not 
adjustable but will change dynamically to best display 
your speed.

- Trip Odometer: The odometer performs like the odometer 
in your car. It can be reset through the MENU button.
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Satellite Status screen
Satellite Status Screen
Although the Satellite Status screen is part of the navigation 
screen sequence, it is not actually a navigation screen.
When ProMark3 is computing your position, an additional in-
formation appears in the right-upper corner with two possible 
values: 3D or 2D. 3D means the computed position is 3-di-
mensional (elevation computed). In 2D (2-dimensional), ele-
vation is not computed. ProMark3 assumes that the last 
computed or entered elevation is the elevation for all comput-
ed positions.
 See also page 33.



List of POI categories
GOTO Function

Purpose
You use the GOTO function to ask ProMark3 to guide you from 
your current position to a destination point. You will be able 
to use this function only after launching the Surveying or Mo-
bileMapping application.
After you will have specified which destination point to go to, 
you will select your favorite navigation screen. You will then be 
able to read the information computed by ProMark3 to help 
you reach the destination.

Destination Point Types
ProMark3 can guide you to:
- Any point of interest (POI) pre-loaded in ProMark3.
- Any waypoint created using the Mark function. This type 

of point is listed as a “User Waypoint” category in the POI 
(Point Of Interest) database.

- The active background map (as set in the DetailMap field 
on the MENU>Setup>Select Map screen), which appears on 
top of the POI list (see oposite).

- Any feature logged in the open GIS job which you will 
select graphically on the Map screen.
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GOTO will not be shown in 
the menu list if you press 
MENU while the unit dis-

plays the Map screen in 
cursor mode. In that case, 

just press NAV and then 
MENU again.
Selecting a POI as the Destination Point
Press MENU and tap GOTO. The possible categories of POIs 
are now listed on the screen. Use the Up/Down arrow keys to 
highlight the category the destination point belongs to.
Before pressing ENTER to list all the points stored in this cat-
egory, choose how you want these points to be listed by setting 
the Find By field. Press the left/right arrow to set this field. Two 
values are possible in this field: 
- Alphabetical: Points will be listed in alphabetical order. 

ProMark3 will then help you find the desired point through 
one of the following two methods: Keyboard Search and 
Alphabetic Scroll.
Keyboard Search: Before displaying the list of points in 
alphabetical order, ProMark3 displays a keyboard that you 
can use to enter the first few characters of the point you 
are looking for. When you press ENTER, you are taken to 
the alphabetical list with the point you began typing at the 
top of the display. Anytime you are viewing the list of 
points, you can re-access the keyboard by pressing ESC.
Alphabetic Scroll: When the alphabetical list is displayed, 
you can use the IN and OUT buttons to step up or down 
the alphabet. If you were viewing points beginning with 
the letter “A”, pressing OUT would take you to the first 
waypoint beginning with “B”, and then “C” and so forth. 
Pressing IN does the same function but only in reverse.

- Nearest To: Only the 20 points from this category the clos-
est to either your position or another POI will be listed.



Selecting a GIS feature as 

the destination
When these 20 points are listed, ProMark3 indicates the bear-
ing and distance to your current position from the first point 
in the list. You can change the point from which the nearest 
points are found. With the Nearest To field now highlighted, 
press ENTER and scroll to the category where this new point 
can be found. Select a new point and press ENTER. If you 
have already pressed the arrow keys and one of the nearest 
points in the list is highlighted, use the ESC button to scroll 
back to the Nearest To field.

Selecting a GIS Feature as the Destination Point
Assuming a GIS job is open and contains already logged fea-
tures:
- Press NAV until the Map screen is displayed.
- Using the IN and OUT buttons, adjust the scale in such a 

way that you can see the feature you want to go to.
- Using the stylus, tap this feature. You know that the cursor 

is positioned over the feature when the “Cursor” indica-
tion at the bottom of the screen is replaced with the name 
of that feature. You may use the arrow keys to refine the 
position of the cursor over the feature.

- Press ENTER. A new screen appears giving the current 
description of the feature. At the bottom of the screen, 
simply tap Goto to enable the Goto function with this fea-
ture as your destination. Then select your favorite naviga-
tion screen, using the NAV button, and navigate to this 
feature.
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Mark screen

Select Item screen
Saving Your Current Position as a Waypoint
Saving your current position as a waypoint is very easy and can 
be done from within the Survey or GIS function.
From any screen, just press the MENU button, and select the 
Mark option. The Mark screen appears. This screen provides 
the description of the waypoint you are about to save.
You can accept all the defaults by simply pressing ENTER 
(Save field already highlighted).
You can also edit the Icon, Name and Message fields using the 
arrow keys to access these fields. Obviously you should keep 
the Location and Elevation fields unchanged as they contain 
the coordinates of your current location.
Waypoints recorded using the receiver's Mark feature are not 
exportable by MobileMapper Office. If you wish to record way-
points in the field and export them to GIS formats, you should 
use MobileMapper Office's Feature Library Editor to create a 
"Waypoint" feature type. You can then log a "waypoint" as a 
point feature while recording a job file.

Editing/Deleting a User Waypoint
You can edit/delete a waypoint from the Map screen:
- Press NAV until the Map screen is displayed
- Use the IN or OUT button, or move the cursor so that the 

waypoint you want to edit or delete is visible on the screen
- Position the cursor over that waypoint. The name of the 

waypoint then appears at the bottom of the screen.
- Press ENTER. This opens the Select Item screen on which 

ProMark3 lists the names of the items present in the 
vicinity.



Select Item screen
- Tap the waypoint you want to edit/delete. This opens the 
User Waypoint screen on which you can see the definition 
of the waypoint (coordinates+comments). At the bottom of 
the screen are three command fields that you can use for 
the following tasks:
Edit (default choice): Select this field if you want to edit 
the definition of the waypoint. The following parameters 
can be changed: icon, name, coordinates, elevation and 
comment.
Goto: Select this field if you want ProMark3 to guide you 
to this waypoint
Del: Select this field if you want to delete the waypoint. 
ProMark3 will then ask you to confirm that you really want 
to delete the selected waypoint.

Clearing the GOTO function
To ask ProMark3 to stop guiding you to a destination while the 
Map screen is displayed in position mode:
- Press MENU
- Tap GOTO. A message appears asking you to confirm that 

you would like ProMark3 to stop guiding you to this point.
- Tap Yes
- Press ESC to return to the Map screen.
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A GOTO route is a one-leg 
route whose two ends are 
your current position and 

the chosen destination 
point.

WPT1

WPT2
WPT3

WPT4

WPT5

WPT6
Routes

You will be able to use this function only after launching the 
Surveying or MobileMapping application.
As explained below, ProMark3 can handle two types of routes: 
GOTO route and multi-leg route.

GOTO Route
This in fact a route that you define when:
- You select a waypoint on the Map screen, you press 

ENTER twice to display the properties of this waypoint, 
and you tap GOTO to enable the Goto function to this way-
point . The same can be done to choose a POI or a GIS 
feature as the destination point.

- You use the GOTO option after pressing MENU and you 
choose a POI or waypoint as the destination point.

GOTO routes are not saved in memory. When you turn your 
ProMark3 off and then back on, the GOTO route is gone. You 
need to create a new GOTO route if you intend on completing 
the route.

Multi-leg Route
A multi-leg route consists of several waypoints or POIs that 
you should reach one after the other. The segment between 
any two consecutive waypoints or POIs is called a “leg.” Un-
like GOTO routes, multi-leg routes can be stored in memory.
The backtrack route also belongs to the category of multi-leg 
routes (see page 160).



Create Route screen

Route List screen
1. Creating a Multi-leg Route

- Press MENU and tap Routes. The Route List screen is now 
displayed.

- Tap the first Empty route in the list.
- Press MENU and tap Create New Rte. The Create Route 

screen is now displayed and the first line on this screen is 
highlighted.

- Press MENU and tap Insert WPT. The Insert WPT screen is 
now displayed.

- Press the Left or Right arrow to select Alphabetical at the 
bottom of the screen.

- Tap User Waypoint 
- Browse the list of available waypoints and tap the name of 

the waypoint you want to define as the first waypoint in 
the route. You are then prompted to define the second 
waypoint in the route.

- Resume the previous 4 steps to define the next waypoints 
in the route.

- When the last point of the route is defined, tap the Save 
Route button on the Create Route screen.

2. Activating/deactivating a Multi-Leg Route

- Press MENU and tap Routes.
- In the Route List screen now displayed, tap the route you 

want to activate.
- Press MENU and tap Activate Route. ProMark3 comes back 

to the Route List screen where the activated route now 
appears in bold characters. Press NAV to navigate along 
this route.

To deactivate this route:
- Press MENU and tap Routes, 
- Tap the activated route in the list
- Press MENU and tap Deactivate Route. The route is now 

deactivated.
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3. Asking ProMark3 to Retrace your Steps

If the Track Mode is active (see page 235), the ProMark3 au-
tomatically creates and stores hidden points into memory as 
you move. This series of points is called the “track” or “track 
history”. To retrace your steps, do the following:
- Press MENU and tap Routes.
- Select Backtrack.
- Press MENU again and tap Activate Backtrk. A message 

appears warning you that the Track History Logging is now 
disabled.

- Tap OK and press NAV to return to the Map screen. Now 
let ProMark3 guide you along the existing track, using the 
track’s hidden points as navigation waypoints, to go back 
to the track’s start point.

4. Creating a Route from the Track History

- Press MENU and tap Routes.
- Select Backtrack.
- Press MENU again and tap Save Trk to Rte. ProMark3 con-

verts the track’s hidden points into User Waypoints. The 
new route then appears on the Route List screen. It con-
sists of waypoints that are numbered “TxxPyy” (where xx 
is the route number in the list and yy is the order number 
of the waypoint in the route).
For example the created route could be named “T01P01 
.. T01P07”. 
Note that the the route is a copy of the track and not the 
backtrack.



5. Other Functions Tied to Routes

You can also do the following on the highlighted route using 
the functions available from the MENU button (see also dia-
gram on page 231):
- Viewing the route on the Map screen by pressing MENU 

and tapping Map View Route. The Map screen then appears 
showing the route. Press ESC to come back to the Route 
List screen.

- Editing the route by pressing MENU and tapping View/Edit 
Route. From the View/Edit screen you can then press the 
MENU button to access options allowing you to insert, 
delete, replace the highlighted waypoint and then to save 
the changes made to the route.

- Reversing the route, i.e. reversing the direction of travel 
along the route, by pressiong MENU and tapping Reverse 
Route. This instantly reverses the route. Note that the first 
and last waypoints in the route name have been swapped.

- Deleting the route by pressing MENU and tapping Delete 
Route. A message will appear asking you to confirm this 
operation.

- If a route has been activated, selecting the leg you want to 
follow by pressing MENU and tapping Select Leg. The 
screen then shows the list of points making up the route. 
Tap the waypoint you want to navigate to. A warning mes-
sage will appear asking you to confirm the leg change. 
After choosing Yes or No, press ESC twice to return to the 
navigation screen.
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9. Office Work

About Download Procedures

The easiest way to download ProMark3 data to your office 
computer is to remove the SD card from the ProMark3 and in-
sert it into the card reader on your computer. This implies the 
following:
1. You are using the SD card, and not the ProMark3 internal 

memory, to store all your data (see setting on page 31).
2. Your computer should be equipped with an SD card 

reader.

If you do not have a card reader on your computer, then you 
should connect the ProMark3 to your computer via the USB 
cable provided. You can also use COM1 available on the I/O 
module (Serial data cable not provided).
Note that the field data collected with the FAST Survey option 
can only be downloaded via the USB cable.
In this chapter, it is assumed that both GNSS Solutions and 
Mobile Mapper Office have already been installed on your 
computer.

About the Download Utility Program
Note the following about the Download Utility program:
1. When you ask use the Download utility to connect to the 

ProMark3 via the USB cable, using the File>Con-
nect>Receiver>Connect via Cable command, the following 
appears successively in the status bar -at the bottom of 
the Download window- before Download can list the files 
stored in the ProMark3:

Looking for remote on COMx at xxxx Baud...
Connected to Data Source
Setting Baud rate...
Preparing for listing...
Directory has been listed

2. The Download utility will always list the raw data files 
(R*.*) and vector files (O*.*) stored in the ProMark3’inter-
nal memory or SD card whatever the download context.



3. Raw data files (R*.*) are split into different files when 
downloaded. The files are named as follows: 
X<Downloaded_Filename> where X is:
- “E” for Ephemeris data files
- “B” for Position Data files
- “D” for GPS Raw Data files
- “W” for SBAS data files.

4. Unlike raw data files, vector files (O*.*), resulting from a 
real-time TRTK survey, are kept unchanged when down-
loaded.

5. If you use a card reader, the warning message “There is no 
measurements and navigation data file in this session.” 
will normally pop up every time you download a vector file 
(O*.*).

Using the USB Port to Download Data
1. Clip the I/O module as shown opposite.
2. Turn on the ProMark3.
3. Connect the USB cable between the ProMark3 unit and 

your office computer.

The first time you connect ProMark3 to the office 
computer, you may be asked to install a USB driver on the 
computer (although this driver should normally have been 
installed when installing GNSS Solutions). This driver is 
located on the GNSS Solutions CD in the “.../USB Driver/
PROMARK/” folder. Once you have inserted the CD in your 
CD drive, ask the computer to search for this driver on the 
installation CD and then follow the on-screen instructions 
to complete the driver installation.
With the USB driver properly installed, the Download util-
ity program will make a “USB..” port available for connec-
tion to ProMark3.
If the USB connection fails, disconnect the USB cable 
and plug it back. According to context, quit Download or 
MobileMapper Transfer on the computer and restart it, or 
with FAST Survey, quit Data Transfer on the ProMark3 
RTK and re-start it.
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Do not forget to double-tap 
the Surveying icon or else 

no communication will be 
possible between ProMark3 

and the computer. 

Please connect the 
ProMark3 to the computer 

BEFORE running Down-
load.
Processing Field Data Collected With “Surveying”

Downloading Raw Data via USB
See also About Download Procedures on page 162 before fol-
lowing the instructions below.

1. On ProMark3:
- Clip the I/O module to the back of the ProMark3.

- Connect the USB cable between the ProMark3 and 
your office computer.

- Turn on the receiver.
- Double-tap the Surveying icon.
- Make sure the ProMark3 Storage option setting will 

allow the Download utility to access the desired files. 
For example, if the files to be downloaded are on the 
SD Card, make sure SD Card is selected as the Storage 
option. To set this information, press the MENU key 
then select Setup then Storage.

2. On the PC:
- From the Windows task bar, select Start>Pro-

grams>GNSS Solutions>Tools>Download.

(Double-click  in the right side of the window if 
you want to access the parent directory and open 
another folder on your PC.)

- In the Download window, select File>Con-
nect>Receiver>Connect via Cable. This opens the Con-
nect Via Cable dialog.

- In this dialog, choose the “USB..” port created on the 
PC following the installation of the USB driver and 
then click OK. The left side of the Download window 
then lists the files stored in the ProMark3.

- Select the files you want to download. If necessary, 
hold down the Ctrl key to make a multiple selection.

- Press the F5 key. A Copying file dialog appears during 
data transfer.

- Close the Download window.



3. On ProMark3, quit the Surveying function, turn off the 
receiver and remove the cable between the PC and 
ProMark3.

4. Repeat the previous five steps for each of the ProMark3 
units involved in the project to download their respective 
files to the same project folder on your office computer.

Downloading Raw Data from the Card Reader
- Extract the SD card from the ProMark3 and insert it into 

the local SD card reader of your office computer.
- From the Windows task bar, select Start>Programs>GNSS 

Solutions>Tools>Download.

- (Double-click  in the right side of the window if you 
want to change to the parent directory and open your 
project folder on the PC.)

- In the Download window, select File>Connect>PC drive. As a 
result, the left side of the window shows the file structure 
of your computer.

- On top of the left side of the window, click on the down 
arrow and select the letter corresponding to your local SD 
card reader (for example “G:”). You can now see the field 
data files stored on the SD card.

- In the left side of the window, select the files you want to 
download. If necessary, hold down the Ctrl key to make a 
multiple selection.

- Press the F5 key or drag and drop the selected files from 
the left to the right side of the window. A Copying file dia-
log appears during data transfer.
As explained on page 164, each downloaded file is split 
into different files with different prefixes. These files can 
be seen in the right side of the window once the down-
loading is complete.

- Close the Download window.

Downloading RTK Data Via USB
See Using the USB Port to Download Data on page 163 before 
following the instructions below.
1. On ProMark3:

- Clip the I/O module to the back of the ProMark3.
- Connect the USB cable between the ProMark3 and 

your office computer.
165



166

Do not forget to double-tap 
the Surveying icon or else 
no communication will be 

possible between ProMark3 
and the computer. 
- Turn on the receiver.
- Double-tap the Surveying icon.
- Make sure the ProMark3 Storage option setting will 

allow the Download utility to access the desired files. 
For example, if the files to be downloaded are on the 
SD Card, make sure SD Card is selected as the Storage 
option. To set this information, press the MENU key 
then select Setup then Storage.

2. On the PC:
- Run GNSS Solutions and open or create the project in 

which to download your RTK results.
- In GNSS Solutions, select Tools>Preferences and make 

sure Show RTK functions is enabled, otherwise check it 
and then click OK.

- Select Project>Download Positions from External Device.
- Select ProMark3 Surveying and click OK. This launches 

the Download Utility on the computer. The right side of 
the Download window lists the content of the folder 
corresponding to the open GNSS Solutions project.

- On the menu bar, select File>Connect>Receiver>Connect 
via Cable.

- On the Select Port tab, select the “USB...” option and 
click OK. The left side of the Download window now 
lists the files stored in the ProMark3 RTK.

- Select the O-files you want to download
- Press the F5 key to start the file transfer.
- When the transfer is complete, close the Download 

window. This causes GNSS Solutions to import the 
vector data into the open project.
If names of imported points already exist in the 
project, GNSS Solutions will ask you whether you want 
to overwrite them or not. If you choose “Yes”, the 
points in the project will be overwritten. If you choose 
“No”, new points will be created with the “~1” suffix 
(e.g. “A001” is the point in the project and “A001~1” 
is the created point). After answering all these ques-
tions, the imported points and vectors will be seen in 
the open GNSS Sollutions project.



Donwloading RTK Data from the Card Reader
- Extract the SD card from the ProMark3 and insert it into 

the local SD card reader of your office computer.
- Run GNSS Solutions and open or create the project in 

which to download your RTK results.
- In GNSS Solutions, select Tools>Preferences and make 

sure Show RTK functions is enabled, otherwise check it and 
then click OK.

- Select Project>Download Positions from External Device.
- Select ProMark3 Surveying and click OK. This launches the 

Download Utility on the PC.
- On the menu bar, select File>Connect>PC Drive.
- In the combo box located in the upper left corner of the 

Download window, just underneath the menu bar, select 
the drive corresponding to the local card reader. The left-
hand part of the Download window now lists the files 
stored on the SD card.

- Select the O-files you want to download
- Press the F5 key to start the file transfer.
- When the transfer is complete, close the Download win-

dow. This causes GNSS Solutions to import the vector 
data into the open project.
If names of imported points already exist in the project, 
GNSS Solutions will ask you whether you want to overwrite 
them or not. If you choose “Yes”, the points in the project 
will be overwritten. If you choose “No”, new points will be 
created with the “~1” suffix (e.g. “A001” is the point in 
the project and “A001~1” is the created point). After 
answering all these questions, the imported points and 
vectors will be seen in the open GNSS Sollutions project.
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Post-Processing Raw Data
1. On your office computer, launch GNSS Solutions
2. Click Create a New Project, enter a project name and then 

click OK.
3. Click Import Raw Data from Files.
4. Browse your computer to change to the folder containing 

the data files you have just downloaded.
5. Select the files you want to import and click Open. The 

Importing GPS Data dialog lists the files you want to import 
(top). Each row describes one of these files (filename, 
associated Site ID, etc.)

6. At the bottom of the window, define which of the sites is 
the control point (base) and enter or check its known coor-
dinates. You can also fix the control point if necessary by 
selecting one of the options available in the Fixed column. 
If you select <Blank>, the point won’t be fixed.

7. Click OK>To Import to import the data into the project. 
Depending on the type of survey, you can go even faster by 
running, in one operation, the Import, Process and Adjust 
functions.



Downloading RTK Data Collected With FAST Survey

NOTE: Use exclusively the USB cable to download the RTK 
data collected with FAST Survey.
See About Download Procedures on page 162 before follow-
ing the instructions below.
1. On the ProMark3 RTK:

- Clip the I/O module as shown opposite.
- Turn on the ProMark3 RTK.
- Connect the USB cable between the ProMark3 unit 

and your PC.
- Double-tap the FAST Survey icon.
- Select File>6. Data Transfer. This opens the Data Trans-

fer window.
- At the bottom of this window, select “USB (COMx)” 

from the COM Port combo box.
- Tap the SurvCom Transfer button. This opens the File 

Transfer window.
2. On the PC:

- Run GNSS Solutions and open or create the project in 
which to download your RTK results.

- In GNSS Solutions, select Tools>Preferences and make 
sure Show RTK functions is enabled otherwise check it 
and then click OK.

- From the menu bar, select Project>Download Positions 
from External Device.

- In the dialog that opens, select RTK Results in the left 
pane and then FAST Survey data collector in the right 
pane.

- Click OK. This opens the Data Transfer dialog box.
- Select the PC port connected to the ProMark3 RTK 

(USBx) and then click OK. After a couple of seconds, a 
new dialog appears listing the .crd job files stored in 
the ProMark3 RTK.

- Click on the job you want to download. The name of 
the selected job appears in the upper field.

- Click OK. The job is then downloaded to the project 
open in GNSS Solutions. On the PC, a job folder is 
created in the open project folder to store all the 
downloaded files.
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Do not forget to double-tap 
the Mobile Mapping icon or 

else no communication will 
be possible between 

ProMark3 and the com-

puter. 

Please connect the 

ProMark3 to the computer 
BEFORE running Down-

load.
If the coordinate system used in the GNSS Solutions 
project is different from that used in the ProMark3 
RTK job, a warning message will pop up asking you to 
choose which system to use in the GNSS Solutions 
project. The Edit button allows you to edit the proper-
ties of the selected system. Click GO after you’ve made 
your choice.
At the end of the transfer, the job results can be seen 
on the project’s Survey view.

Processing Field Data Collected With “Mobile Mapping”

Downloading GIS Data via USB
See also About Download Procedures on page 162 before fol-
lowing the instructions below.

1. On ProMark3:
- Clip the I/O module to the back of the ProMark3.

- Connect the USB cable between the ProMark3 and 
your office computer.

- Turn on the receiver.
- Double-tap the Mobile Mapping icon.
- Make sure the ProMark3 Storage option setting will 

allow the Download utility to access the desired files. 
For example, if the files to be downloaded are on the 
SD Card, make sure SD Card is selected as the Storage 
option. To set this information, press the MENU key 
then select Setup then Storage.

2. On the PC:
- From the Windows task bar, select Start>Pro-

grams>MobileMapper Office>MobileMapper Transfer.

(Double-click  in the right side of the window if 
you want to access the parent directory and open 
another folder on your PC.)

- In the MobileMapper Transfer window, select File>Con-
nect>GPS Device via Cable. After a few seconds, the left 
side of the MobileMapper Transfer window lists the 
files stored in the ProMark3.



- Select the MMJ files you want to download. If neces-
sary, hold down the Ctrl key to make a multiple selec-
tion.

- Press the F5 key. A Copying file dialog appears during 
data transfer.

- Close the MobileMapper Transfer window.

3. On ProMark3, quit the MobileMapping function, turn off 
the receiver and remove the cable between the PC and 
ProMark3.

Downloading GIS Data from the Card Reader
- Extract the SD card from the ProMark3 and insert it into 

your local SC card reader.
- From the Windows task bar, select Start>Pro-

grams>MobileMapper Office>MobileMapper Transfer.

- (Double-click  in the right side of the window if you 
want to change to the parent directory and open your job 
folder on the PC.)

- In the MobileMapper Transfer window, select File>Con-
nect>PC drive. As a result, the left side of the window 
shows the file structure of your PC.

- On top of the left side of the window, click on the down 
arrow and select the letter corresponding to your local SD 
card reader (for example “G:”). You can now see the field 
data files stored on the SD card.

- In the left side of the window, select the MMJ files you 
want to download. If necessary, hold down the Ctrl key to 
make a multiple selection.

- Press the F5 key or drag and drop the selected files from 
the left to the right side of the window. A Copying file dia-
log appears during data transfer.

- Close the MobileMapping Transfer window once the down-
loading is complete.
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Viewing/Analyzing the Content of a Job
Run MobileMapper Office and then use the File>Open com-
mand to open one of the MMJ files you have previously down-
loaded. As a result, MobileMapper Office shows the content of 
this job in the main window. Here is an example of a job open 
in MobileMapper Office:

First of all, you can see the list of layers present in this job in 
the lower-right corner of the screen. Clear or check the buttons 
for the layers you want to see in the Map Display area (the 
pane occupying the left part of the window).



The main purpose of viewing a job in MobileMapper Office is 
to get a view of the features that were logged during field op-
erations. If enabled for display, these features are represented 
on the Map Display area according to the viewing choices 
made for the corresponding layers. You can do more than just 
view these features. You can also view the conditions in which 
these features were logged. To do that, just click on these fea-
tures, one after the other in the Map Display area. This opens 
a new window in which you can see the properties of these fea-
tures. In the example below, MobileMapper Office shows the 
properties of the selected point being part of an area feature:
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The Feature Properties window provides the following infor-
mation:
• Feature name and geometry, number of points for lines 

and areas only, measurement(s), user-settable Updated 
field. Apart from the Updated field, these are non-editable 
properties.
The nature of the measurements performed is presented 
below:

Length: MobileMapper Office determines the length of 
a line feature in the same way used by the receiver: by 
estimating the distance between successive points on 
the line feature with the assumption that each point is 
on a sphere of average Earth radius. The elevations of 
the points are not factored into the equation. Thus the 
software calculates the spherical distance rather than 
the horizontal or slope distance between the succes-
sive positions. The length of the line feature is the sum 
of all these distances..
Perimeter: MobileMapper Office estimates the perime-
ter of an area feature in the same way it estimates the 
length of line features.
Area of area features: MobileMapper Office determines 
areas by estimating the area enclosed within point 
locations recorded in the field with the assumption 
that each point making up the feature is on a sphere of 
average Earth radius. Thus the area is that of a curved, 
not flat, feature.

• Observation data (non-editable): date/time, duration of 
point logging.

• Current Position for the selected point (non-editable): lati-
tude, longitude, altitude, number of satellites used, PDOP 
and correction type.



Direction of 
travel along 
the feature

Feature offset to the 
left by distance d

d

“Real” feature
The correction type may be one of the following:
- “WAAS”
-  “RTCM”
-  “Post-processed”
-  “Uncorrected” (for autonomous positions)

• Accuracy Estimation for the selected point: horizontal 
error, vertical error (non-editable).

• Offset data (editable): direction (for line or area) or bear-
ing (for point), horizontal distance, vertical distance.
This set of properties can be used to artificially move the 
receiver’s GPS antenna by a certain distance from the real 
position it occupied in the field.
For example, if the receiver  was held at 5 feet (1.52 m) 
from the ground, you can enter “-1.52” m in the vertical 
distance cell to artificially bring the GPS antenna position 
down to ground level.
Likewise, you can offset a line or area feature to the right 
or left by a certain distance that you enter in the horizon-
tal distance cell. The Left and Right directions for the off-
set are defined with respect to the direction followed by 
the field operator along the feature while logging this fea-
ture (see example opposite).

• Attributes (editable): list of attributes and values currently 
assigned to these attributes. You can freely change these 
values or enter new ones if blank.

There are many other functions that you can use in Mo-
bileMapper Office such as creating feature libraries or back-
ground maps, importing/exporting GIS data, downloading 
reference station data, post-processing jobs, etc. Please refer 
to the MobileMapper Office User Manual for more informa-
tion.
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Exporting Data to a GIS
The most important processing of your field data is its export 
to a GIS. Exporting field data has two processes: conversion 
of the data files to a standard format a GIS can read and then 
the actual transfer of the file.
1. On your office computer, launch MobileMapper Office
2. From the menu bar, select File>Open
3. Select the folder where you downloaded your files. 
4. Select the MMJ file you want to open and then click Open. 

MobileMapper Office now views the data collected in the 
field.

5. From the menu bar, select File>Export.
6. Select one of the formats displayed and you will see a 

“Browse for Folder” window that allows you to select the 
directory to which the reformatted file will be transferred. 
If you don't know where to put this file, just select a tem-
porary location.

7. Click Export. Your job will be automatically formatted and 
transferred to the selected folder. You can select any 
folder that is accessible by your PC - including any GIS 
folders that may be on your network. When you start 
recording real data to export to a GIS, you will typically 
export data to a GIS database.



Upload Procedures from GNSS Solutions

Uploading a Real-Time “Surveying” Job
See Uploading Points to ProMark3 on page 181. Uploading a 
real-time job, later run with “Surveying”, amounts to upload-
ing the control points and/or target points you will need to per-
form this job in the field.

Uploading a FAST Survey Job
NOTE: Only through the USB cable can you upload a FAST 
Survey job to ProMark3 RTK.
1. On the ProMark3 RTK:

- Clip the I/O module as shown opposite.
- Turn on the ProMark3 RTK.
- Connect the USB cable between the ProMark3 unit 

and your PC.
- Double-tap the FAST Survey icon.
- Select File>6. Data Transfer. This opens the Data Trans-

fer window.
- At the bottom of this window, select “USB (COMx)” 

from the COM Port combo box.
- Tap the SurvCom Transfer button. This opens the File 

Transfer window.
2. On the PC:

- Run GNSS Solutions and open or create the project 
containing the job you want to upload to ProMark3 
RTK. At this stage, you can make a pre-selection of all 
the points making up the job.

- In GNSS Solutions, select Tools>Preferences and make 
sure Show RTK functions is enabled otherwise check it 
and then click OK.

- From the menu bar, select Project>Upload Positions to 
External Device.

- In the dialog that opens, select RTK Job in the left 
pane and then FAST Survey data collector in the right 
pane.
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- Click OK. This opens the Upload Job dialog box.

- Define the content of the job you want to upload by 
enabling one of the buttons in the upper-left corner. If 
you have previously made a pre-selection of points in 
the project, the first option will be automatically 
selected.

- Name the job if the default name is inappropriate (the 
default name is derived from the open GNSS Solutions 
project name).
The dialog box also indicates the folder where the job 
files will be created before effective transfer to the 
ProMark3 RTK (default folder: <Open_project_folder>/
job/). The following files will be created:

•  <job_name>.CRD
• <job_name>.FCL
• <job_name>.INF
• <job_name>.SCB
• <job_name>.SYS

- Check or clear the Write feature code list file as well 
option depending on whether you want to make this 
list available to the field operator or not.

- Click OK. This opens the Data Transfer window.
- Select the PC port connected to the ProMark3 RTK 

(USBx) and then click OK. The job is then uploaded to 
ProMark3 RTK.

- When the transfer is complete, close the File Transfer 
window on the ProMark3 RTK.



Uploading a Vector Background Map
Background maps are imported into GNSS Solutions projects  
either from DXF, SHP or MIF files (for vector maps) or BMP, 
JPG, JPEG2000 or non-compressed TIFF files (for raster 
maps).
You can upload a combination of several vector maps and sev-
eral raster maps through a single upload operation.
Raster maps will keep their original names (truncated to 8 
characters if necessary) throughout the upload procedure.
Unlike raster maps, vector maps will need to be renamed be-
fore running the upload procedure. If you want to upload sev-
eral vector maps at the same time, then GNSS Solutions will 
merge them into a single vector map and will name it with the 
name you provide.
Before uploading background maps, choose the storage medi-
um on ProMark3 where you would like the background maps 
to be stored.
Map files stored in the ProMark3 will be overwritten without 
notice if you upload new maps with the same name.
Assuming the ProMark3 unit is connected to the PC via the 
USB cable, it has been turned on and you have double-tapped 
the Surveying icon, do the following on PC side:
- Launch GNSS Solutions and then open the project con-

taining the background maps you want to upload to 
ProMark3.

- In the Command pane on the left, click the Map topic bar 
and then the Upload Maps to External Device icon. GNSS 
Solutions then automatically detects the presence of the 
ProMark3 on the USB port and also lists the project maps 
present in the open GNSS Solutions project (see screen 
below left).
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- Check on the maps you want to upload. You can select 
several vector maps and several raster maps. After you’ve 
checked on your vector maps, please name the vector map 
that will result from the merging of all these maps (see 
screen above right).

- Click OK. The following messages will appear in succes-
sion during the upload procedure:

Preparing data..
Creating data
Creating output image file...
Connecting... USBx
Uploading to GPS

While the last message above is displayed, messages on 
the ProMark3 screen informs you that the <map 
name>.imi file and then the <map_name>.tif file are 
being uploaded.

- When the file transfer is complete, press MENU, tap Setup 
and then Select Map.

- Tap in the Detail Map field and then select the name of the 
IMI file you have just uploaded.

- Tap in the Raster Map field and then select the name of the 
TIF file you have just uploaded.

- Tap Save. ProMark3 starts loading the new maps. After a 
while, the Map screen is displayed.

- Use the IN, OUT and scrolling buttons to get a full view of 
the new maps on the Map screen. Only the rectangular 
limits of the maps will appear if you zoom out too much.



Please read the “Point 
Properties” section in 

GNSS Solutions Refer-
ence Manual , Chapter 5 to 

know more about point 
types.
Uploading Points to ProMark3
GNSS Solutions lets you upload control points, reference 
points and target points to ProMark3. Points will always be 
uploaded to the ProMark3 internal memory, whatever the stor-
age setting (internal memory or SD card).
All points uploaded to ProMark3 are always seen as waypoints 
in the ProMark3, regardless of their original types. In addition, 
they can also be seen as control points if you ask GNSS Solu-
tions to do so.
Finally, you can choose whether the points you upload will add 
up to the list of existing waypoints or will replace this list (at 
one step before the uploading, you will have to check or clear 
the Erase existing waypoints option).
In ProMark3, waypoints can only be used for navigation, and 
more particularly through the GOTO function. Unlike the list 
of waypoints, the list of control points can be used at different 
levels:
- When setting a ProMark3 RTK base station, you can 

access the list of control points to choose the point where 
the base station is installed. By selecting this point, you 
quickly define the position of the base without having to 
enter its coordinates.

- When initializing a ProMark3 RTK rover on a known point, 
selecting “Known” as the RTK Initialization option gives 
access to the list of control points from which you can 
select the point where RTK initialization is to take place.

- Running a Stakeout survey with the ProMark3 RTK opens 
the list of control points from which you can choose the 
point you want to stake out. It is therefore essential that 
you upload your target points as waypoints AND control 
points so you can select them as targets when you run 
your stakeout survey.

- In a ProMark3, or in a ProMark3 RTK used in Post-Pro-
cessing receiver mode, selecting “Known” as the Initialize 
method in a Stop&Go or Kinematic survey opens the list of 
control points from which you can choose the point where 
initialization is performed.
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Ctrl Wpt

Ctrl
On the map screen, uploaded control points (Ctrl) will appear 
as small yellow triangles whereas uploaded waypoints (Wpt), 
as well as those created with the internal Mark function, will 
appear as yellow squares (see opposite). Note that any upload-
ed control point is also available as a waypoint and so can be 
selected from the list of user waypoints.
NOTE: Control points logged during a post-processing survey 
performed in Static or Stop&Go mode will be represented on 
the map screen as black rhombs (see opposite).
The names of the uploaded points will be truncated to 4 char-
acters for control points and 8 characters for waypoints. Con-
sequently, make sure the points you select will keep different 
names after truncation or rename those points that would oth-
erwise have similar names after truncation.

Assuming the ProMark3 unit is connected to the PC via USB 
(or RS232), it has been turned on and you have double-
tapped the Surveying icon, do the following on PC side:
- Launch GNSS Solutions and then open the project con-

taining the control, reference and target points you want 
to upload to ProMark3.

- Select the points you want to upload (select them on the 
Survey View or on the Points tab in the workbook).

- In the Command pane on the left, click the Export topic 
bar and then the Upload Positions to External Device icon. In 
the new dialog that opens (see below), select one of the 
following two options:
• Points (as wpts & ctrl pts) if the uploaded points will be 

used for RTK initialization, base position or stakeout 
points (and possibly navigation).

• Points (as wpts only) if the uploaded points will be used 
for navigation only.



- Click OK. GNSS Solutions then automatically detects the 
presence of the ProMark3 on the USB port.

- In the dialog that opens, make the appropriate selections 
for each point type (None/Selected/Remaining/All), choose 
the right port (USBx) to communicate with ProMark3 and 
choose to delete the existing ProMark3 waypoints or not. 
See screen example below).

- Click OK. The following messages appear in succession 
during the point upload process:

Connecting... USBx
Uploading control points and 
waypoints...

- The points you have uploaded can now be seen on the 
ProMark3 using the following procedures. To view the list 
of waypoints:
• Press MENU and tap GOTO
• Tap User Waypoint, then Position. The list of available 

user waypoints now appears in which you can recog-
nize the points you have just uploaded.

To view the list of control points with a ProMark3 RTK with 
the Real-time Receiver mode ON:
• Press MENU and tap Initialize RTK
• Select Known Point. The list of available control points 

now appears in which you can recognize the points you 
have just uploaded.
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To view the list of control points with a ProMark3 or a 
ProMark3 RTK with the Post-processing Receiver mode 
ON:
• Press LOG
• Select Stop-and-go or Kinematic as the Survey Mode
• In the Initialize field, select Known. The list of available 

control points now appears in which you can recognize 
the points you have just uploaded.

Uploading a Geoid to ProMark3
GNSS Solutions’ Geoids utility allows you to generate geo-
graphical sections of geoid models. The available geoid mod-
els include 30SJULY, Alaska99, DVR90, EGM96, Geoid03, 
Geoid99, GGF97, GGR99, GSD95, Hawaii99, hBG03, HT1, 
HT2, NAP, NAP2004, NorthSea, OSGM02, PRVI99, RAF98 
and Swen01l.
To upload a section of a geoid model to ProMark3 RTK, follow 
the instructions below. The upload procedure will create a 
GSF file, which will be uploaded to \MyDevice\FAST Sur-
vey\Data\ folder in the ProMark3 RTK.
- Clip the I/O module to the back of the ProMark3.
- Connect the USB cable between the ProMark3 and your 

office computer.
- Turn on the ProMark3.
- Run FAST Survey and open the job in which you want to 

use the new geoid.
- Tap on the File tab and run Data Transfer.
- Tap on the SurvCom Transfer button.
- On your office computer, run Geoids (Start>Programs>GNSS 

Solutions>Tools>Geoids)
- Open the desired geoid model (File>Open).
- Select Transfer>Write.
- Select FAST Survey Data collector in the upper field.
- If appropriate, create a geographical section from the 

open geoid model using the world map button to define 
the rectangular limits of the section or entering the coordi-
nates of the two points defining the NW-SE diagonal of the 
section.

- Click OK.
- In the Data Transfer window, select the PC port connected 

to the ProMark3 (USBx or COM1) and click OK. Wait until 
the file transfer is complete.



To use the new geoid in the job: 
- Tap Cancel to close the Data Transfer window.
- Select File>Job Settings.
- Tap on the GPS tab
- Tap on the Geoid Separation File: button. A new dialog lists 

the files stored in the ... \FAST Survey\Data folder.
- Select “GSF Files” in the Type field. The list now shows 

the file you have just uploaded.
- Select it and tap OK. The name of the geoid file used in 

the job is now displayed underneath the Geoid Separation 
File: button.

Upload Procedures from MobileMapper Office

Uploading a Vector Background Map
Vector background maps are generated from DXF, SHP or MIF 
files imported in MobileMapper Office’s Map Editor.
Note that raster background maps CANNOT be uploaded to 
ProMark3 in its current version.
It is all or part of the background map attached to MobileMap-
per Office’s Map Display area that can be uploaded.
The background map is output as an IMI file. The IMI file can 
be directly uploaded to the ProMark3, or copied to the SD 
card inserted in the local SD card reader, or stored on the PC 
hard disk. In all cases, a connection to the ProMark3 is a pre-
requisite to the upload sequence.
Assuming the ProMark3 unit has been connected to the PC via 
the USB or RS232 cable, it has been turned on, you have dou-
ble-tapped the Mobile Mapping icon and you have selected the 
storage medium on which to upload the map, do the following 
on PC side:
- Launch MobileMapper Office.

To attach the desired vector map to the Map Display area:

- Click 
- On the Vector Maps tab, select this map from the left-hand 

list and then click the Attach Map button.
- Click OK to close the window.
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If you want to upload only a region of the background map:

- Click 
- Drag a rectangle around the desired region and then 

release the mouse button.
The limits of the region are now represented with a rectan-
gle. You can still resize or reshape the rectangle by drag-
ging its control points (corner and mid-side points). You 
can also move the whole rectangle by dragging the mouse 
cursor from inside the rectangle.

- When the location and size of the region is okay, click out-
side of this region.The region is now defined and its limits 
are represented by a thick green line.
NOTE: To delete the region and start over, resume the 
above three steps.

Start the upload procedure as such by selecting File>Upload to 
GPS>Background Map. MobileMapper Office tests the connec-
tion to the ProMark3 (the software needs to know which type 
of receiver the map is intended for). Once the data link is es-
tablished, you can make one of the following three choices:

• Upload to GPS Unit if you want to upload the map 
directly to the ProMark3.

• Upload to SD Card Reader if you simply want to copy 
the background map to the SD card inserted in the 
local SD Card Reader (you will use that SD card later 
in a ProMark3).

• Or Store on Hard Drive if you just want to create now 
the IMI file on your hard disk so that later you can 
copy it to an SD card using the local SD card reader.

1. If you select Upload to GPS Unit, then:
• Click Next >
• After the GPS unit has been detected on the USB or 

RS232 port, click Next > again.
• MobileMapper Office indicates the size of the map 

file and the remaining memory space on ProMark3. 
Click Finish.



• If the map filename uses more than 8 characters, 
MobileMapper Office will  warn you that this name 
will be truncated. Keep the truncated name or type a 
different name and then click OK.

• Wait until the uploading messages on the PC and 
ProMark3 disappear.

• When the upload procedure is complete, press 
MENU on the ProMark3, tap Setup and then Select 
Map.

• Tap in the Detail Map field and then select the name 
of the file you have just uploaded

• Tap Save. ProMark3 starts loading the new map. 
After a while, the Map screen is displayed. 

• Use the IN, OUT and scrolling buttons to get a full 
view of the new map on the Map screen.

2. If you select Upload to SD Card Reader, then:
• Click Next >.
• Select the drive letter corresponding to the local SD 

card reader (e.g. “G:”)
• Click Next > again. MobileMapper Office indicates 

the size of the map vs. the remaining memory space 
on the SD card and the name of the background 
map file.

• Click Finish if you agree. The background map file is 
transferred to the SD card.

3. If you select Store on Hard Drive:
• Click Next >. MobileMapper Office indicates the size 

of the map vs. the remaining memory space on the 
hard disk, the folder where the file will be saved and 
the name of the background map file.

• Click Finish if you agree. The background map file is 
saved on the hard disk.
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To create a waypoint 
in a job:

Click on  in the 
MobileMapper Office tool-

bar and then click where to 
create the waypoint on the 

Map Display area. If neces-
sary, adjust its coordinates, 

icon and name in the edit 
box on the right.

For more detail, please 
refer to the Using the Way-
point/Route Editor Chapter 
in the MobileMapper Office 

User Manual.
Uploading Jobs and Waypoints to ProMark3
Jobs and waypoints associated with jobs are uploaded through 
the same procedure.
The way waypoints are uploaded and made available on the 
ProMark3 depends on whether the uploaded job is “empty” 
(i.e. there is no GIS data in it, just waypoints) or not:
- If the job is “empty”, the uploaded waypoints will replace 

the list of existing waypoints stored in the ProMark3. Prior 
to uploading, a message will warn you that the waypoints 
currently stored in ProMark3 will be deleted.

- If the job is not “empty” (i.e. it contains GIS data), way-
points are uploaded as a separate MMW file associated 
with the MMJ job file. On ProMark3, these waypoints will 
be visible only when you open the corresponding job. 
These waypoints will add up to the list of existing way-
points.

Assuming the ProMark3 unit is connected to the PC via the 
USB or RS232 cable, it has been turned on and you have dou-
ble-tapped the Mobile Mapping icon, do the following on PC 
side:
- Launch MobileMapper Office.
- Open the MMJ job file you want to upload

- Click  to read the list of waypoints associated with the 
job. If you change the list, save the job before continuing.

- Select File>Upload to GPS>Job.
• If the job is “empty”, a message will warn you that all 

waypoints currently stored in the ProMark3 will be lost 
if you continue. Click Yes if  you agree and then wait 
until the upload procedure is complete.

• If the job is not “empty”, MobileMapper Office will 
successively upload the MMJ file and then the MMW 
file.



Uploading Jobs and Waypoints to the Local SD 
Card Reader
If you are using the SD card in the field rather than the 
ProMark3’s internal memory, you can also copy your MMJ and 
MMW files to the SD card using the MobileMapper Transfer 
utility and your local SD card reader.
- Extract the SD card from the ProMark3 and insert it into 

your local SC card reader.
- From the Windows task bar, select Start>Pro-

grams>MobileMapper Office>MobileMapper Transfer.

- (Double-click  in the right side of the window to 
access the folder containing the MMJ and MMW files you 
want to upload.)

- In the MobileMapper Transfer window, select File>Con-
nect>PC drive. As a result, the left side of the window 
shows the file structure of your PC.

- On top of the left side of the window, click on the down 
arrow and select the letter corresponding to your local SD 
card reader (for example “G:”). You can now see the field 
data files stored on the SD card.

- In the right side of the window, select the MMJ and MMW 
files you want to upload. If necessary, hold down the Ctrl 
key to make a multiple selection.

- Press the F5 key or drag and drop the selected files from 
the right to the left side of the window. A Copying file dia-
log appears during data transfer.

- Close the MobileMapper Transfer window once the upload-
ing is complete.
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10.Bluetooth Manager Module

This chapter gives general information on ProMark3’s Blue-
tooth Manager module. For detailed information on how you 
can establish a GPRS connection via Bluetooth Manager, 
please refer to Step-by-Step Procedure for Establishing a 
GPRS Connection Via Bluetooth on page 198.

Introduction

ProMark3 is equipped with built-in Bluetooth technology that 
allows short-range connections to other Bluetooth-enabled de-
vices such as cellular phones, personal digital assistants 
(PDA), desktop or notebook computers.
Bluetooth offers fast, reliable, and secure wireless communi-
cation. 

Host and Inquiring Devices

In any communication between two Bluetooth-enabled devic-
es, one of them is the inquiring device and the other the host 
device:
• The inquiring device is the one that detects and uses one 

of the local services of the other device.
• Reciprocally, the host device is the one that is discovera-

ble and that makes its local services available for the 
inquiring device.

Here is a typical example in which ProMark3 is the inquiring 
device. When you operate ProMark3 RTK in NTRIP or Direct 
IP DGPS mode, the cell phone used is the host device and 
ProMark3 RTK is the inquiring device. The local service used 
in the cell phone is the Dial-Up Networking service.



Bluetooth Range

The maximum range in class 2 devices is 10 meters (30 feet) 
typically. A minimum distance of about 60 cm (two feet) 
should be observed between any two Bluetooth-enabled devic-
es.

First Steps with Bluetooth Manager

Starting Bluetooth Manager
- Double-tap the Bluetooth Manager icon located on the 

ProMark3 workspace or in the Settings folder. The Blue-
tooth window appears on the screen after a few seconds.
For a quick overview of the functions accessible from the 
Bluetooth Manager toolbar, please refer to the table in 
Bluetooth Manager Toolbar Memo on page 197.

Minimizing/Maximizing the Bluetooth Window

- Tap  in the upper-right corner. This minimizes the Blue-
tooth window (but Bluetooth is still running).

- To re-open the Bluetooth window, double-tap the Bluetooth 
Manager icon located on the ProMark3 workspace or in the 
Settings folder.

Turning Off Bluetooth
- You can only turn off Bluetooth Manager by turning off 

ProMark3.

Detecting Bluetooth-Enabled Devices
Use the following two buttons to let ProMark3’s local Blue-
tooth controller detect the Bluetooth-Enabled devices present 
nearby:
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- Tap  the first time you run a search. The message 
“Searching...” is displayed in the status bar (bottom of the 
screen) during the search.
The search sequence first focuses on paired peripherals 
and then searches for distant peripherals. “Ready” is dis-
played at the end of the search. When next tapping this 
button, you will just list all the Bluetooth-enabled devices 
that were detected during the last search, regardless of 
whether these devices are still present or not.

- Tap  every time you need to refresh the list of Blue-
tooth-enabled devices present nearby.

NOTE 1:  is only active after  has been tapped.
NOTE 2: At the end of a search, the name or class of a 
detected device may not have been found. In this case, 
tap and hold the “Unknown” icon and then select Update 
in the pop-up menu to let Bluetooth Manager determine 
these parameters.

PIN Code, Detectability & Authentication

- Tap  in the Bluetooth Manager toolbar. This opens the 
Properties window on which you can read or edit the prop-
erties of the local Bluetooth controller.

- Tap on the Security tab. The bottom of the window shows 
the default PIN code. This code should be entered in any 
remote device that attempts to pair itself with ProMark3.

- To change the PIN code, enter the desired code in the 
Default PIN field.

- To make the device discoverable (or detectable), enable 
the Let other devices discover check box. Otherwise disable 
this option (default setting: enabled).



- To demand that a remote device be allowed to access the 
local services only after pairing itself with ProMark3, 
check the Enabled box underneath Authentication. Other-
wise keep this option disabled (check box cleared).
Caution! This option is automatically disabled every time 
you start Bluetooth Manager.

- Tap OK on top of the window for the changes to take 
effect.

Local Services

Introduction
The local services offered by ProMark3’s Bluetooth controller 
are the following:
• Serial Port Service. The Serial Port service allows you to 

exchange data with a remote device via a virtual Bluetooth 
serial port.

• File Transfer Service. This service allows any two Blue-
tooth-enabled devices to exchange files.

• Object Push Service. This service is required to run the 
File Transfer Service but is not usable as such in 
ProMark3.

To list the local services offered by ProMark3:

• Tap  located in the Bluetooth Manager toolbar. The 
Bluetooth window shows the three icons representing its 
three local services.
Note that all the services are made active at power up (a 
small green circle containing a plug symbol is visible on 
each of the icons; see screen opposite).
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To deactivate a local service:

• Tap  in the Bluetooth Manager toolbar.
• Tap and hold the icon representing the local service 

you want to deactivate and then select Stop. This 
instantly stops the concerned local service.
Note that when you deactivate the File Transfer Ser-
vice or Object Push Service, you automatically deacti-
vate these two services.

To re-activate a local service:

• Tap  in the Bluetooth Manager toolbar.
• Just tap and hold the concerned icon and then select 

Start.
When you re-activate the Serial Port Service, Bluetooth 
Manager asks you to select the COM number you want 
to assign to the virtual port. Choose any port from the 
list and then tap OK. A message indicates that the port 
is now ready. Tap OK to close the message window.

To change the identification of the Bluetooth virtual port used 
by the Serial Port service, the Serial Port Service must be 
stopped first. When you re-start it, you can change the port 
used as explained above.

Using the Serial Port Service
...

Using the File Transfer Service
Assuming you want to transfer files between two ProMark3 
units, follow the procedure below, based on the use of 
ProMark3’s File Transfer Service:

- On the host ProMark3, make sure:
• Its File Transfer Service is activated.
• Its File Transfer Service properties include the path 

and name of the folder containing the files you want to 
transfer to the inquiring ProMark3 (for example the 
folder path and name are: \Application Data\Job101\).



To change this parameter, tap and hold the File Transfer 
Service icon and then select Properties. A window opens in 
which you can edit this parameter.

- On the inquiring ProMark3:
• Run Bluetooth.
• Display the properties of its File Transfer Service as 

explained above for the host device.
• Enter the path and name of the local folder through 

which files will be exchanged with the host (for exam-
ple the path and folder name are: \Application 
Data\Job547\).

• Detect the host ProMark3.
• If required, pair the two devices (you’ll need to enter 

the PIN code defined in the host ProMark3 Bluetooth 
properties; see page 192).

• List the local services offered by the remote (host) 
ProMark3.

• Double-tap the remote File Transfer Service icon to 
connect the inquiring unit to the host’s File Transfer 
Service. As a result the Bluetooth Manager window 
now lists the content of the remote folder (in our exam-
ple, the window would show the content of \Applica-
tion Data\Job101\ on the host ProMark3).
If the remote folder contains a sub-folder (\Application 
Data\Job101\Day1\ for example), you can double-tap 
on the sub-folder icon to list the content of this sub-
folder and then download files from this subfolder.

Tap  in the toolbar when you want to go up to the 
initial folder (\Application Data\Job101\).

• To download files from the host to the inquiring 

device, tap and hold the icon corresponding to the file 
you want to download and then select Get file. This 
starts the file transfer. Once the transfer is complete, 
the downloaded file can be found in the preset folder 
on the inquiring device (in our example, the file would 
be found in \Application Data\Job547\).
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• To upload files from the inquiring device to the 

host, tap and hold the stylus on a blank area (i.e. not 
on a file icon) within the Bluetooth Manager window.
When a dotted circle appears, remove the stylus and 
then select Add file in the pop-up menu. This opens a 
browser.
Open the local folder containing the file you want to 
upload, select this file and tap OK. This starts the file 
transfer. Once the transfer is complete, the uploaded 
file can be found in the selected folder on the host 
ProMark3 (in our example, in \Application 
Data\Job101\). As the inquiring ProMark3 is still list-
ing the content of this remote folder, the name of the 
uploaded file is now also visible in the Bluetooth Man-
ager window (new file icon added following the file 
transfer).

Creating Shortcuts for Remote Services

Once a service in a detected remote device has been found, 
you can create a shortcut for this service. This means you will 
no longer have to ask ProMark3 to find this service to be able 
to use it.
- To create a shortcut, tap and hold the service icon and 

then select Shortcut in the popup menu. This instantly cre-
ates the shortcut.

- To view the shortcut icon, tap .



Bluetooth Manager Toolbar Memo

Icon Function

Terminates the search sequence in progress.

Launches a search sequence (“Searching...” is displayed in the status 
bar) to find all the Bluetooth devices present in the vicinity. New icons 
appear in the window as new devices are detected. “Ready” is dis-
played in the status bar at the end of the sequence.

NOTE:  is only active after  has been tapped.
Allows you to list the content of the parent folder. Valid when using the 
File Transfer service of a remote ProMark3 after you have opened a 
subfolder.
Lists the shortcuts you created for the Bluetooth services found in the 
detected remote devices. Any shortcut can be deleted from the list.
Is initially used to search all the remote Bluetooth devices present in 
the vicinity.
Tapping this button after a search has been performed simply lists the 
Bluetooth devices that were detected during the last search sequence.

Tap  to refresh the list of detected Bluetooth devices.
Provides access to all Bluetooth local services available in the 
ProMark3 unit.
Allows you to view or edit the properties of ProMark3’s Bluetooth 
device: General, Security and Options.

Returns the software version of Bluetooth Manager software.

Minimizes the Bluetooth Manager window (but keeps Bluetooth Man-
ager running).
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11.Step-by-Step Procedure 
for Establishing a 
GPRS Connection Via Bluetooth

Introduction

You will use a cell phone associated with ProMark3 RTK to op-
erate in NTRIP or Direct IP mode via a GPRS connection. The 
cell phone should be a Bluetooth-enabled device fitted with a 
“full IP” SIM card1 that allows a GPRS connection to be es-
tablished with the provider.
When first implementing a GPRS connection, you will have to 
go through a relatively long procedure. But if you strictly fol-
low this procedure, re-establishing this connection next time 
you use your ProMark3 RTK will only take a few seconds.
Entering the right GPRS call number is essential to establish 
a GPRS connection. Three cases are possible:
• GPRS connection profile known
• GPRS connection profile unknown
• Special cases wherein a modem command is needed.

In all cases, you may have to get in touch with your provider 
in order to settle the connection issue.

Connection Profile Known
The GPRS connection profile you want to use is already stored 
in your cell phone. Your GPRS provider put it there. In this 
case, you will just have to refer to this profile when setting the 
GPRS connection. Referring to this profile will be made by 
simply using the adequate GPRS call number. This number is 
in the form:

*99***<Profile_No.>#

Where <Profile_No.> is the rank of the desired profile in the 
list of available GPRS connection profiles. To list the connec-
tion profiles stored in your cell phone, refer to its instructions 
manual.

1. A SIM card that can access all TCP ports.



Connection Profile Unknown
The GPRS connection profile you want to use is not stored in 
your cell phone, or your cell phone does not let you list the 
profiles stored in its memory or SIM card.
In this case, you will have to enter the parameters of the con-
nection profile in the Dial-Up Connection window.
One or several of the following parameters (APN parameters) 
may be required, depending on your provider:

In this case, there is only one possible GPRS call number, 
which is:

*99#

Special Cases
For some cell phone models, entering a GPRS call number 
and the required APN parameters is not enough to establish a 
GPRS connection.
In this case, when configuring the connection, a Hayes mo-
dem command, instead of the APN parameters, should be en-
tered to perform the connection. The modem command 
should be entered in a dedicated field, on the Call Options tab 
of the “Network and Dial-up Connections” utility, (see com-
mand example on the left).
The command is in the form:
+CGDCONT=<cid>,<PDP_type>,<APN>,<PDP_addr>,<d_comp>,<h_comp>

(more information on this command at http://www.phone-
star.com.my/s_at_10.html).
When used, the modem command replaces all the APN pa-
rameters, which means you should leave the User Name, Pass-
word and Domain parameters as set by the utility.
Finally, when a modem command is used, use the following 
GPRS call number:

*99#

Parameter Definition
User Name APN Login

Password APN password

Domain APN domain
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Step

1

2

3

4

5

The First Time You Use ProMark3 RTK

Please carefully read the procedure outlined in the table be-
low. This procedure is described in detail in the continuation 
of this chapter. Please strictly follow the order in which the in-
structions are given.
Note that the procedure was tested for several popular mobile 
phone brands and for a European GPRS operator. The proce-
dure should normally apply for any other manufacturer, phone 
model and GPRS operator although this cannot be guaran-
teed.

Task Detail
Ask ProMark3 RTK to be 
paired with the cell phone.

On ProMark3 RTK:
- Start Bluetooth Manager
- Detect the cell phone
- Ask for a paired Bluetooth link
- Enter a Pin code.

Allow the cell phone to be 
paired with ProMark3 RTK

On the cell phone, select the appropriate 
command and then enter the same Pin code as 
in Step 1.

Establish a Bluetooth link 
between ProMark3 RTK and 
the cell phone

On ProMark3 RTK:
- List the cell phone’s local services
- Establish a Bluetooth link
- Create a shortcut for future connections.

Prepare the GPRS connection On ProMark3 RTK
- Start creating a new connection icon
- Enter the GPRS call number
- Finish creating the new connection icon.

Establish the GPRS connection On ProMark3 RTK:
- Double-tap the new connection icon
- Enter GPRS operator identification data
- Start the GPRS connection.



Step 1: Ask ProMark3 RTK to Be Paired with the 
Cell Phone
Start Bluetooth Manager

1. On ProMark3 RTK, double-tap the Settings icon and then 
the Bluetooth Manager icon. The Bluetooth window appears 
on the screen after a few seconds.
For a quick overview of the Bluetooth Manager toolbar, 
please refer to Bluetooth Manager Toolbar Memo on 
page 197. For more details about Bluetooth Manager, 
please refer to Bluetooth Manager Module on page 190 

Detect the Cell Phone

Caution! ProMark3 RTK and the cell phone should not be too 
close to each other. Keep a minimum distance of 60 cm 
(2 feet) between the two devices.
1. Turn on your cell phone. 
2. Activate its Bluetooth device. Refer to the instructions 

manual of your cell phone to do this.
3. Make its local Bluetooth device discoverable from external 

Bluetooth devices such as ProMark3 RTK. Again, refer to 
the instructions manual of your cell phone to do this.

4. On ProMark3 RTK, tap  to search for the Bluetooth-
enabled devices present in the vicinity, including your cell 
phone.
At the end of this sequence, the icon representing your 
cell phone should be visible in the Bluetooth Manager 
window (see example opposite). Other Bluetooth devices 
may have been detected during this search sequence.

NOTE: Tap , not , if for any reason you need to 
resume the search sequence.
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Ask for a Paired Bluetooth Link

This procedure is for securing and quickly re-establishing the 
Bluetooth connection between the two units.
1. Tap and hold the cell phone icon.
2. When a dotted circle appears, remove the stylus and, in 

the menu that pops up, select Pair. A new window opens in 
which you should enter a pin number to secure the con-
nection to the cell phone (see below).

Enter a Pin Code

1. Tap inside the Pin field and type in any number. A two- to 
four-figure number is recommended. You will have to 
remember this number in step 2 below.
Note that this number may be different from the one 
entered in the Bluetooth Properties dialog (see PIN Code, 
Detectability & Authentication on page 192).

2. Tap OK to enter the pin code and close the dialog box. 
This causes the cell phone to display a message or menu 
following the pairing request from ProMark3 RTK.

Step 2: Allow the Cell Phone to Be Paired with 
ProMark3 RTK
On the cell phone, following the message triggered by the 
pairing request from ProMark3 RTK, allow a new pair of Blue-
tooth devices to be created between ProMark3 RTK and the 
cell phone:
1. Select the appropriate function depending on the cell 

phone used. For example on the Sony/EricssonT68i, select 
“Add to Paired”.

2. You will then be asked to enter the pin number you have 
previously defined in ProMark3 RTK (see Step 1).
When the units have successfully been paired, a yellow 
circle containing a padlock will appear on the cell phone 
icon on ProMark3 RTK (see example opposite).



Step 4: Establish a Bluetooth Link Between 
ProMark3 RTK and the Cell Phone

List the Cell Phone’s Local Services

1. Tap . The cell phone icon appears instantly and you 
can see a yellow circle included indicative of an active 
pair of Bluetooth devices.

2. Double-tap the cell phone icon. The Bluetooth Manager 
window now shows the Bluetooth services offered by your 
cell phone (see screen example opposite).

Establish a Bluetooth Connection

1. Double-tap the Dial-Up Networking icon. As a result, a 
connection is automatically implemented using the first 
Bluetooth virtual port available on ProMark3 RTK. The 
message “Connection succeeded on communication port 
COMx:” is displayed.
NOTE: COM1 is the only physical COM port on ProMark3 
RTK. COM2 is an internal virtual port and COM3 is auto-
matically assigned as the first Bluetooth virtual port at 
power on. So when you double-tap the Dial-Up Networking 
icon, COM4 is normally the port used for that connection.

2. Tap OK to close the message window. Note the presence of 
a plug in a green circle on the Dial-Up Networking icon 
showing that the connection is effective (see opposite).

Create a Shortcut for Future Connections

This shortcut will allow you to save time for future connections 
as you won’t have to list the local services of the cell phone to 
re-activate the Bluetooth link. Instead you will just have to 
double-tap the shortcut.
1. Tap and hold the Dial-Up Networking icon. When a dotted 

circle appears, remove the stylus and, in the menu that 
pops up, select Create Shortcut. A message “Shortcut suc-
cessfully saved” appears after a few seconds.

2. Tap OK to close the message window.

3. Tap  to view the shortcut you have just created.

4. Tap  to minimize the Bluetooth Manager window.

Step 5: Prepare the GPRS Connection
1. Double-tap Network and Dial-up Connections.
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2. In the window that opens, double-tap the Make New Con-
nection icon.

3. Name the new connection (for example “My Cell Phone”) 
using the virtual keyboard, keep Dial-Up Connection 
checked on and then tap Next>.



4. In the Select a modem field, select the port used on 
ProMark3 RTK (i.e. the port assigned previously) to com-
municate with the Bluetooth modem of the cell phone 
(see screen example opposite; the selected modem should 
be in the form “BT Modem on <CellPhoneName> COMx”).

5. Tap Configure and then enter the data line settings on the 
Port Settings tab. Choose a baud rate that is greater than 
the one used by the GPRS connection.

6. Tap OK to close the Device Properties window. Ignore the 
warning message, if any. Simply tap OK to close this mes-
sage.

7. In the Modem window, tap Next>.
8. In the Phone Number field, type the GPRS call number 

according to the instructions on page 198.
9.  Tap Finish. A new icon appears in the Connection window 

(see example opposite).

Step 6: Establish the GPRS Connection
1. Double-tap the icon you have just created in the connec-

tion window.
2. Enter the following parameters:

• User Name
• Password
• Domain

3. Enable the Save password option.
4. Tap on the Dial Properties button and then on the Edit but-

ton. This opens the Edit Dialing Patterns window.
5. Correct the content of this window in order to read “G” in 

the three fields.
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6. Tap OK twice to return to the Dial-up Connection window.
7. Tap on the Connect button. The following messages appear 

successively: “Opening Port”, “Dialing...”,... “User 
Authenticated” and “Connected”. The GPRS connection 
is now established.

8. Tap Hide to close the message window.

9. Tap  to close the Connection window.
10.Now it’s time to select your DGPS mode (refer to Select-

ing a DGPS Mode on page 209).

Troubleshooting
You may encounter problems when attempting to establish the 
GPRS connection (Step 6 above). The table below may help 
you solve the problem.

Important! The Password and Domain fields (see Step 6) are 
intentionally corrupted when next opening the Dial-up con-
nection. This is done for safety purposes. You don’t need to re-
type these parameters. The correct values are stored in the 
unit.

Message Action

“No Carrier Detected. Verify phone 
number and then try again.”

- Double-tap connection icon
- Tap Dial Properties button
- Tap Edit button
- Reset all fields to “G”.

“You have been disconnected from 
the remote computer you dialed. Retry 
the connection.”

On the cell phone, check that the 
GPRS connection capability is 
activated.

“The port is not available: it is either 
configured incorrectly or another pro-
gram is using it.” 

Check all data entries performed 
during steps 5 and 6. 



Subsequent Uses

Standard Re-Start Procedure
Next time you turn on ProMark3 RTK and the cell phone, the 
procedure for re-establishing the GPRS connection will be sig-
nificantly shorter, as explained below. Because the two devic-
es were paired when first using them, you don’t need to make 
the cell phone discoverable.
1. On ProMark3 RTK, double-tap the Bluetooth Manager icon 

to re-start Bluetooth Manager.

2. Tap  to list the existing shortcuts.
3. Double-tap the Dial-Up Networking icon. This re-estab-

lishes the Bluetooth connection between the cell phone 
and ProMark3 RTK. Tap OK to close the message window.

4. Tap  to minimize the Bluetooth Manager window.
5. Double-tap the Network and Dial-up Connections icon.
6. Double-tap the “My Cell Phone” icon you have created in 

the initial procedure (see page 203).
7. Tap on the Connect button. The following messages appear 

successively: “Opening Port”, “Dialing...”,... “User 
Authenticated” and “Connected”. The GPRS connection 
is now established.

8. Tap Hide to close the message window.

9. Tap  to close the Connection window.
10.Select your DGPS mode (see Selecting a DGPS Mode on 

page 209).
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Disconnecting GPRS
You may want to disconnect the GPRS connection. Follow the 
instructions below to do this from the ProMark3 RTK:
1. Double-tap the Network and Dial-up Connections icon.
2. Tap on the icon representing the currently active GPRS 

connection.
3. Do one of the following:

- Tap  in the menu bar (top of the screen).
- Or Tap Connection in the menu bar (top of the screen) 

and then select Disconnect. This instantly cuts off the 
GPRS connection.



12.Selecting a DGPS Mode

Introduction

ProMark3 RTK can be operated in one of the following DGPS 
modes:
1. None: No DGPS mechanism is used but differential cor-

rections from SBAS satellites (SBAS) will be used if 
received by one or two of the ProMark3 GPS reception 
channels.

2. Beacon: Differential corrections are received by the belt-
carried Magellan MobileMapper beacon. This unit is con-
nected to the ProMark3 or ProMark3 RTK via Bluetooth or 
a serial cable.

3. Direct IP: Differential corrections are taken from the Inter-
net at a fixed IP address. They are routed to 
ProMark3 RTK via a GSM/GPRS cell phone and Bluetooth.

4. NTRIP (=Networked Transport of RTCM via Internet Proto-
col): Same as Direct IP except that the DGPS correction 
provider uses the NTRIP protocol to route correction data.

5. UHF: Only usable with a ProMark3 RTK base/rover configu-
ration to implement a UHF radio link between the base 
and the rover. The corrections provided by the base are 
RTCM 3.1 corrections.

6. Other RTCM Source: Differential corrections are received by 
third-equipment delivering RTCM2.3 message types #1, 
#3 and #9. This third equipment is connected to the 
Promark3 or ProMark3 RTK via a serial cable or Bluetooth.

The table below summarizes the connection and identification 
data needed when operating in the NTRIP or Direct IP mode.

Parameter Direct IP NTRIP
Host IP Address • •

Port Number • •
Login •

Password •
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The table below lists the different steps you have to go through 
before the ProMark3 or ProMark3 RTK can operate in a given 
DGPS mode, depending on whether the mode relies on the 
use of a COM port, Bluetooth or GPRS.

To choose and enable a DGPS mode, use the DGPS Configu-
ration utility as explained in detail in the continuation of this 
chapter.

Beacon

Two different connections to the ProMark3 or ProMark3 RTK 
are possible with MobileMapper Beacon: via Bluetooth (pre-
ferred) or using a wire connection (RS232). For more informa-
tion about MobileMapper Beacon, please refer to its Getting 
Started Guide.

1. If you are using Bluetooth:
- Place MobileMapper Beacon between 60 cm (two feet) 

and 10 meters (about 30 feet) of the ProMark3. Do not 
stand squarely between the two. Bluetooth requires line of 
sight, though you may place the Beacon on your belt.

- Switch on both MobileMapper Beacon and ProMark3.
- On ProMark3, go to the Utilities folder and then double-

tap Bluetooth Manager. The Bluetooth window appears on 
the screen after a few seconds.

- Tap . Bluetooth Manager starts searching for any 
Bluetooth device present in the vicinity. At the end of the 
search sequence, a MobileMapper Beacon icon should be 
present in the list of found devices.

Step #
GPS Mode Step 1 Step 2 Step 3 Step 4

eacon via 
luetooth

Establish Blue-
tooth Connection

Select and set 
(tune) beacon

Enable Beacon 
mode

eacon via 
OM1

Connect Serial 
Data Cable

Select and set 
(tune) beacon

Enable Beacon 
mode

irect IP Establish Blue-
tooth Connection

Establish GPRS 
connection

Select and set Direct 
IP

Enable 
Direct IP

TRIP Establish Blue-
tooth Connection

Establish GPRS 
connection

Select and set 
NTRIP

Enable 
NTRIP

ther RTCM 
ource
ia COM1

Connect Serial 
Data Cable

Select and set 
RTCM source

Enable Other RTCM 
Source mode



- Double-tap the MobileMapper Beacon icon. The screen 
lists the only service available from MobileMapper Beacon 
which is its Serial Port service.

- Double-tap the Serial Port service icon. A dialog box opens 
prompting you to associate a virtual ProMark3 COM port 
with MobileMapper Beacon.

- Just tap OK. A message box appears confirming that a link 
is now established with MobileMapper Beacon via the vir-
tual COM port. On MobileMapper Beacon, the blue indica-
tor light is on.

- Tap OK.

- Tap  to minimize the Bluetooth window.

- Tap  again to close the Settings window.
- Then go to point 3. below.

2. If you are using COM1 on ProMark3 RTK to communicate 
with MobileMapper Beacon (RS232 wire connection):
- Attach the I/O module to ProMark3.
- Connect the serial cable provided with MobileMapper Bea-

con between the two units. See diagram below.

- Switch on both MobileMapper Beacon and ProMark3.

COM1 on I/O module

Data Connector

DB9-female
Round 7-pin connector
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3. Choose MobileMapper Beacon as the DGPS data source:
- On the ProMark3 workspace screen, double-tap the DGPS 

Configuration icon.
- Tap on the Select Mode button.
- In the Select Differential Mode window, enable the Beacon 

option and then tap OK. The Settings window opens to let 
you configure both the beacon and the connection to this 
beacon.

- In the Port field, on top of the screen, set the port through 
which you will communicate with the MobileMapper bea-
con. Typically, you will select:
• COM1, if you are using a wire connection to 

MobileMapper Beacon.
• A virtual COM port if you are using Bluetooth.

Note that the Update button allows you to update the list of 
available ports attached to the Port field. When selecting 
Beacon and tapping OK, this update function is automati-
cally run so you don’t need to tap this button. Typically, 
you need to use this button after you have changed the vir-
tual port in Bluetooth Manager and the Settings window is 
already open.
Note that the Configuration button allows you to display the 
settings of the selected port. But when selecting Beacon as 
the DGPS data source, the settings of the selected port 
are in fact forced to 4800 Bd, no parity, 8 data bits and 1 
stop bit.

- Tap on the Tune button.
- Choose one of the following options to tune the 

MobileMapper Beacon receiver:
• Tune Automatically (automatic method; default choice).
• Tune by Frequency (manual method: you have to specify 

the frequency to which you want the receiver to tune).
• Tune By Site (manual method: you have to specify the 

region, country and name of the DGPS source, i.e. the 
reference station, you want MobileMapper Beacon to 
receive) (see screen example opposite).

- Tap OK.



- Tap OK again after the message “Beacon Tuned Success-
fully!” appears. This takes you back to the previous screen.

- Tap Details to read the current settings and performance 
indicators of the MobileMapper Beacon. The current tun-
ing settings include reception frequency, MSK rate and 
station ID of the reference station being received. The per-
formance indicators are the lock status (No/Yes), the sig-
nal strength, measured in dBµV, and the Signal-to-Noise 
Ratio (SNR) in dB. See screen example opposite. Refer to 
page 266 for more detail.

- Tap OK to close this window and return to the previous 
screen (Settings screen).

- Tap OK for all the settings to take effect. The DGPS Con-
figuration screen is now displayed.

- Tap Connect to allow MobileMapper Beacon to send its 
correction data. When connection is effective and correc-
tions are being sent, the Connect button is changed into a 
Disconnect button and the status bar at the bottom of the 
screen indicates the amount of incoming data packets 
since you tapped the Connect button. The top of the 
screen gives general status information on the DGPS mode 
currently selected.
NOTE: If you had to use the now inactive Select Mode and 
Settings buttons, you should have first to re-activate them 
by tapping on the Disconnect button. This would discon-
nect the source of DGPS data from ProMark3 and so 
would stop the flow of incoming data packets.

- Tap OK to close the DGPS Configuration window. The fol-
lowing two messages are displayed successively: “Please 
wait...” and “Processing incoming data packets...”.

- Tap OK to close the message window.
- Start your job using the chosen software application.
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Direct IP

Warning! Using Direct IP requires that you have previously fol-
lowed the entire procedure described in Step-by-Step Proce-
dure for Establishing a GPRS Connection Via Bluetooth on 
page 198.
Important Notice! Once you are familiar with the GPRS connec-
tion procedure described on page 198, you don’t need to ac-
curately follow this procedure. Instead, make your Bluetooth 
and GPRS connections directly from within the DGPS Config-
uration utility, using the following buttons located on the Di-
rect IP Settings window:

-  for Bluetooth Manager

-  for GPRS

Assuming the GPRS connection is now active, do the follow-
ing to implement the Direct IP DGPS mode:
- On the ProMark3 RTK workspace screen, double-tap the 

DGPS Configuration icon.
- Tap on the Select Mode button.
- In the Select Differential Mode window, enable the Direct 

IP option.
- Tap OK. The Direct IP Settings window opens from which 

you can store several Direct IP configurations. [With an 
already active GPRS connection, note that the Bluetooth 
and DialUp fields have been filled in accordingly.]
Each Direct IP configuration holds the key information 
allowing ProMark3 RTK to connect to a given corrections 
provider. Having the capability to save several Direct IP 
configurations in ProMark3 RTK will therefore allow you to 
quickly change the corrections provider without having to 
re-enter the relevant connection parameters each time you 
do that.

- To enter your first Direct IP configuration, tap 
- Select New in the Direct IP Configuration field, tap on the 

Add button and then enter the following parameters:
• Name: Direct IP Configuration Name (freely choose a 

name)
• Host: IP address
• Port: Port number

(The last two parameters should have been passed on 
to you by the correction provider.)



- Tap OK. The name of the configuration you have just cre-
ated is now pre-selected in the Direct IP Configuration field. 
Two new buttons (Edit and Delete) are shown under this 
field allowing you to respectively edit or delete this config-
uration. When you edit an existing configuration, note that 
you cannot change its name.
To create a second Direct IP configuration, you would tap 
the down arrow to the right of the Direct IP Configuration 
field and select New. The Add button would appear again 
under the field. You would tap this button, enter the three 
parameters of the second configuration and tap OK to save 
this new configuration.

- After selecting the desired configuration from the Direct IP 
Configuration field, tap OK. This takes you back to the 
DGPS Configuration window. On top of the screen, you can 
read part of the settings you have just made.

- Tap the Connect button. The DGPS Configuration screen 
now indicates the amount of incoming data packets (bot-
tom of the screen) as well as the status of the DGPS mode 
(top of the screen).

- Tap OK to close the DGPS Configuration window. The fol-
lowing two messages are displayed successively: “Please 
wait...” and “Processing incoming data packets...”.

- Tap OK to close the message window.
- Start your job using the chosen software application.
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NTRIP

Warning! Using NTRIP requires that you have previously fol-
lowed the entire procedure described in Step-by-Step Proce-
dure for Establishing a GPRS Connection Via Bluetooth on 
page 198.
Important Notice! Once you are familiar with the GPRS connec-
tion procedure described on page 198, you don’t need to ac-
curately follow this procedure. Instead, make your Bluetooth 
and GPRS connections directly from within the DGPS Config-
uration utility, using the following buttons located on the 
NTRIP Settings window:

-  for Bluetooth Manager

-  for GPRS

Assuming the GPRS connection is now active, do the follow-
ing to implement the NTRIP DGPS mode:
- On the ProMark3 RTK workspace screen, double-tap the 

DGPS Configuration icon.
- Tap on the Select Mode button.
- In the Select Differential Mode window, enable the NTRIP 

option.
- Tap OK. The first time you select NTRIP, the message No 

NtripCaster specified appears.
- Tap OK to close the message window. This opens the 

NTRIP Settings window from which you can store several 
NTRIP configurations. [With an already active GPRS con-
nection, note that the Bluetooth and DialUp fields have 
been filled in accordingly.]

- Tap . The NtripCaster Connection window opens in 
which you can store several NTRIP configurations.
Each NTRIP configuration holds the key information 
allowing ProMark3 RTK to connect to a given NTRIP 
caster. Having the capability to save several NTRIP config-
urations in ProMark3 RTK will therefore allow you to 
quickly change the NTRIP caster without having to re-
enter the relevant connection parameters each time you 
do that.



- To enter your first NTRIP configuration, with New selected 
in the NTRIP Configuration field, tap on the Add button and 
then enter the following parameters:
• Name: NTRIP Configuration Name (freely choose a 

name)
• Host: Host IP address
• Port: Port number
• Login: User name
• Password: User password

(The last four parameters should have been passed on 
to you by the NTRIP provider.)

- Tap OK. The name of the configuration you have just cre-
ated is now pre-selected in the NTRIP Configuration field. 
Two new buttons (Edit and Delete) are shown under this 
field allowing you to respectively edit or delete this config-
uration. When you edit an existing configuration, note that 
you cannot change its name.
To create a second NTRIP configuration, you would tap 
the down arrow to the right of the NTRIP Configuration field 
and select New. The Add button would appear again under 
the field. You would then tap this button, enter the five 
parameters of the second configuration and tap OK to save 
this new configuration.

- After selecting the desired configuration from the NTRIP 
Configuration field, tap OK. ProMark3 RTK connects to the 
NTRIP caster. The NTRIP Settings window is displayed 
again on which you can choose a network and station (cor-
rections source) from the caster. The Get Table button is for 
downloading the new list of available stations in the case 
you select a new provider from the Caster field.

- The best choice is to use the station the nearest to your 
current location. Tap on the Find Nearest button to find and 
select this station. This causes the Network and Station 
fields to be automatically updated. The distance to this 
station is indicated just underneath the Station field. A 
second parameter in the same line tells you whether the 
selected station provides VRS corrections data or not (VRS 
for “Virtual Reference Station”; if “VRS”, the station pro-
vides corrections data for a virtual station that would be 
located where you are. If “Not VRS”, the corrections data 
are computed for the true location of the station).
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Note that the screen includes a More Details button allow-
ing you to view the properties of the selected station. Tap 
on this button. The NTRIP Station Details screen is dis-
played on which you can use the following buttons:
• Previous and Next to view the properties of respectively 

the previous and next stations from the list of stations 
provided by the caster.

• Select to select the station whose properties are cur-
rently displayed. This takes you back to the NTRIP 
Settings screen on which you can now see the name of 
this station in the Station field.

• Cancel to return to the NTRIP Settings screen without 
changing the choice made in the Station field.

- Tap the Connect button. The DGPS Configuration screen 
now indicates the amount of incoming data packets (bot-
tom of the screen) as well as the status of the DGPS mode 
(top of the screen).

- Tap OK to close the DGPS Configuration window. The fol-
lowing two messages are displayed successively: “Please 
wait...” and “Processing incoming data packets...”.

- Tap OK to close the message window.
- Start your job using the chosen software application.



Other RTCM Source

- Switch on the external device providing RTCM corrections 
data.
If you want to use COM1 on ProMark3 or ProMark3 RTK to 
communicate with the external device, connect the ade-
quate serial cable between the two units.

- On the ProMark3 workspace screen, double-tap the DGPS 
Configuration icon.

- Tap on the Select Mode button
- In the Select Differential Mode window, enable the Other 

RTCM Source option. The Settings window opens to let you 
configure the connection to the external source.

- In the Port field, on top of the screen, set the port through 
which you will communicate with the external device. By 
default, only the COM1 port, the only “physical” COM port 
available on the ProMark3, is available. Note that COM1 
will not be available from the list if it’s used by another 
application.
Note that the Update button allows you to update the list of 
available ports attached to the Port field. When selecting 
Other RTCM Source and tapping OK, this update function is 
automatically run so you don’t need to tap this button. 
Typically, you need to use this button after you have 
assigned a virtual port in Bluetooth Manager and the Set-
tings window is already open.

- Tap the Configuration button to edit or view the settings of 
the selected port. A Test button allows you to test the 
availability of the port.

- Tap OK to close the Port Configuration window. This takes 
you back to the Settings window.

- Tap OK and then Connect.
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- Tap OK to close the DGPS Configuration window. The fol-
lowing two messages are displayed successively: “Please 
wait...” and “Processing incoming data packets...”.

- Tap OK to close the message window.
- Start your job using the chosen software application.

Returning to Autonomous GPS Mode

- On the ProMark3 workspace screen, double-tap the DGPS 
Configuration icon.

- Tap on the Select Mode button.
- In the Select Differential Mode window, enable the None 

option.
- Tap OK to close the window. This takes you back to the 

DGPS Configuration window where you can read the 
choice you have just made.

- Tap OK again. The window is closed and ProMark3 starts 
operating instantly in Autonomous GPS mode.

How to End a Direct IP or NTRIP Session

You don’t need to cut off the GPRS connection and the NTRIP 
or Direct IP connection before shutting down the unit.
Actually, turning off the ProMark3 RTK and cell phone while 
a NTRIP or Direct IP session is active is not a hazardous op-
eration.
When you next turn on the two units, the re-start procedure 
will take place according to the instructions in the next sec-
tion (Subsequent Uses).
However, after you cut off the connection, you may have to 
wait up to 10 seconds before a new connection is possible, 
due to time-outs in servers.

Subsequent Uses

Next time you turn on ProMark3 RTK and you run the DGPS 
Configuration utility, you will be prompted to run the same 
DGPS mode as the one you last used. If it was Direct IP or 
NTRIP, the configuration you last used is preset. If it was Mo-
bileMapper Beacon, the last station used is preset.



If you use Bluetooth however, you will have to launch Blue-
tooth Manager manually. For NTRIP or Direct IP for example, 
you will have to do the following after launching DGPS Config-
uration (skip step 8 for Direct IP):
1. Tap on the Settings button.

2. Tap  and then 
3. Double-tap the Dial-Up Networking shortcut icon to re-

assign a virtual port to Bluetooth. Tap OK to close the mes-
sage box.

4. Tap  to minimize the Bluetooth Manager window.

5. Tap  to access your GPRS Connection icon
6. Double-tap this icon and then tap Connect. After the con-

nection is active (Sound + “Connected”), tap Hide.

7. Tap  to close the Connection window
8. Tap the Get Table button to recover the list of stations, 

choose the desired one and tap OK.
9. Tap Connect. Once connected to the station, tap OK to 

close the DGPS Configuration window.

Cell Phone Changes

Here are a few recommendations you should follow when sub-
stituting your current cell phone for a brand new one:
1. In Bluetooth Manager, delete the Dial-Up Networking short-

cut icon
2. In Bluetooth Manager, unpair your old cell phone (tap and 

hold the corresponding icon and select Unpair)
3. In Bluetooth Manager, run a new search for Bluetooth-

enabled devices in order to let ProMark3 detect your new 
cell phone.

4. In the GPRS Connection window, delete the icon corre-
sponding to your old cell phone.

5. In the GPRS Connection window, create a new connection 
icon for the new cell phone.

By following these precautions, you make sure all the virtual 
ports in ProMark3 are made available for new connections.
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13.Accuracy

RTK

Operating Conditions
Unless otherwise mentioned, all performance figures given in 
what follows  were collected in kinematic mode and open sky 
environment.

Open sky is defined as:
- No obstructions above 10-degree elevation
- No metal-like reflectors within 100-meter radius
- More than 5 satellites tracked above 5-degree elevation
- Maximum SNR value is greater than 52 dB.Hz.
- No satellite above 10-degree elevation has an SNR figure 

less than 30 dB.Hz (external antenna used).
- In RTK mode, differential corrections are available for at 

least 7 satellites received.

Partly blocked sky is defined as a situation where at least one 
of the requirements above is not met, but the number of 
tracked satellites above 10 degrees is still over 4.

SBAS availability is defined as:
- At least one SBAS satellite providing fast+long corrections 

for at least 6 GPS satellites and at least half of complete 
ionosphere grid (for SBAS differential).

- Any SBAS satellite providing code & carrier measurements 
and ephemeris data with URA<6 is considered as a 
healthy satellite.

Position Accuracy
“Float” position status:
- Accuracy at start up: 35 cm + 1 ppm (CEP)
- Accuracy after 300 seconds: 20 cm + 1 ppm (CEP)
- Accuracy after sufficient convergence: 5 cm + 1 ppm 

(CEP)

“Fixed” position status:
- Accuracy: 1cm + 1ppm (sigma horizontal)



Paramet

Fix Availab
within the 

600 se

Reliabili

TTFF for 5
of the tes
Time to First Fix (TTFF)
Conditions of use: External antenna used, baseline < 10 km, 
difference of altitude between base and rover <50 m

Initialization in Networks
If you are working with a single Physical Reference Station 
(PRS), performance figures should be equivalent to those giv-
en in the above table, in the same operating conditions.
Performance figures will also be of the same level if you are 
working with a Virtual Reference Station (VRS), provided the 
distance between the master station (i.e. the PRS used for 
creating the VRS) and the rover is less than 10 km.

ers Sky 
Environment OTF Static

(Static OTF)
With Initializer  

Bar
ility 

next 
c

Open Sky >80% >90% >99%

Partly blocked sky >60% >70% -

ty
Open Sky >99% >99% >99%

Partly blocked sky >99% >99% -

0% 
ts

Open Sky <120 s <90 s <30 s

Partly blocked sky <150 s <120 s -
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To achieve the best accu-
racy, it is important to hold 
the receiver at an angle of 
45 degrees from horizon-

tal. This allows the internal 
antenna to pick up signals 
from the GPS, WAAS and 
EGNOS satellites. This is 

especially true when 
recording data for post-pro-

cessing.
Autonomous GPS, SBAS & DGPS Modes

ProMark3 provides autonomous 3-meter accuracy all around 
the globe assuming the receiver is tracking five GPS satellites 
and the PDOP < 4 (which is almost all the time).
ProMark3 is also capable of providing 50- to 70-cm horizontal 
accuracy using real-time differential corrections from its built-
in SBAS receiver. You must be in North America to make use 
of the free WAAS signals broadcast by the US Federal Aviation 
Administration. You must be in Europe to make use of the free 
EGNOS signal broadcast by the European Union. If you are us-
ing the Mobile Mapping function and SBAS signals are re-
ceived, a “W” will appear on all logging screens (after the 
number of received satellites; see page 225).
In addition to SBAS, ProMark3 can apply real-time differen-
tial corrections (DGPS) from land-based systems such as 
Coast Guards beacons or your own privately broadcast RTCM 
Type 1 or Type 9 corrections. Just use the serial cable to con-
nect your ProMark3 to a differential correction receiver. A 
"DGPS.." will appear on the ProMark3's Position screen when 
the receiver detects RTCM input.
The accuracy with land-based systems is approximately the 
same as with SBAS. However, it is possible to improve accu-
racy by one or two decimeters if you broadcast your own RTCM 
corrections while keeping the distance between the broad-
casting reference receiver and the rover receiver less than 10 
km (3 miles).
If you average positions for a point feature for a few minutes, 
even better accuracy is possible.



Tracking 3 satellites will in 
principle allow you to cal-
culate a 2D position (lat/

lon) using the last altitude 
recorded by the receiver. 

You need to track at least 4 
satellites to get a 3D posi-

tion (lat/lon/altitude). To 
achieve the specified accu-

racies for ProMark3, you 
will need to track 5 or more 

satellites.

GPS quality indicators
ProMark3 may warn you if the PDOP, and therefore the accu-
racy, of your positions has dropped below the level you select-
ed during Setup (see page 240, the PDOP alarm option). If 
you see this warning you may press the ESC button and con-
tinue logging.
However, if you are running a kinematic survey or recording 
line or area features, you might want to return to the field 
when the GPS satellites are in a better configuration overhead 
(the constellation changes slowly but constantly).
And if you are running a static survey or recording a point fea-
ture, you should strongly consider moving to another location 
with better satellite reception and recording an offset (dis-
tance and bearing) to the feature.

Quality Indicators

On the Survey Status screen in Surveying or at the bottom of 
each logging screen in Mobile Mapping, you can see two num-
bers that give you a good indication of how accurate the 
ProMark3 unit should be.
The first is the number of satellites that the receiver is track-
ing. In Mobile Mapping, a “W” will appear after the number 
of satellites if SBAS is used. The presence of this letter is in-
dicative of an even better accuracy level.
The second number is the Positional Dilution of Precision 
(PDOP), which is an estimate of accuracy that the receiver 
constantly calculates using the geometry of satellites in the 
sky. The more satellites that are being tracked and the more 
evenly they are distributed around the sky, the better the ac-
curacy. PDOP values less than 4 or 5 are good. If the PDOP 
value is over 5, you should consider moving to an area with a 
clearer view of the sky and recording features with offsets.
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The MENU key is inactive 
until you double-tap the 

Survey or Mobile Mapping 
icon.
14.MENU key

The diagram below shows the available functions when press-
ing MENU. When you select the Setup option in the menu list, 
another menu is displayed containing a number of options, as 
shown in the diagram below.

All the options available from the Menu screen are described 
below.

Receiver mode

This option is available only with a ProMark3 RTK or after you 
have upgraded your ProMark3 to a ProMark3 RTK and you 
have unlocked the RTK option.
This option allows you to choose between real-time or post-
processing survey mode. Three options are available:
- Post-Processing: Sets the receiver to perform post-process-

ing surveys in static, kinematic or stop & go mode
- Real-Time: Sets the receiver to perform real-time surveys in 

logging point, kinematic or stakeout mode.
- Real-Time & Raw Data Recording: Same as Real-Time above 

but in addition, and as a background task, the receiver will 
immediately start logging raw data (at a fixed 1-second 
recording rate). For this reason, please select your storage 
medium (SD card or Internal Memory) before selecting 
this option.
If you select this option for both your base and rover, you 
will be able to check the results of your real-time surveys 
by post-processing the corrresponding raw data files in 
GNSS Solutions.

Receiver Mode
DGPS Configuration
Initialize RTK
Base Station
File Manager
Mark
GOTO
Routes
Setup
Customize
About...
Exit

Storage
Receiver ID
Antenna Type
Real-Time Fast Mode
Select Map
Map Setup
Nav Screens
Coord System
Map Datum
Time Format
Units
Alarms
North Reference
Beeper
Reset Trip
Clear Memory
Simulate
Language

(Surveying only)

(Available only when 
a customizable navi-
gation screen is dis-
played)

(Not available if Map 
screen displayed in 
cursor mode)

ProMark3 RTK Only

ProMark3 RTK Only, 
Real-Time selected as 
Receiver Mode

(Real-Time only)



DGPS Configuration

This option is available only with a ProMark3 RTK after you 
have set the Receiver Mode to Real-Time or Real-Time & Raw 
Data Recording.
This option provides access to the DGPS Configuration Utility 
from within Surveying or Mobile Mapping. See this utility in 
Selecting a DGPS Mode on page 209.
The DGPS Configuration Utility can also be run from the 
ProMark3 workspace, or from the Utilities folder, by double-
tapping the corresponding icon.

Initialize RTK

This option allows you to choose an initialization method for 
the rover. Rover initialization is required at the beginning of a 
real-time survey and every time you lose RTK initialization.
RTK initialization is achieved when the solution status chang-
es from “Float” to “Fixed”. The solution status is displayed on 
the Position screen (see Position Screens on page 147) and 
on the Log screens (see Standard RTK: “Surveying” on 
page 51). There are four possible initialization methods:
- On the Fly: Initialization will be achieved while freely mov-

ing in the field with the rover. This is the easiest yet the 
slowest initialization method.

- Static: Initialization will be achieved on an unknown 
point. Keep the antenna still over this point until the rover 
can fix the position solution. This is a faster initialization 
method than “On the Fly”.

- Known Point: Initialization will be achieved on a known 
point. Keep the antenna still over this point until the rover 
can fix the position solution. A very fast initialization 
method. 

- Bar: Initialization is achieved by placing the rover antenna 
on top of the kinematic bar installed at the base. The fast-
est initialization method.

Choose the initialization method that is the most convenient 
in your case of use.
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Base Station

This option allows you to set the ProMark3 RTK as a base sta-
tion. Setting a base station includes defining:
- The three coordinates of the point occupied by the base 

station (Location, Elevation),
- The height of its antenna with respect to the reference 

point (Antenna Height), how the antenna height was mea-
sured (Height Type), and the unit in which the height is 
expressed (Units),

- The station ID (Station ID).
Once these parameters are defined, simply tap the Start but-
ton to get the base station started. A new screen will appear 
showing the following parameters:
- Site ID
- Time elapsed since the base station was started.
- Number of satellites currently received
- Current value of PDOP
- Coordinates of the base
- Power indicator
- Free Memory indicator

This screen will continually be displayed until you tap the Stop 
button. ProMark3 RTK will then instantly stop operating as a 
base to take you back to the last displayed navigation screen.

File Manager

This option allows you to list the files stored in the internal 
memory or SD card, depending on the choice you have made 
through Setup and Storage.
A sign is placed before each filename. The meaning of this 
sign is as follows:

+ Indicates that the file has not yet been downloaded from 
the handheld
- Indicates that the file has been downloaded from the 
handheld.



The name, last modification date and size of the selected file 
is shown at the bottom of the screen. Only the following file 
types are listed:

- *.O* (vector files; ProMark3 RTK only)
- R*.* (Raw data files)
- *.MMJ (GIS job files)
- *.MMF (GIS feature library files)
- *.IMI (Map files)

You can delete the selected file or all the files by tapping re-
spectively Delete or Delete All and then Yes to confirm.
(Delete All does not delete waypoints, track, routes and user 
settings but only the listed files, as opposed to Clear All in Clear 
Memory which deletes all waypoints, track and routes but does 
not impact user files; see page 242.)
When the internal memory is selected for storage, you can 
copy files to the SD Card you have previously inserted in the 
unit. Tap the Copy button and then one of the following op-
tions:

- All Files: All listed files are copied to the SD Card
- Selected File: Only the highlighted file is copied to the 

SD Card
- New Files: Only the files with filenames preceded by 

“+” are copied to the SD Card.

Mark

This option allows you to quickly create a new waypoint whose 
default coordinates will be those of your current location.
A typical use of this option is when you are located at a new 
point of interest and you wish to log its position.
When you select Mark in the menu list, ProMark3 displays the 
Mark screen with the following default values:
-  Default icon in the Icon field
- “WPTxxx” as waypoint name in the Name field. “xxx” is a 

number that ProMark3 automatically increments as you 
create new waypoints

- Coordinates of your current location in the Location and 
Elevation fields

If you agree with all these parameters, and as the Save field is 
already selected at the bottom of the screen, you just have to 
press ENTER to create the new waypoint. This is the fastest 
procedure to create a new waypoint.
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On the other hand, if you have to change any of these param-
eters or add a comment in the Message field, then you have 
first to edit the corresponding fields before selecting the Save 
field and pressing ENTER
The Route button gives direct access to the Route List screen 
where you can insert the newly created waypoint into a new or 
existing route.
If you would like to add more description or if you would like 
to export a waypoint to your GIS, use a feature library that in-
cludes a point feature called “Waypoint” and whatever level of 
attribution that you need. Then, when you want to record a 
waypoint, you can select the Waypoint feature type from the 
feature library and record a fully describable and exportable 
point feature.

GOTO

This option is discussed in detail on page 153.



Routes

This option is discussed in detail on page 158. The MENU 
button gives access to a list of specific options when the 
Routes option is enabled. This is summarized in the diagram 
below.

Insert WPT
Delete WPT
Replace WPT
Save Route

From View/Edit 
Route screen

Activate Route
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

Deactivate Route
Select Leg
View/Edit Route
Reverse Route
Delete Route
Save Trk to Rte
Map View Route

From Route List 
screen, route high-
lighted and activated

From Route list 
screen, route 
highlighted, not 
activated

From Route List 
screen, empty 
route highlighted

Create New Rte
Save Trk to Rte

Deactivate
Advance Leg
Save Trk to Rte

From Route list 
screen, backtrack 
route highlighted, 
activated

Activate Backtrk
Save Trk to Rte

From Route list 
screen, backtrack 
route highlighted, 
not activated
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Setup Menu

Storage
This option allows you to choose the media to which 
ProMark3 will save the data collected in the field. There 
are two possible choices:
• Internal Memory
• SD Card 

In surveying, your choice of storage media is reminded at 
the bottom of the logging screen:
• “SD Card” is displayed inside the lower-right rectangle 

if you chose the SD Card
• Nothing is mentioned in that rectangle if you chose 

the internal memory.

Receiver ID
(Surveying only)
This option provides you with the ability to enter the 4-
character receiver ID which is used in naming the raw data 
files. Each raw data file from this receiver will include this 
4-character receiver ID.
The receiver ID must be unique among all receivers used 
together in a survey. Otherwise, raw data files will be given 
the same name, causing problems when the data is down-
loaded to the same location on the office computer for 
processing.
Valid characters are 0-9 and A-Z.

Antenna Type
This option has already been discussed in the Preparing 
For First-Time Use chapter: See Specifying the Antenna 
Used on page 32.



Real-time Fast Mode
This option allows you to define the way the received RTK 
corrections are processed in the ProMark3 RTK.
Set this option to match your application. Some applica-
tions require the fastest possible position output rate 
whereas some others can do with a slower ouput rate pro-
vided the position accuracy is maximum.
Two settings are possible for this option:
• ON: Enables the real-time Fast mode. The last received 

RTK corrections are extrapolated for the time when the 
next RTK position solution is expected. The “ON” 
option provides the fastest RTK position output rate 
because it is insensitive to possible delays in the 
reception of new RTK corrections from the base.   

• OFF: Disables the real-time Fast mode. The ProMark3 
RTK will wait until a new set of RTK corrections is 
received from the base before it calculates a new RTK 
position solution. With the “OFF” option used, the 
RTK position output rate may be slowed down if for 
some reason, the base experiences delays in transmit-
ting its RTK corrections. However, this option gives 
more accurate position solutions than with the “ON” 
option.
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Select Map
This option is mainly used to choose the background maps 
(vector map and/or raster map) that ProMark3 will display 
on the Map screen. The following parameters can be set 
on the Change Map screen:
- Basemap: Only the Default Map option can be selected 

in this field. The default map – an American or Euro-
pean map – is always present in ProMark3.

- Detail Map: Select the desired vector map from the list 
attached to this field.
Vector maps are IMI files downloaded into the unit 
using GNSS Solutions (see Uploading a Vector Back-
ground Map on page 179) or MobileMapper Office 
(see Uploading a Vector Background Map on 
page 185). Only one vector map can be displayed at a 
time. 
The list attached to the Detail Map field includes IMI 
files from both the internal memory and the SD card, 
whatever the storage setting.
If you did not upload any vector map to ProMark3, 
then Empty is the only option available for this field. 
The extent of a vector map is usually limited to the 
extent of the area you are working in.

- Raster Map: Select the desired raster map from the list 
attached to this field.
Raster maps are TIF files downloaded into the unit 
using GNSS Solutions (see Uploading a Vector Back-
ground Map on page 179) or MobileMapper Office 
(see Uploading a Vector Background Map on 
page 185). Only one raster map can be displayed at a 
time.
The list attached to the Raster Map field includes TIF 
files from both the internal memory and the SD card, 
whatever the storage setting.
If you did not upload any raster map to ProMark3, then 
Empty is the only option available for this field.

After choosing the desired options for these parameters, 
tap Save.
Maps are arranged as follows on the Map screen: raster 
map at the front, basemap at the back, vector map in 
between.



Map Setup screen, 
Format tab

Fixed Rate

Auto

Auto Detailed
Map Setup
This option allows you to set the viewing options for the 
Map screen.
On the Format tab, you can set the following parameters:
- Orientation: You can change how the map is orientated 

on the screen to either North Up, Course Up or Track 
Up. Default is North Up.

- Detail: Use this field to set the detail for both the 
basemap and the detail map. This field can be set to 
highest, high, medium, low or lowest. This changes 
the zoom level that different map objects (cities, high-
ways, labels, etc.) are displayed. If you have set a 
zoom level and the display is too cluttered, set the 
map detail to a lower level; conversely set it to a higher 
level to view more detail.

- Track Mode: Allows you to set how often the ProMark3 
stores track points:
•  Off: Stops the ProMark3 from saving any new track 

points.
• Auto: The ProMark3 uses a method for track point 

storage that maximizes memory. Using Auto, you will 
see more points on and near turns and less points on 
straight stretches of the map.

• Auto Detailed: Same as Auto but with more track 
points on and near turns.

• 2.0 km, 1.0 km,..., 0.05 km, 0.01 km: Fixed time inter-
vals for track point storage.
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Map Setup screen, 
Display tab
Please note that the Track Mode will be automatically  
set to Off when you start logging a new feature in the 
open GIS job (using the Mobile Mapping application). 
This is to avoid confusion on the Map screen between 
features and track points. The Track Mode will be auto-
matically restored with its initial settings when you 
close the GIS job.

- Primary Usage: ProMark3 can be set to either Land or 
Marine usage. When in Land (default), the map dis-
plays land areas in white and water areas in blue. For 
marine applications it may be desirable to reverse the 
display, showing water as white and land as blue. This 
will make reading some of the data information on the 
water easier.

From the Display tab, you can customize the Map screen 
by specifying the items that ProMark3 should display on 
the map:
- Show Map Info: Use this option to show or hide the two 

data fields displayed at the bottom of the Map screen. 
To customize these fields, see Customize on page 244.

- Waypoints (default: checked)
- Track Lines (lines connecting track points if Track Mode 

different from Off; see page 235)
- Pos-Dest Line (line connecting current position to desti-

nation)
- Depart-Dest Line (line connecting initial position to des-

tination)
Check the items you want to show and clear those you 
want to hide. You can also check or clear all these items in 
a single operation by respectively selecting Mark All or Clear 
All just above these items.
Press ESC or NAV to quit the Map Setup screen.



Nav Screens
This option allows you to remove the navigation screens 
that you do not need from the navigation screen sequence 
that you scroll by pressing NAV repeatedly (see page 143).
When selecting this option, you are asked to turn off or on 
each of the available navigation screens. Tap “Off” for all 
these screens that you are not currently using. Note that 
the Map screen cannot be turned off. You must cycle 
through all the screens in order to save any changes to the 
On/Off status of any screen.

Coord System
This option allows you to define a primary coordinate sys-
tem, and also a secondary coordinate system if you need 
one.
By defining a coordinate system, you tell ProMark3 how 
the calculated coordinates should be expressed. For exam-
ple, if you choose Lat/Lon, all coordinates will be expressed 
as angles (latitudes and longitudes) and if you choose UTM 
or any other system, coordinates will all be distances 
(Northings and Eastings) from the chosen origin.
When you select the Coord System option from the Setup 
menu, ProMark3 asks you to specify which system you 
want to define (primary or secondary). Tap one. In the list 
that appears, tap the coordinate system you want to use. 
Depending on your choice, ProMark3 may then ask you 
additional information:
- If you select Lat/Lon, you are then asked to select the 

display format (DEG/MIN.MMM, DEG/MIN/SEC.SS, 
etc.)

- If you select any system other than Lat/Lon or UTM, 
you are asked to choose a scaling factor for displaying 
position coordinates: 1 meter, 10 meters or 100 
meters. If you choose 1 meter, a northing coordinate 
will be displayed as, for example, 249143N. If you 
chose the 10-meter factor, the same coordinate will be 
displayed as 24914N. And if you select the 100-meter 
factor, the coordinate will be displayed as 2491N.

- For some systems, you are asked to supply information 
on grid zones or types
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- For the User Grid, you are asked to supply a projection 
type (Transverse Mercator, Lambert Conic, Stereo-
graphic, Oblique Mercator or Polyconic), coordinates 
of origin, scale factor, unit to meters conversion and 
false Easting and Northing at origin

Notes on Coordinate Systems:
- The ProMark3 always uses the WGS 84 coordinates to 

locate the features and waypoints on the Map screen, even 
if you select some other coordinate system/datum.

- The coordinate systems and datums used to display any-
thing on the Map screen are only for display. When you 
select some other coordinate system/datum, only the num-
bers of the coordinates of a feature/waypoint are changed. 
The map screen is not changed in appearance.

Map Datum
This option allows you to define a primary map datum, 
and also a secondary map datum if you need one.
A map datum is a geographic reference that ProMark3 will 
refer to to calculate the coordinates of your position. 
ProMark3 holds more than 70 different map datums in its 
memory.
After selecting the Map Datum option from the Setup 
menu, tap the map datum that applies to your country and 
working area.



To enter a user map datum, select the term “USER” in the 
list of datums arranged in alphabetical order. Depending 
on the type of map datum you want to define, up to nine 
different parameters, distributed on two different screens, 
may have to be defined:
1st screen:

Semi-major axis (meters)
Inverse flattening
Delta X (meters)
Delta Y (meters)
Delta Z (meters).

2nd screen (select Next> at the bottom of the 1st screen 
to access this screen):

Rotation X (seconds)
Rotation Y (seconds)
Rotation Z (seconds)
Scale factor (ppm).

Tap Done to complete the definition of the user map 
datum. This takes you back to the Map Datum list where 
“USER” is selected. Tap twice to return to the last dis-
played navigation screen.

Time Format
This option allows you to select the time format you want 
to use in ProMark3. You can choose from three different 
time formats: Local 24Hrs, Local AM/PM or UTC.
After selecting the Time Format option from the Setup 
menu, just tap the time format you want to use.
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Units
This option allows you to select the units of measurement 
that will be used when displaying navigational data or fea-
tures being logged.
All sets of units are formatted as follows: long distance unit/
short distance unit/speed unit/area unit. You can select from 5 
different sets of units.
You can also create your own set of units by selecting 
Advanced at the end of the list. You are then prompted to 
specify the unit you wish to use for each type of possible 
measure, i.e. Distance, Speed, Elevation, Bearing and 
Area.
After selecting the Units option from the Setup menu, tap 
the set of units you wish to use. If you have selected 
Advanced, a new list appears prompting you to choose a 
unit for each type of measure. Tap the first measure in the 
list and then tap the desired unit. This takes you back to 
the former screen where you can select the second mea-
sure, etc. When all units are defined, press ESC to come 
back to the Setup menu.

Alarms
All of the Alarm options are set in the same way. The 
instructions below apply to all of the Alarm settings. When 
the beeper is turned on for alarms (see Beeper option) an 
audible beep will be sounded for the alarm. A visual alert 
is displayed for the alarm whether the beeper is turned on 
or off.
Setting the Arrival Alarm: The arrival alarm alerts you that 
you have arrived at the destination of your GOTO route or 
to the destination of any leg in a route you are navigating 
on.



This option allows you to set how close you must come to 
the destination before the alarm begins to sound.
After the alarm sounds, you can reset the arrival alarm to a 
shorter distance, but this shorter distance will apply to the 
next target and not to the current one. If you want the 
alarm to sound again when you come within a shorter dis-
tance to the current target, first select another target des-
tination and then reselect the original target.
Setting the PDOP Alarm: This turns on or off the alarm 
that can sound whenever ProMark3 has lost its ability to 
compute accurate position fixes due to poor geometry of 
the GPS constellation. Generally, PDOP values less than or 
equal to “5” are indicative of good operating conditions. 
So it is a good idea to set this alarm to “5.” To turn off the 
PDOP alarm, enter “00.”
Note: Apart from the Arrival and PDOP alarms, ProMark3 
will generate a warning message on the screen in each of 
the following two cases:
- “Low Memory.” This message will appear when the 

receiver is running out of memory. If raw data is being 
collected with the Surveying function or a GIS job is 
being logged, then the occurrence of this message will 
automatically stop data logging. You will however be 
allowed to enter the attribute values of the current GIS 
feature before the job is closed.

- “Out of Memory.” This message will appear when the 
memory is full. The occurrence of this message will 
immediately end raw data collection or close the cur-
rently open GIS job and you will not be able to log any-
thing until you free some space in memory.

North Reference
This option allows you to define the type of North refer-
ence you want ProMark3 to use. This can be True North, 
Magnetic North, Military True North or Military Magnetic 
North.
After selecting the North Reference option from the Setup 
menu, tap the desired North Reference from the displayed 
list.
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Beeper
This option allows you to enable (On) or disable (Off) the 
beeper.
After selecting the Beeper option from the Setup menu, 
tap the desired option.

Reset Trip
If you tap this option, a warning message is displayed ask-
ing you to confirm your choice. To reset the trip odometer, 
tap the Yes button.

Clear Memory
This option allows you to clear one of the following data 
sets from ProMark3’s memory:
- Track history: Will clear the track shown on the Map 

screen.
- Wpts/Routes: Will clear all waypoints and routes from 

memory.
- Routes: Will clear all routes from memory.
- Reset default: Will reset the receiver by restoring all fac-

tory defaults.
- All: Will clear all memory.

(Clear All does not delete files but only waypoints, 
routes, track and user settings (language), as opposed 
to Delete All in File Manager which deletes all listed files 
but does not impact waypoints, track and routes; see 
page 228.)

After selecting the Clear Memory option from the Setup 
menu, tap the desired choice. ProMark3 will ask you to 
confirm your choice. If you have selected All, ProMark3 
will then exit from the current application to return to the 
ProMark3 workspace screen. It will then automatically re-
launch the same application for which re-initialization will 
be required (user language).



Simulate
This option allows you to set the simulator. It shows you how 
ProMark3 uses its various functions based on a simulated 
journey. The simulator is useful for learning or demonstrating 
ProMark3’s GPS functions when indoors and there is no GPS 
reception. When the simulator is on, ProMark3 quits normal 
operation to operate in the simulator mode. You can choose 
one of the following three options when you access the Simu-
late option:

- Off: Will turn the simulator off. ProMark3 will return to 
normal operation

- Auto: Will turn the simulator on. A predefined heading 
and speed rate will be used.

- User: Will turn the simulator on. A user-defined head-
ing and speed rate will be used.

After selecting the Simulate option from the Setup menu, 
just tap the desired choice.
If you have selected User, ProMark3 will then ask you to 
enter heading and speed data.

Language
This option allows you to select the language that 
ProMark3 will use to display text.
TIP: If you accidentally set the language to one you cannot 
read and want to get back to the Language Select screen, 
follow these instructions. Press MENU. Tap the fifth item 
in the list and then tap the last item in the new list. You 
are back at the Language Select screen.
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The Map screen must be in 
Position mode if you wish 

to customize data fields. If 
the Map screen is in cursor 

mode (cursor is a cross-
hair), press ESC to return 

to the Position mode.

Available data:
BEARING

DISTANCE
SPEED

HEADING
VMG (Velocity made good)

CTS (Course to steer)
ETA (Estimated time of 

arrival)
ETE (Estimated time 

enroute
XTE (Crosstrack error)

Turn
Elevation

Time
Date

EPE (Estimated Positional 
Error)

Avg. Speed (Average 
speed)

Max Speed
Customize

Except for the Satellite Status screen, all navigation screens 
can be customized through the following procedure:
• Press NAV repeatedly until the desired navigation screen 

is displayed
• Press MENU
• Tap Customize. Additionally for the Map screen, tap Cus-

tomize Fields.
• On the Navigation screen now shown in edit mode, high-

light the data field to be changed using the left/right arrow 
and press ENTER

• Choose the data in the list that you wish now to display in 
this field. Press ENTER. Data change in the field is imme-
diate.

• Resume this procedure for all the fields that need to be 
changed on this screen and on the other navigation 
screens.

If you select Customize when the Map screen is displayed, an-
other option an additional menu is displayed showing two op-
tion:
- Customize Fields: This option is described above
- Street info: If you select this option, the bottom of the Map 

screen will display the name of the street you are currently 
walking or driving along. To re-activate the first option, 
press MENU, tap Customize and then Two Data Fields.

About...

The About... screen displays the current status of your 
ProMark3.
Using the About... screen you can see the serial number of the 
receiver, the version of software, the version and memory size 
of the basemap and the memory space percentage occupied 
by data & maps, routes and waypoints.

Exit

This option allows you to quit the Surveying or Mobile Map-
ping application that is currently running and return to the 
ProMark3 workspace screen.



15.Power Management

ProMark3 comes with a removable/rechargeable battery, 
which provides enough energy for a full working day –provided 
you start your day with a fully charged battery. In order to en-
sure a longer battery life, use the external power whenever 
possible. When used, the external power source also automat-
ically recharges the internal battery.

Power Saving Modes

The built-in advanced power saving features also help to opti-
mize power consumption while the system is idle. The 
ProMark3 system has two power saving modes when the inter-
nal battery is used:
1. User Idle state: A state in which you are using the 

ProMark3 but not actively interacting with it. For example, 
you may be only looking at the display and not interacting 
with the system.

2. System Idle state: A state in which you are not directly 
using the ProMark3 but processes in the unit are still 
active.

You can configure the ProMark3 to automatically enter each 
state when it has been idle for a specified time.
To change the idle times, from the ProMark3 workspace 
screen, double-tap the Settings icon and then the Power icon. 
Then make the necessary changes on the Schemes tab (see op-
posite.)
We recommend that you keep the default setting (“Never”) for 
the last field.
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Backlight Control

To adjust or turn on and off the backlights manually, first exit 
from the Surveying or Mobile Mapping function if you are 
working with one of these functions. Then from the ProMark3 
workspace screen, double-tap the Settings icon. A list of func-
tions is now displayed on the screen. Double-tap Backlight Con-
trol.
In the window that opens (see figure opposite), you can do the 
following:
- Adjust separately the brightness for the keypad and the 

brightness for the screen by dragging horizontally the cor-
responding cursors on the screen

- Adjust the screen contrast by moving the corresponding 
cursor.

- Tap the Backlight OFF button to turn off the backlight
- Tap the Backlight ON button to turn on the backlight

The backlight can also be turned off automatically after a 
user-set time delay. This delay will add up to the delay re-
quired before ProMark3 enters the User Idle state (see 
page 245). For example, if the ProMark3 switches to the User 
Idle state after 2 minutes of inactivity and the Backlight Off 
time delay is 15 seconds, then the backlights will turn off af-
ter 2 minutes and 15 seconds of inactivity.



To enable and set the Backlight-Off time delay, first exit from 
the Surveying or Mobile Mapping function if you are working 
with one of these functions. Then from the ProMark3 work-
space screen, double-tap the Settings icon and then the Dis-
play icon. On the Backlight tab (see opposite):
- Check each of the two boxes on the left and then choose a 

Backlight-Off time delay for each case of power source 
(battery or external)

- Tap OK to close the dialog box.

After the backlights have been automatically turned off 
through this process, it is very easy to turn them back on: you 
just need to press a key or touch the screen.

Checking Battery Status

From the ProMark3 workspace screen, double-tap the Settings 
icon and then the Power icon. Tap the Battery tab. This tab pro-
vides a visual indication of the the battery level (see opposite).
Note that it takes a few minutes after you have turned on the 
unit before this tab indicates the accurate status of the bat-
tery.
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Power

Charge
LED Indicators

The charge LED will give charging information only if the re-
ceiver is on.

Turning Off ProMark3

Press the red key until the Shutdown window appears. Tap OK 
to confirm that you want to turn off the unit. As a result, the 
unit instantly shuts down.

Power LED (Green) Indicates:
Off Device Switched Off

Solid Green Power On

Charge LED (Amber) Indicates:
Off Not charging

Solid Amber Battery is fully charged
Blinking Amber Battery is charging



16.Diagnostics & Upgrade Tools

This chapter focuses on the different ProMark3-embedded 
tools that allow you to test the operation of your ProMark3.

Testing ProMark3’s Internal Peripherals

Use the Tests utility.
This utility can be found in the Utilities folder. To run this util-
ity from the ProMark3 workspace screen, double-tap the Utili-
ties icon and then the Tests icon.
The Tests utility allows you to test various elements in the unit, 
namely USB, keypad, LCD, touch screen, speaker, serial port, 
Bluetooth and SD card.
After launching Tests, tap Start. All the tests are then run in 
succession. You can skip the test in progress by tapping Skip, 
or all the remaining tests by tapping Skip All.
USB test: Plug a Mass Storage USB device, wait about 10 
seconds and then tap OK.
If the test is successful, the unit will switch to the next test.
If the test fails, a Failed button will appear at the bottom of the 
screen, next to the OK button. You can either retry the test by 
tapping OK, or acknowledge that the test failed by tapping the 
Failed button. The unit will then continue with the tests.

Keypad test: Successively press the key corresponding to the 
white spot shown on the screen. If the key is pressed success-
fully, the spot turns green and a new white spot appears on an-
other location on the screen prompting you to press the 
corresponding key, etc. Tap OK at the end of the test.
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LCD test: Consists of displaying different colors and shapes 
with different levels of brightness and contrast. There is no 
user action required. This test can be skipped by pressing the 
ESC key.

Stylus test: Follows automatically.  Takes place as described 
in Calibrating the Screen on page 29. You can skip that test 
by pressing the ESC key.

Speaker test: Tap Passed after the speaker has correctly emit-
ted three different sounds with increasing volume. The test 
will be repeated indiefinitely until you tap Passed (or Failed if 
the test failed).

Serial Port test: You first need to connect a female plug on the 
ProMark3 I/O module’s RS232 port on which pins 2 and 3 
have been shorted. Then tap OK to start the test.

SD card test: You first need to insert an SD card in the unit 
and then tap OK.

At the end of the tests, the initial dialog box reappears on 
which you can see the tests that passed and those that failed.  
Note that Bluetooth is tested through an internal routine (see 
BT ADDR:... line).
Tap OK to close the Tests dialog box.



ProMark3 Serial Number & Versions

Use Magellan System Info.
This module can be found in the Settings folder. To run this 
module from the ProMark3 workspace screen, double-tap the 
Settings icon and then the Magellan System Info icon.
This module provides the following information on the hard-
ware, software and GPS section currently installed in your 
ProMark3:
• Hardware:

- Serial Number
- BT MAC Address

• Software:
- OS F/W Version
- EBoot Version

• GPS:
- GPS F/W Version
- GPSData Server.

Upgrading ProMark3 Software & Firmware

Use AutoLoader.

This utility can be found in the Utilities folder.
When Magellan releases new ProMark3 software or firmware 
(in the form of a single txt file), you will have to:
- Copy the txt file to an SD card
- Insert that SD card into your ProMark3
- Launch the AutoLoader utility: from the ProMark3 work-

space screen, double-tap the Utilities icon and then the 
AutoLoader icon

- Select the TXT file you need to load and then let the Auto-
Loader utility complete the upgrade for you.
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ProMark3 Reset Procedures

Hardware Reset
Shuts down the unit.
Use the following key combination to hardware-reset the 
ProMark3 unit:

ESC+ENTER+Red Power key.

Software Reset
Restores the factory settings.
Use the following key combination to software-reset the 
ProMark3 unit:

LOG+IN+MENU



17.Utilities & Settings

This chapter lists all the utilities and setting modules embed-
ded in the ProMark3 unit. It gives details for all those utilities 
and setting modules that are not addressed elsewhere in the 
present manual. For all others, cross-references are provided.

Utilities

To run a utility from the ProMark3 workspace screen double-
tap the Utilities icon and then double-tap the icon of the utility 
you want to run. You can only run one utility at a time.

DGPS Configuration
Refer to Selecting a DGPS Mode on page 209.

Install FAST Survey (and Datum Grids)
This utility allows you to install FAST Survey as well as the 
grids you may need for your applications. Remember however 
that installing FAST Survey is not enough to be able to run this 
software on your ProMark3 RTK. You also need to unlock the 
software by entering the product key you ordered to your Ma-
gellan dealer (see Unlock FAST Survey on page 254).
The FAST Survey installation files have been ProMark3-
resident files since the release of the ProMark3 RTK version 
in June 2007 (English or Chinese). For ProMark3 units 
purchased from this date, you just need to launch the Install 
FAST Survey utility to install it. If your ProMark3 unit is older 
or you wish to install another language, please refer to Getting 
ProMark3 Ready for FAST Survey Installation on page 267 to 
know what to do.
Installing FAST Survey may also include the installation of the 
grids you need for your applications. To let the utility also in-
stall grids when installing FAST Survey, do the following:
1. Insert the FAST Survey CD in the CD drive of your office 

computer.
2. Browse the CD to find the “Grids” folder containing the 

list of available grids. Grids are available as CAB files.
3. Insert the ProMark3 SD card in the card reader of your 

office computer.
4. Create a “Grids” folder in the root directory of the SD 

card. Copy the grid files you need from the Magellan FAST 
Survey CD to the “Grids” folder on the SD card.
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5. Remove the SD card from the card reader and insert it into 
the ProMark3 unit.

6. Run the Install FAST Survey utility. The utility lists the 
grids stored on the SD card.

7. Check on the grids you want to install.
8. Tap the Install button and then let the unit complete the 

installation of both FAST Survey and the selected grids.

NOTE: If you want to install FAST Survey and you don’t need 
to install a grid, just launch the utility, make sure FAST Survey 
is checked on, and tap Install.

Unlock FAST Survey
This utility allows you to unlock the FAST Survey software op-
tion. You first need to order FAST Survey to your Magellan 
dealer. You will receive in return the product key that will allow 
your unit to run FAST Survey.
To unlock FAST Survey, launch the Unlock FAST Survey utility 
and type in the product key. After tapping OK, a message will 
inform you that FAST Survey has successfully been unlocked. 
FAST Survey will be usable only after you have installed it (see 
Install FAST Survey (and Datum Grids) on page 253).

Unlock RTK Option
This utility allows you to unlock the RTK function. Typically, 
you use it to upgrade your ProMark3 into a ProMark3 RTK af-
ter you have ordered and received the product key that is suit-
able for your unit.
Before unlocking the RTK function, you need to download the 
ProMark3 RTK firmware from the Magellan FTP server and 
copy it to your ProMark3 (see Installing the ProMark3 RTK 
Firmware on page 267).
Then you can launch the Unlock RTK option utility and type 
in the product key. After tapping OK, a message will inform 
you that the RTK function has been activated.

Desktop Properties
This utility allows you to add a shortcut icon on the ProMark3 
workspace for every application or tool you enable on this 
screen.
Every time you press OK after you have made changes to this 
screen, you will be asked to reboot the device to make the new 
desktop configuration effective.



GPSInit
This utility is in fact used when first using your ProMark3. Re-
fer to Initializing GPS on page 30 in this manual or to the 
ProMark3 Getting Started Guide.

GPSReset
This utility allows you to re-apply the default settings to the 
GPS section of the ProMark3. When you tap Cold Reset, 
ProMark3 clears such data as almanac and iono data, etc. 
used by the GPS section.
You usually need tu run a cold reset after installing new firm-
ware or software in your ProMark3.

AutoLoader
Refer to Upgrading ProMark3 Software & Firmware on 
page 251.

Tests
Refer to Testing ProMark3’s Internal Peripherals on page 249.

Radio Configuration
This utility is used to set the radio modem connected to the 
ProMark3 RTK.
The Magellan radio modems being plug-and-play units, you do 
not normally have to change their settings. However, you may 
want to change the radio channel to get rid of a possible jam-
ming signal.
When you launch the Radio Configuration utility, the message 
“Please wait while detecting radio...” is displayed for a few 
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seconds. Then depending on the radio modem used, the fol-
lowing screen is displayed:

With the US model, you can only change the channel number 
(0.. 49).
With the European model, you can change both the channel 
number (0.. 2) and the RTCM Rate (1 or 2). With RTCM 
Rate=1, you are sure you will always meet the 10% duty cycle 
requirement. With RTCM Rate=2, the radio may not always 
meet this requirement.
Note that the settings of the serial line between ProMark3 
RTK and the radio cannot be changed. These settings are as 
follows: 9600 Bd, no parity, 8 data bits, no stop bit.

Install Language
This utility allows you to change the interface language used 
by the operating system. Three languages are available in 
ProMark3: English, Chinese and French.
ProMark3 units leaving the factory only have English installed. 
To install the Chinese or French language, please refer to In-
stalling New OS Languages (Chinese, French) on page 266. 

US model European model



Settings

To run a setting module from the ProMark3 workspace screen, 
double-tap the Settings icon and then double-tap the icon you 
want to run. You can only run one setting module at a time.

Backlight control
See Backlight Control on page 246.

Bluetooth Manager
The ProMark3 is equipped with built-in Bluetooth technology 
that allows short-range connections to other Bluetooth-en-
abled devices such as a cell phone or MobileMapper Beacon.
 Use theBluetooth Manager to find, configure and establish 
connections to other Bluetooth devices.
For more information, refer to Bluetooth Manager Module on 
page 190.
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Date/Time
This module allows you to set the date, time and time zone. 
The time zone you choose in this module impacts the local 
time displayed in the Surveying and Mobile Mapping applica-
tions. This module also allows you to ask for automatic clock 
adjustment for daylight saving.
Changing the time in this window also updates the time run-
ning in the GPS Init utility (see page 255). So it’s a good idea 
to set this window before running the GPS Init utility.
When the GPS section of the receiver has been initialized, the 
time displayed in this window comes under GPS control which 
means the time field provides the GPS time. This usually hap-
pens about 40 seconds after initialization is effective. From 
this time, you should not change the time in this window.
 

Display
This module is used to:
• Choose the screen background
• Enable and set two Backlight-Off time delays that will be 

activated after the ProMark3 switches to the User Idle 
state (refer to Backlight Control on page 246).

Keyboard
This module allows you to refine the keyboard settings (repeat 
delay and repeat rate) for optimum use.

Magellan System Info
Refer to ProMark3 Serial Number & Versions on page 251.



Owner
This module is used to identify the unit using the following in-
formation about the user: name, company, address, work 
phone and home phone. To be able to see all the fields in this 
dialog box, you will have to tap and hold the keyboard from its 
title bar and drag it upward or downward.

Power
Refer to Power Management on page 245.

Regional Settings
This module is used to perform various local settings such as 
number, currency, time & date formats. Default settings can 
be obtained in one operation by selecting your language/coun-
try on the Region tab.

Stylus
As explained on the screen, the first tab allows you to set and 
test your double-tap actions.
The second tab allows you to recalibrate the screen as ex-
plained in Calibrating the Screen on page 29.
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System
This three-tab window gives information on the internal com-
ponents of the ProMark3 system.

Volume & Sounds
This module allows you to make volume and sound settings.



Alarm Acknowledge:

Tap anywhere on the 
screen outside of the alarm 

window to acknowledge 
(erase) the alarm message.

The “Not enough satel-
lites...” and “No external 
antenna...” messages will 
also automatically disap-
pear when the condition 

that triggered the message 
also disappears. 
18.Appendices

Main Alarm Screens

Alarm message Description & Action Required
(Surveying only)
You are trying to start data collection with no exter-
nal antenna connected to the unit. Please connect 
the external antenna using the appropriate cable 
and resume data collection.
The internal battery is low and the unit will very 
shortly be unable to function properly. Please 
acknowledge the alarm, quit the current applica-
tion, turn off the unit and replace the battery before 
doing anything else.
The internal memory or SD card you are using for 
data collection is almost full. Do one of the follow-
ing: 1) If possible, free some  memory space using 
the File Manager command, 2) Switch to the other 
possible medium using the Setup>Storage com-
mand or 3) Replace the SD card if you work exclu-
sively with SD cards.
You were using the AC adapter as the power 
source for the unit and you have just unplugged it. 
The unit is now powered from its internal battery. 
Just acknowledge the alarm.
If you are not collecting data, the unit warns you 
that it would be unable to collect data at your cur-
rent location due to poor GPS reception conditions: 
Move to a better location.
If a survey is in progress (Stop & Go or Kinematic 
without initialization or –less likely– Static), the unit 
warns you that it has stopped collecting data until 
the reception conditions improve.
You are performing a stop-and-go or kinematic sur-
vey that you initialized with the initializer bar or at a 
known point. Poor reception conditions have trig-
gered this message. Whether these conditions are 
intermittent or persistent, you must now acknowl-
edge this message and resume all or part of the 
survey (see Re-Initialization on page 118).
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File Naming Conventions

Survey Data Collection
Any file created while collecting survey data is named accord-
ing to the following conventions:

The session ID increments A-Z, which provides up to 26 
unique session IDs for any given day number. If more than 26 
files are collected in one day, the first digit of the year is used 
as part of the session ID. The following file list illustrates the 
session ID incrementing scheme:

O2050A07.133 ... O2050Z07.133
O2050AA7.133 ... O2050ZA7.133
O2050AB7.133 ... O2050ZB7.133, etc.

    2050A05.257

Day number when file was created
Year (last 2 figures only)
Session ID
Receiver ID
File Prefix (“R” for raw data files, “O” for RTK data 
files (vectors)

O
R



GIS Post-Processing
Suppose you have created a new job named “JOB1.MMJ.” 
You selected the post-processing job mode in ProMark3 so 
that it records GPS measurement files in addition to 
JOB1.MMJ. The table below illustrates how these files will ap-
pear at various stages of the differential correction process:

Suppose you have logged a reference station file on ProMark3. 
The table below illustrates how the resulting files will appear 
at various stages of the differential correction process:

The rover files with a B, D, E or W in the extension represent 
files with different GPS measurements all related to the orig-
inal rover file. MobileMapper Office handles the information 
in these files automatically. But if you archive your files, you 
should include them in the archived directories.
The reference files that start with B, D, E or W are similarly 
handled automatically by MobileMapper Office but should be 
archived together with the rover files.
Reference files recorded by non-ProMark3 receivers may have 
other naming conventions.

Rover file seen on receiver JOB1.MMJ
Rover file seen on MobileMapper Transfer’s left 
window, before download JOB1.MMJ

Rover file seen on MobileMapper Transfer’s right 
window, after download JOB1.MMJ

Rover files seen with Windows Explorer, after 
download

JOB1.MMJ, JOB1.B00, 
JOB1.D00 and JOB1.E00

Rover file seen on MobileMapper Office’s Differ-
ential Correction window JOB1

Reference file seen on receiver 
R0001a06.014 (for 1st file logged 
at point 0001 on the 14th day of 
2006)

Reference file seen on MobileMapper Trans-
fer’s left window, before download

0001a06.014 (for the first file 
recorded at reference station site 
ID 0001 on the 14th day of 2006

Reference file seen on MobileMapper Trans-
fer’s right window, after download

b0001a06.14, d0001a06.14, 
e0001a06.14 and w0001a06.14

Reference files seen with Windows Explorer, 
after download

b0001a06.14, d0001a06.14, 
e0001a06.14 and w0001a06.14

Reference file seen on MobileMapper 
Office’s Differential Correction window b0001a06.14
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Ordering Information

NOTE: Magellan reserves the right to make changes to this list 
without prior notice.

Item Designation Part
Number

I/O Module 980808

USB Cable 730396

AC Adapter/Charger 980783

External GNSS Antenna 110454

External Antenna Cable 702058

Vertical Antenna Extension 103717

Field Receiver Bracket 702065

HI Measurement Tape 111146

Field Bag 111132



ProMark3
User Documentation 501497

Initializer Bar and Antenna 
Adaptor 800954

GNSS Solutions CD 702081-01

MobileMapper Office CD 501498

FAST Survey license for 
ProMark3 RTK (includes 

FAST Survey CD)
990590

RTK
Vertical Antenna Extension 111362

Pair of license-free radios for 
Europe (EU), each radio 

includes radio modem with 
data cable, bracket and velcro 

tape

990580

Pair of license-free radios for 
North America (NA), each 

radio includes radio modem 
with data cable, bracket and 

velcro tape

990581

Radio bracket 702102

Battery pack (Li-ion) 980782

Item Designation Part
Number
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Installing New OS Languages (Chinese, French)

To install the Chinese or French version of the operating sys-
tem into your ProMark3, you need an office computer with a 
card reader that is compatible with the SD card used in the 
ProMark3. 
Assuming the currently running ProMark3 operating system is 
in English, follow the instructions below:
1. Insert the SD card from your ProMark3 into the SD card 

reader on your office computer.
2. Copy the “language.CAB” file from the /Chinese/ or 

/French/ folder to the root directory of the SD card.
3. After the file has been copied, remove the SD card from 

the card reader and insert it back into the ProMark3.
4. Power on the ProMark3. Double-tap the “Utilities” and 

then the “Install Language” icons.
5. Tap the Add button. The “language.CAB” file is automati-

cally copied to the ProMark3 RAM memory and then 
installation begins. At the end of this phase, the “lan-
guage.CAB installed successfully” message is displayed.

6. Tap OK.
7. Select “Chinese” or “French” from the Active Language 

combo box and then tap on the OK button. A new message 
(“Please reboot the device!”) asks you to turn off the 
ProMark3.

8. Tap OK to close the message window, then OK again on top 
of the screen to close the Install Language window.
9. Press the red key to turn off the ProMark3. When next turn-
ing on the ProMark3, the operating system and the utilities 
(notably DGPS Configuration and Bluetooth Manager) will run 
in Chinese or French. Note that most of the icons will keep 
their original English names.



Installing the ProMark3 RTK Firmware

For all ProMark3 units purchased before June 2007, and for 
all those units purchased after this date without the RTK func-
tion, you first need to download the ProMark3 RTK firmware 
from the Magellan FTP server. The firmware is available as a 
zip file. Follow the instructions below:
- Download the zip file to your office computer.
- Extract the files from the zip file, making sure you pre-

serve the folder structure while doing this.
- Insert the ProMark3 SD card into the card reader of your 

office computer. Delete all possible TXT files present on 
the SD card.

- Copy the unzipped files and folders to the ProMark3 SD 
card.

- Remove the SD card from the card reader and insert it into 
the ProMark3.

- On the ProMark3, double-tap Utilities and then AutoLoader.
- Select in turn each of the TXT files listed in the Auto-

Loader window and each time, tap OK. For each TXT file, 
let the unit complete the installation.

Getting ProMark3 Ready 
for FAST Survey Installation

For all ProMark3 units purchased before June 2007, you need 
to copy the installation files on the ProMark3 SD card before 
starting the FAST Survey installation procedure. Follow the in-
structions below:
- Browse the FAST Survey CD, or the Magellan FTP server, 

to access the “FAST Survey.CAB” file corresponding to the 
language you want to install.

- Copy this CAB file to the root directory of your ProMark3 
SD card.

- Remove the SD card from your local card reader and insert 
it into the ProMark3.

Then install FAST Survey as follows:
- On ProMark3 RTK, run the Install FAST Survey utility.
- Make sure the FAST Survey button is checked on.
- Tap Install and then let the unit complete the installation 

of FAST Survey.

NOTE: To install datum grids, please see page 253.
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Installing Optional Functions in FAST Survey

To purchase an optional FAST Survey function (Total Station 
or GPS), first run FAST Survey, go to Equip> About Fast Sur-
vey>Change Registration and read the registration code on the 
Product Registration screen.
Provide your registration code when ordering an optional func-
tion.
You will receive in return a Serial Number and a Change Key 
specific to your FAST Survey license. Enter these two codes 
on the same Product Registration screen to activate the func-
tion.
When enabled, the Total Station (TS) and GPS options make 
more equipment available from the list of instruments in the 
Equip tab >Instrument function, thus allowing you to use FAST 
Survey with ProMark3 RTK connected to a third equipment.

Using Another Radio Model

For some reason, you may want to use another radio model. In 
this case, because you need the special connector used on the 
ProMark3 side, you should continue to use the Magellan Pow-
er/Data cable and connect your radio to the other end of the 
cable. 
To use this cable, first disconnect it from the Magellan radio 
modem. This is simply done by unscrewing the base of the 
Magellan radio modem and then removing each of the cable 
wires from the screw terminal block. The cable pinout is given 
below.

Note that the settings of the serial line between 
ProMark3 RTK and your radio cannot be changed. These set-
tings are as follows: 9600 Bd, no parity, 8 data bits, no stop 
bit.

Wire Color Signal Name
White TX (Data)
Red +DC IN

[Braid] Ground
Yellow +5 V DC OUT
Blue RX (Data)



Assessing MobileMapper Beacon 
Reception Quality
As long as the green lock indicator light on MobileMapper 
Beacon stays on, you can be certain that ProMark3 can readily 
deliver a DGPS solution using the incoming correction data 
packets from MobileMapper Beacon.
But if you notice that the green indicator light on MobileMap-
per Beacon sometimes temporarily turns off, this means the 
signal received is not as strong as it should be. The reasons 
for this are the following:
- Too many obstructions between you and the station. See 

how you can limit these obstructions.
- Or you are nearly out of range of the station. Consider 

working with a closer station, if possible.
- Or atmospheric noise has significantly increased thus 

reducing the SNR. Consider working with a station that 
would give a better SNR.

ProMark3 gives you the ability to analyze the key reception pa-
rameters of the MobileMapper Beacon. You can do this any-
time, when setting the DGPS beacon mode, or later while 
using the beacon provided you first ask ProMark3 to stop pro-
cessing the incoming correction data packets. This is done by 
tapping the Disconnect button in the DGPS Configuration win-
dow. You can then tap on the Settings button and then on the 
Details button to view the Beacon Details screen. (See also 
page 213.)
Among all the parameters displayed on this screen is the Sig-
nal to Noise Ratio (SNR). This is the most important parameter 
to look at.
The table below gives indications on how safe DGPS operation 
with MobileMapper Beacon will be, depending on the value of 
the SNR. 

SNR DGPS Data Reception Quality
SNR<10 dB Very Critical; DGPS mode steadiness is very unlikely.

10 <SNR<20 dB Good but critical; if signal deteriorates, even slightly, 
ProMark3 won’t be able to maintain DGPS mode.

SNR>20 dB
Excellent; there is signal level “in reserve”, which means even 
if the signal slightly deteriorates, DGPS mode will be main-
tained.
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Glossary

Attribute: A description item of a feature.
Attribute value: One of the possible values that can be ascribed to a 
feature.
Base: A reference station operated in static mode.
B-File: A binary data file containing
GPS measurement data.
Baseline: A three-dimensional vector connecting the base to the rover. 
The baseline length is the vector modulus.
Carrier phase data: Phase angle measurements for the 1575 MHz ra-
dio wave carrying the GPS coded messages. Using carrier phase data 
greatly improves GPS accuracy.
Datum: A mathematical definition of a surface from which coordi-
nates of a given system are referenced.
D-File: A binary data file created by field collection software and 
stored in the receiver.
DGPS: Differential GPS. A technique whereby data from a receiver at a 
known location is used to correct the data from a receiver at an unknown 
location. Differential corrections can be applied in real-time or by post-
processing. Since most of the errors in GPS are common to users in a wide 
area, the DGPS-corrected solution is significantly more accurate than a 
normal autonomous solution.
Differential Correction: The process of:
(1) calculating how much to adjust GPS measurements to reduce the 
difference between a location's surveyed coordinates and the coordi-
nates calculated by a GPS receiver that is kept stationary over that 
point; and
(2) the application of these adjustments to the GPS measurements re-
corded by any number of receivers within a few hundred kilometers of 
the "reference receiver."
Differential GPS: See DGPS.
Direct IP: (IP=Internet Protocol) A way of acquiring base data (corrections) 
from the Internet via GPRS. When setting Direct IP in a receiver, you must 
specify the IP address of the corrections provider.
E-File: A binary data file containing GPS ephemeris data.
Ephemeris Data: Information transmitted from a satellite which al-
lows the GPS receiver to determine the satellite’s position in space.
Export: Converting MobileMapper data files to GIS Formats and writ-
ing them to any directory visible to the PC.
Feature: Any element located in the field that you wish to record for 
further uploading into a GIS database for example. A feature can rep-
resent a real object (streetlight, park, electrical transformer, etc.) or 
on the contrary, something invisible or impalpable (gas, noise level, 
dose of fertilizer, etc.).
Each new feature that you log in the field can only be an “emanation” 
or “offshoot” of one of the feature types described in the feature type 
library associated with the job in progress. The logging procedure will 
be different depending on the type of the feature you are logging.



To log a feature: Means to save the characteristics of a feature 
into the receiver memory. The user is in charge of entering the 
description of this feature whereas the receiver is responsible for 
saving the GPS position(s) it has determined on this feature.
To describe a feature: Means to give each attribute of the feature 
one of the prompted values for this feature.

Feature Library: A file containing all the feature types required for a 
given job. (In fact we should say “Feature Type Library”.)
Feature Type: An item present in a feature library. Each feature type 
is defined by a geometry type, a name, a certain number of possible 
attributes and the list of possible values for each attribute. There are 
four different geometries in feature types: point, line, area and grid.
Field: Any area on the receiver screen dedicated to displaying the val-
ue of a parameter. Some fields are user-editable, some others are not.
Fixed: Position solution status achieved by a receiver operating success-
fully in RTK mode. Position accuracy is in the order of one centimeter.
Float: Intermediate position solution status obtained in a receiver attempt-
ing to operate in RTK mode. Position accuracy is also intermediate as it is 
only in the order of a few decimeters.
Geographic Information System: A system of digital maps, data anal-
ysis software and a database of features, attributes and geographic lo-
cations.
GIS: See Geographic Information System.
GNSS: Global Navigation Satellite System. GPS, GLONASS and the future 
Galileo are each a GNSS.
GPRS: General Packet Radio Service. A mobile data service available to 
cell phone users. GPRS data transfer is typically charged per megabyte of 
transferred data, while data communication via traditional circuit switch-
ing is billed per minute of connection time, independent of whether the 
user has actually transferred data or he has been in an idle state.
GPS: Global Positioning System. Passive, satellite-based navigation sys-
tem operated by the Department of Defense of the USA. Its primary mis-
sion is to provide passive global positioning/navigation for land-, sea-, and 
air-based operations.
GPS satellite geometry: The satellite distribution at a given location. 
measured by the PDOP index
GPS signal multipath: Occurs when the GPS signal arrives at the an-
tenna by a path other than a straight line. Multipath signals make the 
receiver think that a GPS satellite is farther away than it is and the 
resultant position is inaccurate.
GSM: Global System for Mobile communications. The most popular stan-
dard for mobile phones in the world.
HRMS: Horizontal Root Mean Square. A statistical measure of the scatter 
of horizontal computed positions about a “best fit” position solution. It 
gives you a good indication of how well the unit performs.
Initialization: • A process used at power-on to help a GPS receiver more 
easily determine its own location. The solution is of the GPS standalone 
type (accuracy is a few meters).
• For an RTK rover, once GPS initialization is achieved, a process through 
which the receiver can solve integer ambiguity from which it can deliver a 
fixed solution with centimeter accuracy. 
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Job file: File containing a feature type library and a collection of fea-
tures that grows as you log new features in the field with this job file 
open. All the features in the job file necessarily “originate” from the 
feature types present in the job file’s feature type library.
Nesting: This word is used to describe a feature that you are logging 
whereas another feature is already being logged.
NTRIP: Networked Transport of RTCM via Internet Protocol. A protocol 
used by GNSS service providers to deliver corrections from their networks 
of reference stations. When setting NTRIP in a receiver, you must specify 
the mount point (an IP address) of the NTRIP provider as well as your per-
sonal user profile. 
PDOP: Positional Dilution of Precision. An accuracy factor derived 
from the geometry of the constellation of GPS satellites used to cal-
culate a position. In general, the more widely distributed the satellites 
are in the sky, the greater the accuracy. In general, PDOPs less than 
10 are good.
Post-processing: Differential corrections applied to GPS positions in 
a PC - after both rover and reference data are logged and downloaded.  
Post-processing is slower but more accurate than real-time differen-
tial correction.
Rover: The mobile unit that you carry with you during your field operations.
RTCM: Radio Technical Commission for Maritime Services. Common-
ly refers to a format of real-time DGPS format.
Reference Station: A stationary GPS receiver logging, or broadcasting, 
data from a known point. The data is used for differential correction. 
Reference Station is synonomous with Base Station.
RINEX: Receiver Independent Exchange Format. A “universal” GPS 
measurement data format designed to allow compatibility b tween dif-
ferent brands of GPS receivers.
RTK: Real Time Kinematic. An algorithm run in a receiver that allows its 
position to be determined in real time, with centimeter accuracy.
UHF: Ultra High Frequency band. Magellan radio modems use this fre-
quency band.
VRMS: Vertical Root Mean Square. A statistical measure of the scatter of 
vertical computed positions about a “best fit” position solution. It gives 
you a good indication of how well the unit performs.
Shapefile: A set of GIS files invented by ESRI but published as an 
open file standard readable by most GISs.  A shapefile consists of a 
map file (SHP),  a file containg feature descriptions (DBF), a file re-
lating the map locations with the feature description (SHX)  and 
sometimes a file containing coordinate system information (PRJ).
Waypoint: A pre-determined coordinate point to which a GPS receiver 
can navigate. GPS receivers can also log waypoints in the field for lat-
er navigation. GPS for GIS receiver have largely replaced waypoints 
with point features.
W-File: A binary data file containing SBAS data.
WGS-84 coordinate system: World Geodetic System, 1984. The coor-
dinate system is used by GPS receivers for computing their positions.
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- sign 228
Symbols
# Sats 94, 107, 116
*99# 198
+ sign 228
Numerics
3D/2D 225
A
Absolute positioning 36
AC adapter 5
AC adapter/charger 27
Accuracy 224
Adaptor (antenna adaptor) 7
Age 52, 54
Alarm screens 261
Alarm, Arrival 240
Alarm, PDOP 241
Almanac 81
Alphabetical 154
Antenna Height 51, 53, 55, 91, 102, 112
Area measurement 174
Attribute (feature attribute) 21
Authentication 193
Autoloader 251
Automatic tuning 212
Averaging 148
B
Backlight 29
Backtrack 160
Bag (field bag) 6
Base 34
Base position 36
Base station 17, 18
Baseline 35, 52, 54
Basemap 234
Battery door 3, 27
Battery pack 27
Beacon 209, 210, 211
Bearing, offset 132
Beeper 242
Bluetooth 257
Bluetooth Manager 46, 197, 201, 257
Boundary survey 75
Bracket (field bracket) 6
C
Cable (antenna cable) 5
Calibrating the screen 29
Carrier 206

Cellular modem 34
Clear, memory 242
Closed-loop traverse 75, 76
Coast Guards 224
Collected data 74
Columns, grid feature 136
Compass 149, 150
Compass screen 145
Control Point 92
Control points 181
Control points, non-fixed 181
Coordinate system 23
Coordinate systems 237
Corrections 34
CSV 22
Current

Constellation 82
Cursor mode (map screen) 144
Custom map datum 23
Customize 244
Customize Fields 244
D
Data link 34
Data screen 150
Date and time 258
Datum 23
DC Power Input 4
Depart-Dest Line 236
Detail 235
Detail map 180, 234
DGPS 148
DGPS Configuration 212, 214, 216, 219, 
220
Dial-up Networking 203
Direct IP 45, 209, 214
Direction, line or area feature offset 133
Disconnect GPRS 208
Display 258
Distance to station 217
Domain 198, 199
DOP 82
Download files 195
Download utility 74, 165
DXF 22, 179
E
EGNOS 23
Elapsed (time) 93, 116
Existing control point 75
Export 176
Extension (vertical antenna extension) 6
External GNSS antenna 4, 5



F
Feature library 21
Feature Properties window 173
File Naming convention 94, 108, 116
File Transfer Service 193
Files, managing 229
Find Nearest 217
Fixed-height GPS tripod 12
G
GIS features 2, 21
GNSS Solutions 2, 16, 18, 19, 24, 74, 81
GNSS Solutions installation CD 7
GOTO 153, 157, 158
GPRS 34, 209
GPRS call number (GPRS numbering) 198
GPRS Connection 47
GPRS operator 200
GPS Firmware version 251
GPS vector 79
GSM/GPRS 209
H
Handstrap 3
Hardware reset 252
Hardware version 251
Heading, grid feature 136
Height Type 51, 53, 55, 92, 102, 112
HI 38, 89
Holding the unit 21, 33, 123
Horizontal Distance, offset 132
Host 190, 214
Host IP address 209, 217
HRMS 52, 54
I
I/O module 3, 27, 169, 177
IMI 180, 185, 186, 229
Indicator lights 248
Initialize 102, 112
Initialize rover 42, 50
Initializer bar 7
Inquiring device 190
Instrument height 38
instrument height 89
Intervisible points 75, 77
J
Job content 172
K
Keyboard 258
Keypad test 249
Kinematic 18
Kinematic mode 25

L
Languages 243
Large Data screen 146
LED Indicators 248
Leg 161
Length measurement 174
Let other devices discover 192
Line-of-sight 78
Link (direct) 77
Local services (Bluetooth) 203
Lock status 213
Login 209, 217
Loop (strong) 77
M
Manual tuning 212
Map datum 238
Map screen 144
Mark 228, 229
Measurement tape 6
Message types #1 and #3 209
MIF 22, 179
Mini USB 4
Minimum distance (between Bluetooth-
enabled devices) 201
Mission Planning 81, 83
MMJ 176
MobileMapper Office 2, 21
MobileMapper Transfer 22
Modem command 198
MSK rate 213
Multi-leg 159
N
Naming conventions (GIS raw data files for 
post-processing) 263
Naming conventions (survey raw data files) 
262
NAP100 32
Nav screens 237
Navigation screens 22, 23
Nearest To 154
North reference 241
NTRIP 45, 48, 49, 209, 216
NtripCaster 216
Number of tracked satellites 225
O
Object Push Service 193
Observation

Plan 80
Times 81, 82

Observation Range 24, 83, 87, 93, 94, 
107, 116



Occupation times 24
Offset 175
Ordering information 264
Orientation 235
OTF 26
Other external device 34
Other RTCM Source 209
Owner information 259
P
Paired peripherals 192
Pairing Bluetooth-enabled devices 202
Password 199, 209, 217
PAUSE 54
PDOP 24, 52, 54, 82, 94, 108, 116, 
224, 225
Perimeter measurement 174
Phone number 205
Pin code 192, 202
Pivot 16
Pivot point 80
Points in loop 77
Poor (availability) 82
Port number 209, 217
Pos-Dest Line 236
Position screens 147
Post-processing mode 2, 21, 26
Power indicator 28
Primary Usage 236
ProMark Antenna 110454 32
ProMark3 CD (user documentation & 
MobileMapper Office software) 7
Properties (Bluetooth Properties) 192
Q
Quality (results) 81
R
Range Pole 12
Real-time corrections 3
Receiver ID 32, 232
Receiver status 52, 54
Recording (Raw Data) 34
Recording Interval 19, 51, 55, 92, 102, 
112
Reference points 181
Regional settings 259
Relative positioning 36
Remain (time) 107
Reset Trip 242
Reset, cold 255
Reverse 161
Revisiting features 22
Road 149

Road screen 149
Routes 158, 231
Rows, grid feature 136
RS232 185, 186, 188
RTCM 3, 34, 224
RTCM source 219
RTCM2.3 209
S
Satellite

Availability 81, 82
Distribution 81
Geometry 82

Satellite Status screen 33, 66, 90, 101, 
111, 152
Save password 205
SBAS 23, 209, 224
Scale indicator 149
Scrolling button 3
SD card 1
SD card slot 4
SD card test 250
SD Card Utilities 244
Security 192
Select a modem 205
Select Map 180
Serial port (COM1) 4
Serial Port Service 193, 194
Serial Port test 250
Setup 232
Setup menu 226
Shortcut 196, 203
Show Map Info 236
SHP 22, 179
Shut Down window 28
Shutdown 248
Simulate 243
Simulator 243
Site Description 51, 53
Site ID 91, 94, 108, 116
Slant 51, 53, 55, 92, 102, 112
SNR 213, 269
Software reset 252
Software version 251
Solid-state memory 1
Solution 52, 54
Sound 260
Spacing, grid feature 136
Speaker 3
Speaker test 250
Speedometer screen 151
Stake out 71



Stakeout screen 56
Static Mode 16
Static Survey screen 93
Station 218
Station ID 213
Stop-and-go mode 17, 24
Storage 232
Storage option 164, 166, 170
STORE 52, 57
Store on Hard Drive 186
Street info 244
Stylus 29, 259
Stylus test 250
Survey Mode 51, 53, 55, 91, 101, 111
System Idle mode 245
T
Target on Map screen 140
Target points 181
Tests Utility 249
Time format 239
Total station 75, 76
Track history 242
Track Lines 236
Track Mode 235
Trajectory 53
Traverse legs 77
Traverse plan 76
Tribrach 11
Tripod 5, 11
Tripod (fixed-height) 5
Tune by site 212
Two Data Fields 244
U
Units 32, 51, 53, 55, 91, 102, 112, 240
Upload files 196
Upload GIS job to ProMark3 22
Upload Positions to External Device 182
Upload to SD Card Reader 186
USB 5, 163, 169, 177
USB (mini-port) 5
USB driver installation 163
USB flash drive 4
USB host port 4
USB test 249
User Idle mode 245
User map datum 239
User Name 199
V
Vertical 51, 53, 55, 92, 102, 112
Vertical control points 76
Vertical Distance, offset 132

VRMS 52, 54
VRS 217
W
WAAS 3, 23
Waypoints 23, 188, 189, 236
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